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PREFACE 
 

The Volpe National Transportation Systems Center (Volpe Center) of the United States 
Department of Transportation’s Research and Innovative Technology Administration has 
developed a modeling system to assist the National Highway Traffic Safety Administration 
(NHTSA) in the evaluation of potential new Corporate Average Fuel Economy (CAFE) 
standards.  Based on externally-developed inputs, the modeling system estimates how 
manufacturers could apply additional fuel-saving technologies in response to new CAFE 
standards, and estimates how doing so would increase vehicle costs, reduce national fuel 
consumption and carbon dioxide emissions, and result in other effects and benefits to society.  
The modeling system can also be used to estimate the stringency at which an attribute-based 
CAFE standard satisfies various criteria.  For example, the system can estimate the stringency 
that produces a specified average required fuel economy level, or that maximizes net benefits to 
society. 

This report documents the design and function of the CAFE Compliance and Effects Modeling 
System as of March 31, 2010, specifies the content, structure, and meaning of inputs and outputs, 
and provides instructions for the installation and use of the modeling system. 

The authors of this report are John Van Schalkwyk, Kevin Green, Donald Pickrell, Ryan 
Harrington, and Mark Shaulov. 

The authors acknowledge the technical contributions of individuals who have been involved in 
guiding recent changes to the modeling system, including Joe Mergel and Josh Templeton of the 
Volpe Center, Donna Glassbrenner, Phil Gorney, Ken Katz, Jim Tamm and Lixin Zhao, Gregory 
Powell of NHTSA, Arthur Rypinski of the Office of the Secretary of the Department of 
Transportation, and David Boggs, Anrico Casadei, Scott Ellsworth, and Sandy Stojkovski of 
Ricardo, Inc.  The authors further acknowledge former Volpe Center staff who participated in the 
development of earlier versions of the modeling system, including Gregory Ayres, Kristina 
Lopez-Bernal, and Kenneth William. 

The authors further acknowledge the technical contributions of individuals who have reviewed 
detailed results of the model and/or provided specific suggestions regarding the model’s design.  
Among these individuals are Steve Plotkin and Michael Wang of the Department of Energy’s 
Argonne National Laboratory, Jeff Alson, William Charmley, Ben Ellies, David Haugen, 
Richard Rykowski, and Todd Sherwood of the U.S. Environmental Protection Agency (EPA), 
Gary Rogers of FEV Engine Technology, Inc., Jamie Hulan of Transport Canada, and Jonathan 
Rubin of the University of Maine.  
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1 Introduction 

The Energy Policy and Conservation Act (EPCA), as amended by the Energy Independence 
and Security Act of 2007 (EISA), requires the National Highway Traffic Safety 
Administration (NHTSA), an agency within the U.S. Department of Transportation (DOT), 
to promulgate and enforce Corporate Average Fuel Economy (CAFE) standards. NHTSA 
has been administering these standards since 1975. 

The Volpe National Transportation Systems Center (Volpe Center) provided technical 
support to the Department in connection with the establishment of the CAFE program in 
the 1970s, and has continued to provide such support since that time. The Volpe Center is a 
Federal fee-for-service organization within DOT's Research and Innovative Technology 
Administration (RITA). 

In 2002, the Volpe Center began developing a new modeling system to support NHTSA’s 
analysis of options for future CAFE standards. Objectives included, but were not limited to, 
the following: the ability to utilize detailed projections of light vehicle fleets to be produced 
for sale in the United States, the ability to efficiently estimate how manufacturers could 
apply available technologies in response to CAFE standards, the ability to quickly evaluate 
various options for future CAFE standards, and the ability to estimate a range of outcomes 
(in particular, changes in fuel consumption and emissions) resulting from such standards. 

Since 2002, the Volpe Center has made many changes to this modeling system. Some 
changes were made in response to comments submitted to NHTSA in connection with 
CAFE rulemakings, and in response to a formal peer review of the system. Some changes 
were made based on observations by NHTSA and Volpe Center technical staff. As NHTSA 
began evaluating attribute-based CAFE standards (i.e., standards under which CAFE 
requirements depend on the mix of vehicles produced for U.S. sale), significant changes 
were made to enable evaluation of such standards. At the same time, the system was 
expanded to provide the ability to perform uncertainty analysis by randomly varying many 
inputs. Later, the system was further expanded to provide automated statistical calibration 
of attribute-based standards, through implementation of Monte Carlo techniques, as well as 
automated estimation of stringency levels that meet specified characteristics (such as 
maximizing estimated net benefits to society). In 2007, NHTSA and Volpe Center staff 
worked with technical staff of the U.S. Environmental Protection Agency (EPA) on major 
changes to the range of fuel-saving technologies accommodated by the model, as well as the 
logical pathways for applying such technologies.  In 2008, NHTSA and Volpe Center staff 
collaborated on further revisions, particularly with respect to the representation of 
available fuel-saving technologies, support for the reexamination of which was provided by 
Ricardo, Inc. 

In support of the 2010 rulemaking, a multi-year technology application feature has been 
introduced into the modeling system. 
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2 System Design 
2.1 Overall Structure 

The basic design of the CAFE Compliance and Effects Modeling System developed by the 
Volpe Center is as follows: The system first estimates how manufacturers might respond to 
a given CAFE scenario, and from that the system estimates what impact that response will 
have on fuel consumption, emissions, and economic externalities. A CAFE scenario involves 
specification of the form, or shape, of the standards (e.g., flat standards, linear or logistic 
attribute-based standards, scope of passenger and nonpassenger regulatory classes), and 
stringency of the CAFE standard in each model year to be analyzed. 

Manufacturer compliance simulation and effects estimation encompass numerous 
subsidiary elements. Compliance simulation begins with a detailed initial forecast of the 
vehicle models offered for sale during the simulation period. The compliance simulation 
then attempts to bring each manufacturer into compliance with a CAFE policy scenario 
described in an input file developed by the user. The model sequentially applies various 
technologies to different vehicle models in each manufacturer’s product line in order to 
simulate how a manufacturer might make progress toward compliance with CAFE 
standards. Subject to a variety of user-controlled constraints, the model applies 
technologies based on their relative cost-effectiveness, as determined by several input 
assumptions regarding the cost and effectiveness of each technology, the cost of CAFE-
related civil penalties, and the value of avoided fuel expenses. For a given manufacturer, 
the compliance simulation algorithm applies technologies either until the manufacturer 
achieves compliance, or until the manufacturer exhausts all available technologies, or, if 
the manufacturer is assumed to be willing to pay civil penalties, until paying fines becomes 
more cost-effective than increasing vehicle fuel economy. The user may disable the fine 
paying option for manufacturers expected to be unwilling to pay fines, thus effectively 
“forcing” the manufacturer to add additional technology even once it might otherwise be 
preferable to pay fines (considering the cost to add further technology as compared to the 
estimated value of the resultant saved fuel). At this stage, the system assigns an incurred 
technology cost and updated fuel economy to each vehicle model, as well as any civil 
penalties incurred by each manufacturer. 

This point marks the system’s transition between compliance simulation and effects 
calculations. At the conclusion of the compliance simulation for a given model year, the 
system contains a new fleet of vehicles with new prices, fuel types (gasoline, diesel), fuel 
economy values, and curb weights that have all been updated to reflect the application of 
technologies in response to CAFE requirements. For each vehicle model in this fleet, the 
system then estimates the following: lifetime travel, fuel consumption, and carbon dioxide 
and criteria pollutant emissions. After aggregating model-specific results, the system 
estimates the magnitude of various economic externalities related to vehicular travel (e.g., 
noise) and energy consumption (e.g., the economic costs of short-term increases in 
petroleum prices). 

Different categorization schemes are relevant to different types of effects. For example, 
while a fully disaggregated fleet is retained for purposes of compliance simulation, vehicles 
are grouped by type of fuel for the energy and carbon dioxide calculations, and by U.S. 
Environmental Protection Agency (EPA) emissions classes for criteria pollutant 
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calculations. The system may be expanded in the future to represent CAFE-induced market 
responses (i.e., mix shifting), in which case such calculations would group vehicles by 
market segment.  Therefore, this system uses model-by-model categorization and 
accounting when calculating most effects, and aggregates results only as required for 
efficient reporting. 

2.2 CAFE Compliance Simulation 
2.2.1 Compliance Simulation Algorithm 

Each time the modeling system is used, it evaluates one or more CAFE scenarios. Each of 
these scenarios is defined in the “scenarios” input file described in Appendix C. Each 
scenario describes an overall CAFE program in terms of the program’s coverage, the 
definition of nonpassenger automobiles, the structure and stringency of the standards 
applicable to passenger and nonpassenger automobiles. The system is normally used to 
examine and compare at least two scenarios.  The first scenario is identified as the baseline 
scenario, providing results to which results for any other scenarios are compared. Although 
many scenarios can be examined with each run of the model, for simplicity in this overview, 
we will only describe one scenario occurring in one model year. 

The compliance simulation applies technology to each manufacturer’s product line based on 
the CAFE program described by the current scenario and the assumed willingness of each 
manufacturer to pay civil penalties rather than complying with the program. The first step 
in this process involves definition of the fleet’s initial state—that is, the volumes, prices, 
and attributes of all vehicles as projected without knowledge of future CAFE standards—
during the study period, which can cover one or more consecutive model years (MYs). The 
second step involves evaluating the applicability of each available technology to each 
vehicle model, engine, and transmission in the fleet. The third and final step involves the 
repeated application of technologies to specific vehicle models, engines, and transmissions 
in each manufacturer’s fleet. For a given manufacturer, this step terminates when CAFE 
standards have been achieved or all available technologies have been exhausted. 
Alternatively, if the user specifies that some or all manufacturers should be considered 
willing to pay CAFE fines (i.e., civil penalties for noncompliance), this step terminates 
when it would be less expensive to pay such fines than to continue applying technology. 

2.2.1.1 Initial State of the Fleet 

The fleet’s initial state is developed using information contained in the vehicle models, 
engine, and transmission worksheets described in Appendix C. The set of worksheets uses 
identification codes to link vehicle models to appropriate engines, transmissions, and 
preceding vehicle models. Figure 1 provides a simplified example illustrating the basic 
structure and interrelationship of these three worksheets, focusing primarily on 
structurally important inputs. These identification codes make it possible to account for the 
use of specific engines or transmissions across multiple vehicle models. They also help the 
compliance simulation algorithm to appropriately “carry over” technologies between model 
years. 
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Figure 1. Basic Structure of Input File Defining the Fleet’s Initial State 
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2.2.2 Vehicle Technology Application within the CAFE Model 

Vehicle technologies are a set of possible improvements available for the vehicle fleet. The 
vehicle technologies, referred to below simply as ‘technologies’, are defined in the 
technology input file for the model (see Appendix A.2). As a part of the definition for each 
technology there is an associated cost for the technology, an improvement factor (in terms of 
percent reduction of fuel consumption), the introduction year for the technology, whether it 
is applicable to a given class of vehicle, grouping (by technology group – engine, 
transmission, etc.) and phase-in parameters (the amount of fleet penetration allowed in a 
given year). Also defined in the technology inputs file are cost synergies and improvement 
synergies. 

Having defined the fleet’s initial state, the system applies technologies to each 
manufacturer’s fleet based on the CAFE program for the current model year. The set of 
technologies accommodated by the model is discussed in NHTSA’s Model Years 2012 – 2016 
Final Rule (FR) regarding CAFE standards for passenger cars and light trucks produced for 
sale in the United States in model years 2012 – 2016.1

As discussed in the FR, the set of technologies, and the methods for considering their 
application, builds on a 2002 study by the National Academy of Sciences.
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2.2.2.1 Vehicle Technology Class 

 That study 
estimated that the applicability of different technologies would vary based on vehicle type. 
Although the model now represents a wider range of technologies than the 2002 NAS study, 
and uses different logical sequences for considering their addition to manufacturers’ fleets, 
the model retains the ability for differentiation based on vehicle type.  NAS is currently 
conducting a study to develop an updated assessment of fuel-saving technologies. 

The CAFE model uses twelve technology classes as shown in Table 1: 

Table 1. CAFE Technology Vehicle Classes 
Class Description 
Subcompact PC Subcompact passenger car. 
Subcompact Perf. Subcompact performance oriented passenger car 
Compact PC Compact passenger car 
Compact Perf Compact performance oriented passenger car 
Midsize PC Midsized passenger car 
Midsize Perf Midsized performance oriented passenger car 
Large PC Large passenger car 
Large Perf Large performance oriented passenger car 
Small LT Small sport utility vehicles and pickups 

                                                 
1 Federal Register [to be supplied later]. Available on the internet at [to be supplied later].   
2 National Research Council, ‘‘Effectiveness and Impact of Corporate Average Fuel Economy (CAFE) Standards,’’ 
National Academy Press, Washington, DC (2002). Available at 
http://www.nap.edu/openbook.php?isbn=0309076013 (last accessed April 20, 2008). The conference committee 
report for the Department of Transportation and Related Agencies Appropriations Act for FY 2001 (Pub. L. 106–
346) directed NHTSA to fund a study by NAS to evaluate the effectiveness and impacts of CAFE standards (H. Rep. 
No. 106–940, p. 117–118). In response to the direction from Congress, NAS published this report. 

http://www.nap.edu/openbook.php?isbn=0309076013�
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Midsize LT Midsize sport utility vehicles and pickups 
Large LT Large sport utility vehicles and pickups 
Minivan Minivans 

2.2.2.2 Technology Groups:  

The CAFE Model organizes technologies into groups. The table below lists the technologies 
represented by the system, and the grouping we have applied to enable the system to follow 
a logical incremental path within any given group without being unnecessarily prevented 
from considering technologies in other groups. This “parallel path” approach is discussed 
below. 

Table 2. Technology Group Assignments 
Technology Group Group Members 
Engine Technology Group 
(EngMod) 

Low Friction Lubricants (LUB) 
Engine Friction Reduction (EFR) 
Variable Valve Timing type 

• VVT Coupled Cam Phasing on SOHC (CCPS) 
• VVT Couple Cam Phasing on OHV (CCPO) 
• VVT Intake Cam Phasing (ICP) 
• VVT Dual Cam Phasing (DCP) 

Cylinder Deactivation 
• on SOHC (DEACS) 
• on DOHC (DEACD) 
• on OHV (DEACO) 

Variable Value Lift & Timing 
• Discrete Variable Valve Lift [DVVL] on SOHC (DVVLS) 
• Discrete Variable Valve Lift [DVVL] on DOHC (DVVLD) 
• Continuously Variable Valve Lift (CVVL) 
• Discrete Variable Valve Lift [DVVL] on OHV (DVVLO) 

 
Conversion to DOHC with DCP (CDOHC) 
Stoichiometric Gasoline Direct Injection (SGDI) 
Combustion Restart (CBRST) 
Turbocharging and Downsizing (TRBDS) 
Exhaust Gas Recirculation [EGR] Boost (EGRB) 
Dieselization3

Electrical Accessory Group 
(ELEC) 

 (DSLC, DSLT) 
Electric Power Steering (EPS) 
Improved Accessories (IACC) 
12 Volt Micro-Hybrid (MHEV) 
Belt Mounted Starter Generator (BISG) 
Crank Mounted Integrated Starter Generator (CISG) 

Transmission Technology 
Group (TrMod) 

6-Speed Manual/Improved Internals (6MAN) 
Improved Auto. Transmission Controls/Externals (IATC) 
Continuously Variable Transmission (CVT) 
6/7/8 Speed Transmission With Improved Internals (NAUTO) 
Dual Clutch or Automated Manual Transmission (DCTAM) 

Material Substitution 
Technology Group (MSM) 

Mass Reduction 1.5% (MS1) 
Mass Reduction 3.5 – 8.5% (MS2) 
 

Hybrid Technology Group Power Split Hybrid (PSHEV) 
                                                 
3 Replacing a gasoline engine with a diesel engine. 



 

7 

(HEV) 2-Mode Hybrid (2MHEV) 
Plug-in Hybrid (PHEV) 

Dynamic Load Reduction 
Technology Group (DLR) 

Low Rolling Resistance Tires (ROLL) 
Low Drag Brakes (LDB) 
Secondary Axle Disconnect (SAXL) 

Aerodynamic Reduction 
Technology Group (AERO) 

Aerodynamic Drag Reduction (AERO) 

Input estimates for each of these technologies are specified in the technologies input file, 
and are specific to each of the CAFE technology vehicle classes, as shown in Table 1. The 
following table lists the input assumptions specified in this file. 

Table 3. Technology Input Assumptions 
Input Definition 
FC-Lower minimum reduction (%) of fuel consumption 
FC-Upper maximum reduction (%) of fuel consumption 
Cost-Lower minimum added cost4

Cost-Upper 
 (in 2007 dollars) 

maximum added cost (in 2007 dollars)  
Learning 
Type 

Indicates whether the learning type is based on time or volume (or 
neither) 

Threshold For technology costs derived through learning curves, this parameter 
is used as the threshold volume learning curve cost calculations 

Learning 
Rate 

For technology cost derived through learning curves, this parameter is 
used as the rate of decline in learning curve cost calculations. 

Year 
Available 

first model year the technology is available 

Applicability Whether the technology is available for the given vehicle class or not. 
Phase-In Set of percentages showing the phase-in limit at each model year. 
Aux. Used to specify cost basis.  If present, identifies whether technology 

costs are calculated on a per-cylinder, per-engine-bank, or per-pound-
removed basis. 

Abbr. abbreviation for technology 
TechType technology group (see technology group (see Table 2)) 

The technology input assumptions define applicability, cost, fuel consumption reduction 
factors, and define which technology group of which the technology is a member. 

2.2.2.3 Technology Applicability 

The technology input assumptions have two means of defining technology applicability. One 
means is with the Applicability field. If the field is set to “TRUE”, then the technology is 
available for the particular class of vehicle, otherwise, the technology is unavailable. 

The other applicability control in the input assumptions is the year available field. If the 
year being modeled by the CAFE Model is prior to the setting in the year available field, 
then the technology will be unavailable for the particular class of vehicle. 

                                                 
4 Because mass reduction is applied as a percentage of curb weight, the corresponding cost estimates are in dollars 
per pound of incremental change in curb weight. 
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Besides those mentioned, there are also other technology applicability factors within the 
CAFE Model. For example, there are controls for individual vehicles in the market data file 
that can override the controls here (see Appendix C). There are also dynamic considerations 
made while the model is running based on vehicle configuration (e.g. cylinder deactivation 
is not applied to vehicles with manual transmissions), as well as technology combination 
factors (e.g.  DVVLD is incompatible with CVVL). 

2.2.2.4 Technology Fuel Consumption Reduction Factors 

The technology input assumptions—specified in an input file supplied by the user—define 
the fuel consumption reduction factors FC_Lower and FC_Upper as a range of low estimate 
and high estimate.  By default, the CAFE Model uses the average of the two.  When 
running the model, the user can direct the model to apply low or high fuel consumption 
reduction factors. 

The reduction in fuel consumption values are on a gallons-per-mile basis and represent a 
percent reduction in fuel consumption. The formula to find the increase in fuel economy 
(miles-per-gallon) of a vehicle with fuel consumption reduction factors from one or more 
technologies, is: 
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  ( 1 ) 

 
where FEorig is the original fuel economy for the vehicle and FCnReduction0,1,…n are the fuel 
consumption reduction factors.  

2.2.2.5 Technology Cost 

The technology input assumptions—specified in an input file supplied by the user—define 
technology costs Cost_Lower and Cost_Higher as a range of low estimate and high 
estimate.  By default, the CAFE Model uses the average of the two as shown in equation ( 2 
).  When running the model, the user can direct the model to apply low or high costs. 

Some technology costs have a cost basis associated with them.  For instance, for material 
substitution technologies, the technology input costs must be multiplied by the reduction of 
vehicle curb weight, in pounds, to get the full cost of applying the technology.  Similarly 
some engine technologies have costs determined on a per cylinder or per bank 
(configuration) basis.  The model uses the ‘Aux’ column to identify when technologies have 
an underlying cost basis associated with them, as discussed further in NHTSA’s Model 
Years 2012 – 2016 Final Rule. 

Several other technologies involve ‘learning’. Learning is a means of capturing the 
reduction in cost of components and manufacturing process involved with a technology 
which takes place as the volume of deployment of that technology increases dramatically, or 
due to other factors, such as negotiated contractual agreements between suppliers and 
OEMs, which occur over a period of time. The model recognizes these two types of learning, 
volume-based and-time based. If a technology’s cost assumption is based on learning, the 
LearningType field (Table 3) will indicate which type. The formula used for learning cost 
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based on volume is shown in equation ( 3 ), the formula used for learning cost based on time 
is shown in equation ( 4 ). 
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Where: kD is the a constant representing a maximum of 2 reductions for learning, Volume 
is the volume of deployment of the technology, Threshold is the threshold volume and is 
from the technology input assumptions, LearningRate is the rate of decline from the input 
technology assumptions. 

If LearningType is left blank or is set to none, then the standard cost method is used, 
otherwise the indicated learning method (VOLUME or TIME) is used. Reduction due to 
learning do not take place in the CAFE Model until the technology is available and applied. 

Other fields in the input assumptions are the TechType and Abbr. Abbr contains 
abbreviations of the technology. The TechType field specifies the technology group. 
Technology groups are shown in Table 2 on page 6. Technology groups are discussed below. 

The CAFE Model uses estimates of each technology’s impact on cost and fuel consumption 
when selecting which technologies to apply to which vehicles in order to achieve compliance 
with CAFE standards.   

Further discussion of the technology input assumptions can be found in Appendix A.2. 

2.2.2.6 Technology Synergies 

Technology synergies exist when the combination of two technologies yields a fuel 
consumption reduction or cost which differs from what would be derived directly from 
equation ( 1 ) for fuel consumption reduction and equations ( 2 ), ( 3 ) above ( 4 ) for cost. 
The synergy can be positive (e.g. increased reduction of fuel consumption or increase in 
cost) or negative (decreased reduction of fuel consumption or decrease in cost).  

Synergy relationships between technologies are captured in the two synergies table in the 
technology input file. The system reads the information from the table and, for each 
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technology, stores the synergy factors between that technology and all other technologies. 
For cases where there is no synergy relationship, there will be no listing in the table, and 
the synergy factor will be zero (0.0). In cases where there are synergies, that applicable 
factor is added to the fuel consumption reduction or to the cost value.  

In the case of fuel consumption reduction synergies, negative synergies lessen the fuel 
consumption reductions of a technology, the system assumes technologies will not combine 
to degrade fuel economy (i.e., to produce negative reductions in fuel consumption). For 
synergies involving technology costs, the final result is allowed to become negative. 

The layout of the synergy table in the technology input file is discussed in Appendix A.2. 

2.2.2.7 Technology Groups: 

Technology groups, as shown in Table 2 on page 6, organizes the technologies into 
functional groups and allows the model to seek the next “best” technology application in any 
of the groups.5

2.2.2.8 Backfill of Technologies 

 There are seven groups: engine technologies; transmission technologies; 
electrical accessory technologies; dynamic load reduction technologies; aerodynamic load 
reduction technologies; material substitution technologies; and hybrid electric vehicle 
technologies. 

In some cases, technologies will be bypassed because they are not cost-effective. If the 
model applies a technology that resides later in the sequence, the model will ‘backfill’ any 
bypassed technologies. This backfill will not occur if the technology is not applicable to the 
vehicle. In the case where the backfill would backtrack through branches in the sequence, 
the model would first resolve any limitations and applicability issues. If the branch still 
exists, it would examine which is the more cost-effective branch to use. 

Unless the current model year is the first or only model year in the study period, the 
compliance simulation algorithm first applies any technologies that should be “carried over” 
from the previous model year. This carryover is implemented based on any “predecessor” 
relationships specified in the market data input file, and increases the cost and fuel 
economy of affected vehicles in the current model year.6

                                                 
5 Within the context of the compliance simulation, “best” is defined from the manufacturers’ perspective.  The 
system assumes that the manufacturer will seek to progress through the technology decision trees in a manner that 
minimizes effective costs, which include (a) vehicle price increases associated with added technologies, (b) 
reductions in civil penalties owed for noncompliance with CAFE standards, and (c) the value vehicle purchasers are 
estimated to place on fuel economy. 

 Carrying over technologies between 
model years based on such relationships avoids some unlikely predictions, such as that a 
given technology would be added to a given vehicle model in one model year and then 
removed in the following model year. 

6 Because it occurs without reference to CAFE standards applicable to the current model year, this technology 
carryover can cause overcompliance with one or more CAFE standards, depending on overall changes in the 
manufacturer’s fleet. 
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The algorithm next determines the applicability of each technology to each vehicle model, 
engine, and transmission. If the technology is available in the current model year, the 
system identifies the technology as potentially applicable. However, technology “overrides” 
can be specified for specific vehicle models, engines, and transmissions in the corresponding 
input files.7

Figure 7
 If any such overrides have been specified, the algorithm reevaluates 

applicability as shown in . 

2.2.2.9 Technology Sequencing and Branching 

The sequence of applying technology works in the following way: Within each group, the 
technology sequence of application proceeds as shown in the technology input file. There are 
some points where the sequence path can branch onto a different course, as discussed 
below. The groups are independent of each other, although there are some interactions, as 
described below. 

2.2.2.9.1 Sequencing and branching within a technology group 

Within each technology group, the choice of technologies that can be applied may vary from 
vehicle to vehicle based on the baseline configuration of the vehicle or on the previous 
application of technologies. Both the engine and transmission technology groups have 
optional paths. The choice of which path depends upon a variety of factors which include 
the vehicle class, the vehicle configuration, technology override settings for that vehicle, 
previous applications of technology, technology availability (year available) and phase-in 
restrictions. When left with a choice of two or more technologies, cost-effectiveness is used 
to choose the technology to apply.  

2.2.2.9.2 Bypassing a Technology  

In cases where a technology is already installed in the baseline vehicle configuration or is 
unavailable for other reasons (e.g., it is not compatible with this vehicle class), then that 
technology is simply bypassed in the technology path. For example, if engine friction 
reduction has previously been installed, then the next available engine technology after low 
-cost lubricants on a vehicle with overhead valves (OHV) is cylinder deactivation. 

Branching within a technology group sequence occurs for the following reasons: 1) A normal 
branch where there are two or more different (and mutually incompatible) technology 
choices – the model can choose one or another path; 2) Limitations of technology choice 
based on vehicle configuration; 3) A combination of both.  

Examples of normal branches are DVVLD and CVVL in the engine technology group and 
CVT or NAUTO in the transmission technology group. 

An example of the limitations would be within the engine technology group, as shown in 
Figure 2, below, where there is a separate path for engines with overhead valves (OHV) 

                                                 
7 These overrides, described in Appendix C.2 on page 59, provide a means of accounting for engineering and other 
issues not otherwise represented by input data or the overall system. 
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engines, single overhead cam engines (SOHC) and for engines with dual overhead cams 
(DOHC). 

2.2.2.9.3 Engine Technology Sequencing and Branching 

Within the engine technology sequence, shown in Figure 2, there are three major sequence 
paths: single overhead cam (SOHC); dual overhead cam (DOHC); and overhead valve 
(OHV). The choice of path for a vehicle model is based on the base engine attributes. There 
are further branches within the DOHC branch and within the OHV path. The choice of 
which branch to take is based on availability for the specific vehicle as well as the vehicle 
class; phase-in constraints; and, finally, cost-effectiveness. 

Further down within the engine technology sequence is another branch which culminates 
in dieselization. The choice of which branch is, again, based on availability for the specific 
vehicle as well as the vehicle class; phase-in constraints; and, finally, cost-effectiveness. 

2.2.2.9.4 Transmission Technology Sequencing and Branching 

Within the transmission technology sequence, for vehicles with a base 4- or 5-speed 
automatic transmission, there are branch options based in part on vehicle attributes 
(unibody versus ladder frame). Further criteria used to decide which branch to take are 
availability for the specific vehicle as well as the vehicle class; phase-in constraints; and, 
finally, cost-effectiveness. Manual transmissions remain in their own path. 

The sequence for transmission technologies is shown in Figure 3. 

The transmission technologies and those on the electrical accessory path are considered 
enabler technologies that must be installed on a vehicle prior to the application of the 
strong hybrid technologies. Therefore, the model fully (i.e., as subject to all other 
constraints) applies technologies in both of these paths before applying power-split, two-
mode, or plug-in hybrid technologies 

2.2.2.9.5 Electrical Accessory Technology Sequence 

The electrical accessory technology sequence has no branches, as shown in Figure 5. This 
group is an enabler for strong hybrid technologies. 

2.2.2.9.6 Strong Hybrid Technology Options 

As discussed above, the transmission technology and electrical accessory technology 
sequences are enablers for strong hybrid technologies.  Once currently-available 
opportunities to add technologies on these two sequences have been exhausted, the system 
evaluates opportunities to apply strong hybrids.  As shown in Figure 6 which also 
illustrates the enabling nature of the transmission and electrical accessory sequences, the 
system selects among power split, two-mode, and plug-in hybrids. 
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Figure 2. Engine Technology Group Technology Sequence 
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Figure 3. Transmission Technology Group Technology Sequence 
 
 
 

 
 
 
 

Figure 4.  Other Vehicle Technology Sequencing. 
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Figure 5.   Electrical Accessory Technology Group Sequencing 
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Figure 6.  Strong Hybrid Electric Vehicle Options 
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Figure 7. Technology Applicability Determination 
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2.2.3 Compliance Simulation Loop  

If a given technology is still considered applicable after considering any overrides, the 
algorithm again re-evaluates applicability based the following engineering conditions: 

Table 4. Engineering Conditions for Technology Applicability 
 
Technology Constraint 
All technologies Do not apply if already present on the vehicle. 
Low-Friction Lubricants Do not apply if engine oil is better than 5W30 
Variable Valve Timing Family Do not apply to diesel or rotary engines.  
Variable Valve Lift and Timing 
Family 

Do not apply to diesel or rotary engines. Do not apply to vehicles with 
VVLT technology already in place. Once a VVLT (continuous or discrete) 
are applied, the other VVLT cannot be applied. 

Cylinder Deactivation Do not apply to engines with inline configuration, and/or fewer than 6 
cylinders. Do not apply to diesel or rotary engines. 

Turbocharging and downsizing Do not apply to diesel or rotary engines.  
Stoichiometric GDI Do not apply to diesel or rotary engines. 
Continuously Variable 
Transmission 

Apply only to FWD unibody vehicles. 

Having determined the applicability of each technology to each vehicle model, engine, 
and/or transmission, the compliance simulation algorithm begins the process of applying 
technologies based on the CAFE standards applicable during the current model year. This 
involves repeatedly evaluating the degree of noncompliance, identifying the “best next”  (as 
described above) technology available on each of the parallel technology paths mentioned 
above, and applying the best of these.  

Figure 8 gives an overview of the process. If, considering all regulatory classes, the 
manufacturer owes no CAFE fines, then the algorithm applies no technologies beyond any 
carried over from the previous model year, because the manufacturer is already in 
compliance with the standard. If the manufacturer does owe CAFE fines, then the 
algorithm first finds the best next applicable technology in each of the technology groups 
(e.g., engine technologies), and applies the same criterion to select the best among these. If 
this manufacturer is assumed to be unwilling to pay CAFE fines (or, equivalently, if the 
user has set the system to exclude the possibility of paying fines as long as some technology 
can still be applied), then the algorithm applies the technology to the affected vehicles. If 
the manufacturer is assumed to be willing to pay CAFE fines and applying this technology 
would have a lower “effective cost” (discussed below) than simply paying fines, then the 
algorithm also applies the technology. In either case, the algorithm then reevaluates the 
manufacturer’s degree of noncompliance. If, however, the manufacturer is assumed to be 
willing to pay CAFE fines and doing so would be less expensive than applying the best next 
technology, then the algorithm stops applying technology to this manufacturer’s products. 
After this process is repeated for each manufacturer. It is then repeated again for each 
modeling year. Once all modeling years have been processed, the compliance simulation 
algorithm concludes. 
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Figure 8. Compliance Simulation Algorithm 

Whether or not the manufacturer is assumed to be willing to pay CAFE fines, the algorithm 
uses CAFE fines not only to determine whether compliance has been achieved, but also to 
determine the relative attractiveness of different potential applications of technologies. 
Whenever the algorithm is evaluating the potential application of a technology, it considers 
the effective cost of applying that technology to the group of vehicles in question, and 
chooses the option that yields the lowest effective cost.8

                                                 
8 Such groups can span regulatory classes. For example, if the algorithm is evaluating a potential upgrade to a given 
engine, that engine might be used by a station wagon in the domestic passenger automobile fleet, a large car in the 
imported passenger automobile fleet, and a minivan in the nonpassenger automobile fleet. If the manufacturer’s 
domestic and imported passenger automobile fleets both comply with the corresponding standard, the algorithm 
accounts for the fact that upgrading this engine will incur costs and realize fuel savings for all three of these vehicle 
models, but will only yield reductions of CAFE fines for the nonpassenger fleet. 

 The effective cost is used for 
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evaluating the relative attractiveness of different technology applications, not for actual 
cost accounting. The effective cost is defined as the change in total technology costs 
incurred by the manufacturer plus the change in CAFE fines incurred by the manufacturer 
minus the value of any reduction of fuel consumed by vehicles sold by the manufacturer, 
The calculation can span multiple modeling years. If the candidate technology was enabled 
for application in a previous year and not used, then it can remain as a candidate to be 
applied and then carried forward to the current model year. The impact of the technology 
application in each of these years is summed to obtain the effective cost. 

 ( )
( )

i PresentMY
i i FUEL i

eff
i BaseMY j i

TECHCOST FINE VALUE
COST

N

=

=

∆ + ∆ −
= ∑  ( 5 )  

where PresentMY is the current modeling year, BaseMY is the first year of the potential 
application of the technology (can be less than or equal to PresentMY), ΔTECHCOST is 
simply the product of the unit cost of the technology and the total sales (Nj) of the affected 
cohort of vehicles (j) for all years involved in the candidate technology application. The 
value of the reduction in fuel consumption achieved by applying the technology in question 
to all vehicles i in cohort j is calculated as follows:9
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where MIv is the number of miles driven in a year at a given vintage v, SURVv is the 
probability that a vehicle of that vintage will remain in service, FEi and iFE′  are the 
vehicle’s fuel economy prior to and after the pending application of technology, gap is the 
relative difference between on-road and laboratory fuel economy, Ni is the sales volume for 
model i in the current model year MY, FUELPRICEMY+v is the price of fuel in year MY+v, 
and PB is a “payback period”, or number of years in the future the consumer is assumed to 
take into account when considering fuel savings. As discussed in Appendix C, MIv, 
SURVv,FUELPRICEMY+v, and PB are all specified in the scenarios file. 

In equation ( 5 ), FINE is the change in total CAFE fines (i.e., accounting for all regulatory 
classes in the current CAFE scenario and model year). Typically, FINE is negative because 
applying a technology would increase CAFE.10

 

 FINE is calculated by evaluating the 
following before and after the pending technology application, and taking the difference 
between the results: 

( )MIN ,0F C
C

FINE k CREDIT= − ∑  ( 7 ) 

Here, kF is in dollars per mpg (e.g., $55/mpg) and specified in the scenarios file.  

                                                 
9 This is not necessarily the actual value of the fuel savings, but rather the increase in vehicle price the manufacturer 
is assumed to expect to be able impose without losing sales. 
10 Exceptions can occur if materials substitution is applied under a weight-based system. 
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Within each regulatory class C, the net amount of CAFE credit created (noncompliance 
causes credit creation to be negative, which implies the use

 

 of CAFE credits) is calculated 
by subtracting the CAFE level achieved by the class from the standard applicable to the 
class, and multiplying the result by the number of vehicles in the class. Taking into account 
attribute-based CAFE standards, this is expressed as follows:  

( ) ( )STD , CAFE ,C C C C C C C CCREDIT N= −  N A N FE  ( 8 ) 

where AC is a vector containing the value of the relevant attribute for each vehicle model in 
regulatory class C, CAFEC is the CAFE level for regulatory class C (e.g., if the standard 
depends on curb weight, AC contains each vehicle model’s curb weight), FEC is a vector 
containing the fuel economy level of each vehicle model in regulatory class C, NC is the total 
sales volume for regulatory class C, NC is a vector containing the sales volume for each 
vehicle model in regulatory class C, and STDC(NC ,AC) is a function defining the standard 
applicable to regulatory class C. 

 

Figure 9 gives an overview of the logic the algorithm follows in order to identify the best 
next technology application for each technology group. 

Within a given technology group, the algorithm considers technologies in the order in which 
they appear. If the phase-in limit for a given technology has been reached, the algorithm 
proceeds to the next technology. If not, the algorithm determines whether or not the 
technology remains applicable to any sets of vehicles, evaluates the effect cost of applying 
the technology to each such set, and identifies the application that would yield the lowest 
effective cost. 

As shown in Figure 8, the algorithm repeats this process for each technology group, and 
then selects the technology application yielding the lowest effective cost. As discussed 
above, the algorithm operates subject to expectations of the willingness of each 
manufacturer to pay fines. COSTeff is determined, as above, by equations ( 5 ), ( 6 ), ( 7 ) and 
( 8 ), irrespective of the manufacturer’s willingness to pay fines. 

At the end of each year in the model year loop, the vehicle/technologies combinations that 
can be candidates for application in multi-year processing are identified. 
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Figure 9. Determination of "Best Next" Technology Application 

2.3 Calculation of Effects 

This section describes how the CAFE modeling system estimates the effects of tightening or 
reforming CAFE standards on energy use, as well as on emissions of greenhouse gases and 
other air pollutants. These effects are caused by improvements in the fuel economy of 
vehicle models as manufacturers respond to changes in the CAFE standards. This section 
also describes how these energy use and environmental impacts are translated into 
estimates of economic benefits or costs, and identifies which of these economic impacts are 
borne privately by vehicle owners and by society as a whole.  
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The effects on energy use and emissions from tightening or reforming CAFE standards are 
estimated separately for each individual vehicle model and vintage (model year) over its 
expected life span in the U.S. vehicle fleet. A vehicle model’s life span extends from the 
initial model year when it is produced and sold, through the year when vehicles produced 
during that model year have reached the maximum age used in the CAFE model.11

Although these effects are calculated for individual vehicle models and vintages, they are 
typically reported at the aggregate level for all vehicle models in a CAFE class (domestic 
automobiles, import automobiles, and light trucks) produced during each model year 
affected by a proposed standard. These aggregated values are reported for each future 
calendar year during which a model year remains in the vehicle fleet. Cumulative impacts 
for each CAFE class and model year over its expected life span are also reported, both in 
undiscounted terms and as their present value discounted to the calendar year when each 
model year is produced. 

 Each of 
these effects is measured by the difference in the value of a variable – such as total gallons 
of fuel consumed by a vehicle model and vintage during a future calendar year – with the 
baseline CAFE standard (usually the standard currently in effect for that class of vehicle) 
remaining in effect, and its value if those vehicles were instead required to comply with a 
stricter CAFE standard.  

2.3.1 Light-Duty Vehicle Sales and Fleet 

The forecast number of new vehicles of a specific model k sold during a given model year 
MY is: 

 , ,k MY MY k MYn N P=  ( 9 ) 

Where NMY indicates the forecast of total new light-duty vehicle sales during that model 
year, and Pk,MY is the forecast market share of each vehicle model produced during that 
year. 

The number of vehicles of a specific model and vintage that remains in service during each 
subsequent calendar year is calculated by multiplying the number originally produced by 
estimates (model inputs) of the proportion that remain in service at each age. Thus the 
number of vehicles of model k produced during model year MY that remain in use during a 
future year t, or nk,MY,t, is: 

 
, , , ,k MY t k MY k an n s=  ( 10 ) 

where sk,a denotes the proportion of vehicles of model k expected to remain in use at the age 
(a) that vehicles produced during model year MY will have reached during year t, which is 
defined as  

                                                 
11 We adopt the simplification that vehicle model years and calendar years are identical. 
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a = t – MY .12

The model utilizes different schedules of expected survival rates by vehicle age for six 
separate classes of light-duty vehicles, as reported in Appendix C. The CAFE model 
assumes that these survival rates will not vary for future model years. 

  

2.3.2 Vehicle Use and Total Mileage 

The total number of miles driven by vehicles of a specific model and vintage (model year) 
during each year they remain in the fleet is calculated by multiplying age-specific estimates 
(model inputs) of annual miles driven per vehicle by the number of vehicles of that model 
year remaining in service at their age during that future year. Thus the total miles driven 
by vehicles of model k produced during model year MY that are expected to remain on the 
road during year t, denoted Mk,MY,t is calculated as: 

 
, , , , ,k MY t k MY t k aM n m=  ( 11 ) 

where mk,,a is the average number of miles that a surviving vehicle of model k is driven 
when it has reached age a, defined above. The CAFE model uses separate estimates of 
average annual utilization at different ages for different classes of light-duty vehicles. As 
with survival rates, we assume that annual usage of vehicles of different types at each age 
during their expected lifetimes will remain unchanged for future model years. 

2.3.2.1 Accounting for the “Rebound Effect” 

By reducing the amount of fuel it consumes per mile, improving a vehicle’s fuel economy 
reduces its fuel cost per mile driven. In response to the reduced per-mile cost of driving a 
more fuel-efficient vehicle, some buyers will increase the amount of driving they do, 
although the precise magnitude of this response is uncertain. Thus, imposing stricter fuel 
economy standards can increase the annual number of miles driven by vehicle models 
whose fuel economy manufacturers elect to improve in their efforts to comply with those 
standards.13

The rebound effect results in a corresponding increase in the total number of miles driven 
by vehicles produced during each model year affected by the stricter standards for every 
year they remain in the fleet. The proportional increase in the average annual number of 
miles driven during year t by a vehicle model k when its fuel economy is improved from the 
level specified by its manufacturer’s product plan for its model year, denoted mpgk,MY,plan, to 

 This increase in the use of vehicles with increased fuel economy is referred to 
as the “rebound effect” in vehicle use.  

                                                 
12 We define a vehicle’s age to be 0 during the year when it is produced and sold; that is, when t=MY. Thus, for 
example, a model year 2005 vehicle is defined to be 10 years old during calendar year 2015. Because we do not 
attempt to forecast changes in the proportion of vehicles produced during future model years that are expected to 
survive to each age, a vehicle’s age is depends only on the difference between its model year (MY) and the calendar 
year (t) for which these calculations are performed, and not on their specific values. 
13 The rebound effect also produces additional benefits to vehicle owners in the form of consumer surplus from the 
increase in driving, which is discussed in Section C.6. 
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a higher level, mpgk,MY,CAFE, is calculated using the elasticity of travel demand with respect 
to the fuel cost of driving: 

 , ,, , ,

, ,

,

t t

k CAFE k plank MY t CAFE
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tk MY t

k plan

f f
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fm
mpg

ε

 − ∆  =
 
 
 

 ( 12 ) 

where εcpm (a model input) is the elasticity of vehicle use with respect to the cost of fuel per 
mile driven (a measure closely related to the magnitude of the rebound effect), and ft is the 
price of fuel per gallon during future year t . Because the fuel cost per mile driven by any 
vehicle is equal to the price of fuel per gallon divided by its fuel economy in miles per 
gallon, the bracketed term in equation ( 12 ) represents the proportional reduction in fuel 
cost per mile driven resulting from the improvement in fuel economy.14

Thus, the absolute increase in average miles driven by vehicles of model k during year t 
that results from an increase in the applicable CAFE standard is: 
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Finally, the increase in the total number of miles driven by all surviving vehicles of model k 
and model year MY during each future year t that some remain in the fleet, denoted 
∆Mk,MY,t,CAFE is calculated from: 

 
, , , , , , , ,k MY t CAFE k MY t k MY t CAFEM n m∆ = ∆  ( 14 ) 

where nk,MY,t is given by equation ( 10 ). 

Total miles driven each year increases due to the rebound effect only for those vehicle 
models whose fuel economy is improved as part of their manufacturers’ efforts to comply 
with a stricter CAFE standard. In contrast, there is no increase in annual usage of vehicle 
models whose fuel economy remains unchanged from the level specified in manufacturers’ 
product plans for that model year.  

The existence of the rebound effect also means that any scenario requiring a vehicle 
manufacturer to increase the fuel economy of some models from those indicated in its 
product plan for that model year will result in an increase in their use over each year of 
their expected lifetime. In particular, where a manufacturer’s product plan specifies fuel 
economy levels that do not meet the CAFE standard in effect during the previous model 
year, the increase in their fuel economy necessary to ensure compliance with the baseline 
standard will produce a slight increase in their lifetime use through the rebound effect.  

                                                 
14 For Equation (11) to be strictly correct, mpg must represent actual “on the road” fuel economy. The difference 
between laboratory test and actual on-road fuel economy is discussed in detail in Section C.2. below. 
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The effect on total annual mileage driven resulting from substituting a new CAFE standard 
(denoted CAFE1) for a previous standard (CAFE0) is the difference in the added driving 
from the rebound effects associated with the two standards: 

 ( ), , , 1 , , , 0 , , , , , 1 , , , 0k a t CAFE k a t CAFE k a t k a t CAFE k a t CAFEM M n m m∆ −∆ = ∆ −∆  ( 15 ) 

2.3.3 Fuel Use and Savings 

Fuel consumption by vehicles of each specific model and vintage during a future year 
depends on the total mileage that the surviving vehicles are driven during that year, and 
the average fuel efficiency they obtain in actual driving. Computing this value is affected by 
the presence of the rebound effect, which as discussed previously causes slightly higher 
annual usage throughout the lifetime of any vehicle model whose fuel economy is improved 
above the level specified in its manufacturer’s product plan.  

The computation is also affected by the difference between the fuel economy levels of new 
vehicles as measured for purposes of assessing CAFE compliance and the (lower) levels 
they actually achieve in real-world driving. Finally, it is also necessary to calculate fuel use 
separately for gasoline and diesel vehicles, since these fuels result in different levels of 
greenhouse gas and air pollutant emissions. 

The number of gallons of fuel consumed by vehicles of model k and model year MY during 
year t, denoted gk,MY,t, is calculated from: 
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where gap (a model input) indicates the difference between that model’s fuel economy as 
measured for CAFE purposes and its actual on-road fuel economy. We assume that a 
vehicle’s fuel economy is constant with respect to both age and accumulated mileage, and 
that the test versus on-road fuel economy gap is identical for all vehicle types and ages.15

When the value of mpgk,MY in this expression corresponds exactly to the value specified in 
the product plan submitted by vehicle k’s manufacturer for model year MY, there is no 
rebound effect (i.e., Mk,MY,t = 0), and 
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For any vehicle model whose fuel efficiency its manufacturer elects to increase as part of its 
strategy to comply with a CAFE standard (including an extension to future model years of 
the prevailing standard), the appropriate form of equation ( 17 ) is: 

                                                 
15 These assumptions explain the absence of an age subscript on mpg, and of all subscripts on the parameter gap. 
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or, equivalently: 
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where the second term on the right hand side represents the additional fuel consumption 
attributable to the standard’s inducement of additional driving through the rebound effect. 
The effect on total fuel use during year t resulting from substituting a different standard 
(denoted CAFE1) for one previously in effect (CAFE0) is obtained by summing expression ( 
18 ) or ( 19 ) over all vehicle models produced during the model years to which the 
alternative standard would apply: 

 ( ), 1 , , , 1 , , , 0t CAFE k MY t CAFE k MY t CAFEMY k
G g g= −∑ ∑  ( 20 ) 

Thus the change in fuel use that results from imposing a different CAFE standard is 
always measured relative to expected fuel use with some baseline or comparison standard 
in effect. A frequent assumption used is that this baseline standard would be an extension 
of the CAFE standard that applied to vehicles produced during the preceding model year. 

The fuel savings from imposing a stricter CAFE standard on vehicles produced during a 
single model year MY over their expected lifetime are given by: 

 ( ), 1 , , , 1 , , , 0MY CAFE k MY t CAFE k MY t CAFEt k
G g g= −∑ ∑  ( 21 ) 

An often more appropriate measure of these fuel savings is the present value of lifetime fuel 
savings for model year MY vehicles, discounted to the year they are produced:  

 
( ) , , , 1 , , , 0
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where d is the annual discount rate.  

2.3.4 Greenhouse Gas Emissions 

Environmental impacts from petroleum use stem primarily from combustion of petroleum 
products such as gasoline, and to a lesser extent from the use of fossil energy during 
petroleum refining and in the transportation, storage, and distribution of refined products. 
These impacts include emissions of greenhouse gases and “criteria” air pollutants currently 
regulated under the Clean Air Act. Increasing CAFE standards will reduce gasoline 
consumption and the amount of petroleum refined, and both of these effects will in turn 
reduce emissions of greenhouse gases. While reduced gasoline refining will also lower 
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emissions of criteria pollutants, the increase in vehicle use that results from improving 
their fuel economy via the rebound effect will raise emissions of these pollutants. Thus on 
balance, raising CAFE standards can either reduce or increase emissions of criteria 
pollutants, depending on the magnitude of the rebound effect, vehicles’ emission rates per 
mile driven, and emissions produced during fuel refining and distribution.  

Fuel savings from stricter light truck CAFE standards will result in lower emissions of 
carbon dioxide, the primary greenhouse gas emitted during the refining, distribution, and 
combustion of transportation fuels.16 Lower fuel consumption reduces carbon dioxide 
emissions directly, because the largest source of these emissions in transportation is fuel 
use in internal combustion engines. The CAFE model calculates reductions in carbon 
dioxide emissions from vehicle operation by multiplying the reduction in the number of 
gallons of fuel consumed by the carbon content per gallon of fuel and the ratio of carbon 
dioxide emissions per unit of carbon consumed during the combustion process.17

Direct or “tailpipe” carbon dioxide emissions occurring during year t as a result of fuel 
consumption by vehicles of model k produced during model year MY are calculated from 
MWCO2/MWC, where cf indicates the carbon content (by weight) per gallon of fuel, and 
MWCO2 and MWC are the molecular weights of carbon dioxide (44) and carbon (12). This 
calculation is performed separately for carbon dioxide emissions resulting from gasoline 
and diesel fuel combustion, since their carbon content per gallon differs. The carbon content 
of gasoline used in the CAFE model is a weighted average of those for different types of 
gasoline in use.  

 

As with fuel consumption, the effect of a new CAFE standard on carbon dioxide emissions 
from vehicle operation is measured by the difference in emissions with the new standard in 
effect, and those under a baseline or other alternative standard. Denoting these CAFE1 and 
CAFE0 as previously, the change in carbon dioxide emissions from fuel consumed by 
vehicles of model k and model year MY during year t is: 

 ( ), , , 1 , , , 1 , , , 0
tp
k MY t CAFE k MY t CAFE k MY t CAFE fC g g c= − (MWCO2/MWC) ( 23 ) 

Again, this calculation is performed separately for carbon dioxide emissions from gasoline 
and diesel fuel use. Its results are summed over the vehicle models and vintages affected by 
a proposed CAFE standard to estimate its impact on carbon dioxide emissions during 
future years, or over vehicle types and ages to estimate the proposed standard’s effect on 
lifetime carbon dioxide emissions by vehicles produced during the model years it would 
affect.  

Increasing the stringency of CAFE standards will also affect carbon dioxide emissions 
generated from combustion of fossil fuels used during petroleum extraction, transportation, 

                                                 
16 Carbon dioxide emissions account for more than 97% of total greenhouse gas emissions from the refining and use 
of transportation fuels; see U.S. Environmental Protection Agency, Draft Inventory of GHG Emissions and Sinks 
(1990-1999), Tables ES-1 and ES-4, http://www.epa.gov/globalwarming/publications/emissions/us2001/energy.pdf. 
17 Although the system does not explicitly account for incomplete conversion of carbon to carbon dioxide, input 
values specifying carbon content can be adjusted accordingly (i.e., reduced to 99-99.5% of actual carbon content). 
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storage, and refining, as well as during storage and distribution of refined fuel. Carbon 
dioxide emissions from each stage of the fuel production and distribution process are 
calculated using estimates of carbon dioxide emissions per unit of fuel energy. These 
estimates are converted to a per-gallon basis using the energy content per gallon of gasoline 
and diesel, and summed to calculate total carbon dioxide emissions per gallon of fuel used.  

For vehicles of model k and model year MY, total carbon dioxide emissions during year t 
from fuel production, distribution, and use are calculated as: 

 ( ), , , ,
tot
k MY t k MY t f r dC g c c c= + +  ( 24 ) 

As above, cf (a model input) is the carbon content of each fuel type, cr includes carbon 
emissions per gallon during crude petroleum extraction, transportation, and refining, cd 
represents carbon emissions per gallon during storage and distribution of refined fuel. 

The effect of increasing a baseline standard CAFE0 to a higher standard CAFE1 on total 
carbon emissions from fuel production and use is: 

 ( )( ), , , 1 , , , 1 , , , 0
tot
k MY t CAFE k MY t CAFE k MY t CAFE f r dC g g c r c c= − + ⋅ +  ( 25 ) 

Again, this quantity can be summed over vehicle models and ages to estimate the effect of a 
proposed CAFE standard on total carbon dioxide emissions during any future year, or over 
vehicle types and years to estimate the proposed standard’s effect on lifetime carbon dioxide 
emissions from vehicles it would affect.  

2.3.5 Air Pollutant Emissions 

Stricter CAFE standards can result in higher or lower emissions of criteria air pollutants, 
by-products of fuel combustion that are emitted by internal combustion engines as well as 
during fuel production and distribution. Criteria pollutants emitted in significant 
quantities by light-duty motor vehicles include carbon monoxide, various hydrocarbon 
compounds, nitrogen oxides, sulfur dioxide, and fine particulate matter. 

The increased use of vehicle models with improved fuel economy that occurs through the 
rebound effect causes increased emissions of criteria pollutants, since federal standards 
regulate permissible emissions of these pollutants on a per-mile basis. The increases in 
emissions of these pollutants during vehicle operation are estimated by multiplying the 
increase in total miles driven by vehicles whose fuel economy is improved by their per-mile 
emission rates for each pollutant.  

Emissions of pollutant i resulting from the operation of vehicle model k and model year MY 
during year t are calculated as: 

 ( ), , , , , , , , ,
tp
i k MY t k MY t k MY t i k aE M M e= − ∆  ( 26 ) 
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where (Mk,MY,t + Mk,MY,t) is given by ( 26 ), and ei,ka, is emissions per mile of pollutant i by 
vehicles of model k and model year m at age a = t - MY. Emission rates (model inputs) for 
criteria air pollutants differ by vehicle type, size class, model year of production, and age.  

Changes in the volume of fuel consumption from varying CAFE standards will also affect 
emissions of criteria pollutants that occur during refining, distribution, and retailing of 
gasoline and diesel fuel.18

Upstream emissions of pollutant i within the U.S. from producing and distributing each 
type of fuel consumed by vehicles of model k and vintage MY during year t are: 

 As with greenhouse gas emissions, these “upstream” emissions 
are estimated by applying emission factors for each criteria pollutant per unit of fuel 
refined to the total volume of each type of fuel consumed with any specified CAFE standard 
in effect. 

 ( ), , , , , , ,
up
i k MY t k MY t i r i dE g r e e= ⋅ −  ( 27 ) 

where gk,MY,t is calculated from ( 27 ), r is the fraction of each fuel type refined domestically, 
ei,r is emissions of pollutant i that occur during crude petroleum extraction, transportation, 
and refining, and ei,d is emissions of that pollutant from the storage and distribution of 
refined fuel. Both ei,r and ei,d are expressed per gallon of fuel produced.  

Total emissions of a criteria pollutant i from the production, distribution, and use of fuel 
are the sum of emissions during vehicle operation and from the production and distribution 
of fuel: 

 
, , , , , , , , ,
tot tp up
i k MY t i k MY t i k MY tE E E= +  ( 28 ) 

In turn, the effect on criteria pollutant emissions of a proposed increase to a standard 
CAFE1 a baseline standard of CAFE0 is 
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Again, this quantity can be summed over model or calendar years to report annual or 
lifetime effects of proposed CAFE standards on emissions of criteria pollutants.  

Emissions of some criteria pollutants may potentially increase as a result of stricter CAFE 
standards, as increased emissions from added driving due to the rebound effect outweigh 
the reduction in emissions from gasoline refining and distribution. Of course, the likelihood 
that this will occur this also depends on the magnitude of the rebound effect itself. For 
other pollutants, however, emission rates during fuel production are large relative to those 
                                                 
18 Reductions in criteria pollutant emissions from fuel refining and distribution are calculated using input values 
specifying emission rates.  Argonne National Laboratories’ GREET model is an available source of such inputs; see 
Argonne National Laboratories, The Greenhouse Gas and Regulated Emissions from Transportation (GREET) 
Model, Version 1.6, February 2000, http://www.transportation.anl.gov/ttrdc/greet/index.html. 
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from vehicle operation, so on balance, emissions of these pollutants are likely to decline as 
CAFE standards are raised.  

2.3.6 Private versus Social Costs and Benefits 

Improving the fuel efficiency of new vehicles produces a wide range of benefits and costs, 
many of which affect buyers of those vehicles directly. Depending upon how manufacturers 
attempt to recoup the costs they incur for improving the fuel efficiency of selected models, 
buyers are likely to face higher prices for some – and perhaps even most – new vehicle 
models. Purchasers of models whose fuel economy is improved benefit from the resulting 
savings in the cost of fuel their vehicles consume, from any increase in the range they can 
travel before needing to refuel, and from the added driving they do as a result of the 
rebound effect. Depending on the technology manufacturers use to improve fuel economy 
and its consequences for vehicle power and weight, these benefits may be partly offset by a 
slight decline in the performance of some new models.  

At the same time, the reduction in fuel production and use resulting from improved fuel 
economy produces certain additional benefits and costs to society as a whole. Potential 
social benefits from reduced fuel use include any value that society or the U.S. economy 
attaches to saving fuel over and above its private value to new vehicle buyers, lower 
emissions of air pollutants and greenhouse gases generated by from fuel production, 
distribution, and consumption, and reduced economic costs associated with U.S. imports of 
crude petroleum and refined fuel. By causing some additional driving through the rebound 
effect, improving fuel economy can also increase a variety of social costs, including the 
economic value of health effects and property damages caused by increased air pollution, 
the value of time delays to motorists from added traffic congestion, added costs of injuries 
and property damage resulting from more frequent traffic accidents, and economic costs 
from higher levels of traffic noise.  

The following sections discuss how each of these benefits and costs can result from 
improving the fuel economy of new vehicles, the factors affecting their likely magnitudes, 
and how their values are commonly measured or estimated. Appendix A.3 provides 
examples of specific unit economic values and other parameters used to estimate the 
aggregate value of these various benefits and costs, explains how these sample values were 
derived, and reports the specific sources from which they were obtained. 

2.3.6.1 Benefits and Costs to New Vehicle Buyers: 
2.3.6.1.1 Increases in New Vehicle Prices 

Depending upon how manufacturers attempt to recover the costs they incur in complying 
with CAFE regulations, purchase prices for some new models are likely to increase. 
Because we assume that manufacturers fully recover all costs they incur for installing fuel 
economy technologies to comply with CAFE in the form of higher prices for some models, 
the total increase in vehicle sales prices has already been accounted for in estimating 
technology costs to manufacturers. Nevertheless, the total value of these price increases 
represent a cost of CAFE regulation from the viewpoint of buyers of vehicle models whose 
prices rise.  
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In addition to increases in the prices paid by buyers who elect to purchase these models 
even at their higher prices, higher prices result in losses in welfare or consumer surplus to 
buyers who decide to purchase different models instead. These losses are extremely 
complex to estimate if prices change for a large number of models, and in any case are 
likely to be small even in total. Thus we do not attempt to estimate their value.  

2.3.6.1.2 The Value of Fuel Savings 

The CAFE modeling system estimates the economic value of fuel savings to buyers of new 
vehicle models whose fuel economy is improved by applying the forecast (an input to the 
model) of future retail fuel prices to each year’s estimated fuel savings for those models. 
The annual fuel savings for a model during each year of its lifetime in the vehicle fleet is 
multiplied by the number of those initially sold that are expected to remain in use during 
that year to determine the total annual value of fuel savings to buyers of that model.  

The forecast retail price of fuel per gallon—including federal and average state fuel and 
other taxes—during that year is used to estimate the value of these fuel savings as viewed 
from the perspective of their buyers. Based on evidence from previous studies of consumer 
purchases of automobiles and durable appliances, we assume that new vehicle buyers value 
these savings over the approximate number of years (an input to the model) they expect to 
own a new vehicle, and that they discount these expected savings to the year in which they 
purchase new vehicles. 

2.3.6.1.3 Benefits from Additional Driving 

The rebound effect also results in additional benefits to new vehicle buyers in the form of 
consumer surplus from the increased driving it produces. These benefits arise from the 
value to drivers and passengers of the social and economic opportunities made available to 
them by additional traveling. As evidenced by the fact that they elect to make more 
frequent or longer trips when improved fuel economy reduces the cost of driving, the 
benefits from this additional travel exceed the costs drivers and their passengers incur in 
making more frequent or longer trips. The amount by which these benefits from additional 
travel exceed its cost to them—which has been reduced by improved fuel economy—
represents the increase in consumer surplus associated with additional rebound effect 
driving.  

The system estimates the value of these benefits using the conventional approximation of 
one half of the product of the decline in fuel cost per mile driven and the resulting increase 
in the annual number of miles driven. This value is calculated for each year that a model 
whose fuel economy is improved remains in the fleet, multiplied by the number of vehicles 
of that model expected to remain in use during each year of its lifetime, and discounted to 
its present value as of the year it was purchased. Given typical input values (e.g, for fuel 
prices), this benefit is relatively small by comparison to most other economic impacts of 
raising CAFE standards.  
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2.3.6.1.4 The Value of Extended Refueling Range 

Manufacturers’ efforts to improve the fuel economy of selected new vehicle models will also 
increase their driving range per tank of fuel. By reducing the frequency with which drivers 
typically refuel their vehicles, and by extending the upper limit of the range they can travel 
before requiring refueling, improving fuel economy thus provides some additional benefits 
to their owners.19

2.3.6.1.5 Changes in Performance and Utility 

 No direct estimates of the value of extended vehicle range are readily 
available, so the CAFE model calculates the reduction in the annual number of required 
refueling cycles that results from improved fuel economy. The change in required refueling 
frequency for vehicle models with improved fuel economy reflects the increased driving 
associated with the rebound effect, as well as the increased driving range stemming from 
higher fuel economy.  

The system currently assumes that the costs and effects of fuel-saving technologies reflect 
the application of these technologies in a manner that holds vehicle performance and utility 
constant.  Therefore, the system currently does not estimate changes in vehicle 
performance or utility. 

2.3.6.1.6 Social Benefits and Costs from Increased Fuel Economy 
2.3.6.1.6.1 The “Social Value” of Fuel Savings 

The economic value to society of the annual fuel savings resulting from stricter CAFE 
standards is also assessed by applying estimated future fuel prices to each year’s estimated 
fuel savings. Unlike the value of fuel savings to vehicle buyers themselves, however, the 
pre-tax price per gallon is used in assessing the value of fuel savings to the economy as a 
whole. This is because reductions in payments of state and federal taxes by purchasers of 
fuel will be exactly offset by reduced spending on the construction and maintenance of 
streets and highways that fuel taxes are mainly used to finance, and thus do not reflect a 
net savings in resources to the economy.  

When estimating the nationwide aggregate economic benefits and costs from CAFE 
regulation, we include this “social” value of fuel savings rather than their private value to 
vehicle buyers. In computing the social value of fuel savings, we include their annual value 
over the entire expected lifetimes of vehicle models whose fuel economy is improved, 
reflecting the presumably longer-term horizon of society as a whole compared to that of 
vehicle buyers, who may be concerned with fuel savings only over the time they expect to 
own newly-purchased vehicles.  

2.3.6.1.6.2 Economic Benefits from Reduced Petroleum Imports 

Importing petroleum into the United States is widely believed to impose significant costs on 
households and businesses that are not reflected in the market price for imported oil, and 
thus are not borne by consumers of refined petroleum products. These costs include three 

                                                 
19 If manufacturers instead respond to improved fuel economy by reducing the size of fuel tanks to maintain a 
constant driving range, the resulting savings in costs will presumably be reflected in lower sales prices. 
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components: (1) higher costs for oil imports resulting from the combined effect of U.S. 
import demand and OPEC market power on the world oil price; (2) the risk of reductions in 
U.S. economic output and disruption of the domestic economy caused by sudden reductions 
in the supply of imported oil; and (3) costs for maintaining a U.S. military presence to 
secure imported oil supplies from unstable regions, and for maintaining the Strategic 
Petroleum Reserve (SPR) to cushion against price increases. By reducing domestic demand 
for gasoline, tighter CAFE standards can reduce petroleum imports, and thus reduce these 
social costs to the extent that their magnitude varies with the volume of U.S. oil imports. 
Any reduction in their magnitude represents an additional category of economic benefits 
from tighter fuel economy standards.  

In this analysis, the reduction in petroleum imports resulting from higher light truck CAFE 
standards is estimated by assuming that the resulting savings in gasoline use during each 
future year is translated directly into a corresponding reduction in the annual volume of 
U.S. oil imports during that same year. The value to the U.S. economy of reducing 
petroleum imports -- in the form of lower crude oil prices and reduced risks of oil supply 
disruptions – is estimated by applying the sum of the previously reported estimates of these 
benefits to the estimated annual reduction in oil imports.  

2.3.6.1.6.3 Valuing Changes in Environmental Impacts 

The CAFE modeling system estimates the economic value of the net change in emissions of 
criteria pollutants, including carbon monoxide, volatile organic compounds, nitrogen oxides, 
sulfur dioxide, and fine particulates, using estimates of the economic damage costs per ton 
of emissions of each of these pollutants. As indicated previously, emissions of criteria 
pollutants can rise or fall when fuel economy increases, so the economic costs of these 
emissions can increase or decline in response to higher CAFE standards.  

The model estimates changes in damage costs caused by carbon dioxide emissions by 
multiplying the magnitude of the change in emissions by the estimated value of damages 
per unit of emissions.  

2.3.6.1.7 Social Costs of Added Driving 

In addition to increasing emissions of criteria pollutants, any added driving associated with 
the fuel economy rebound effect may contribute to increased traffic congestion, motor 
vehicle accidents, and highway noise. Additional vehicle use can contribute to traffic 
congestion and delays partly by increasing recurring congestion on heavily-traveled 
facilities during peak travel periods, depending on how the additional travel is distributed 
over the day and on where it occurs. Added driving can also increase the frequency of 
incidents such as collisions and disabled vehicles that cause prolonged delays, although the 
extent to which it actually does do will again depend partly on when and where the added 
travel occurs. Finally, added vehicle use from the rebound effect may also increase traffic 
noise, which causes inconvenience, irritation, and potentially even discomfort to occupants 
of other vehicles, pedestrians and other bystanders, and residents or occupants of 
surrounding property.  
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The CAFE modeling system uses estimates of the increases in external costs – that is, the 
marginal social costs – from added congestion, property damages and injuries in traffic 
accidents, and noise levels caused by additional vehicle usage. It does so by applying 
estimates of the increases in these costs that result from each added mile of travel by 
different types of vehicles (passenger and nonpassenger automobiles) to the increase in the 
total number of miles driven projected to result from the rebound effect.
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Appendix A Model Inputs 

The CAFE Compliance and Effects Modeling System utilizes a set of data files used as 
input to the analysis.  All input files are specified in Microsoft® Excel format and are 
outline in Table 5 below.  The user can define and edit all inputs to the system.  For 
example, the system does not require market data constructed using confidential business 
information. 

Table 5. Input Files 
Input File Contents 

Market Data 
(Manufacturers Worksheet) 

Contains an indexed list of manufacturers available during the study period, along 
with manufacturer’s willingness to pay fines and other manufacturer-specific 
modeling settings. 

Market Data 
(Vehicles Worksheet) 

Contains an indexed list of vehicle models available during the study period, along 
with sales volumes, fuel economy levels, prices, other attributes, domestic labor 
utilization, references to specific engines and transmissions used, and optional 
settings related to technology applicability, designation as a passenger or 
nonpassenger automobile, and coverage of vehicles with GVWR above 8,500 
pounds. 

Market Data 
(Engines Worksheet) 

Contains an indexed list of engines available during the study period, along with 
various engine attributes and optional settings related to technology applicability. 

Market Data 
(Transmissions Worksheet) 

Contains an indexed list of transmissions available during the study period, along 
with various transmission attributes and optional settings related to technology 
applicability. 

Technologies Specifies estimates of the availability, cost, and effectiveness of various 
technologies, specific to various vehicle categories. 

Parameters 
Provides inputs used to calculate travel demand, fuel consumption, carbon dioxide 
and criteria pollutant emissions, and economic externalities related to highway travel 
and petroleum consumption. 

Emissions Rates Provides inputs used to project the emissions rates of various pollutants. 

Scenarios Specifies coverage, structure, and stringency of CAFE standards for scenarios to be 
simulated. 

EIS Parameters Provides inputs required for EIS upstream emissions calculations.  This input file is 
required for EIS modeling only. 

EIS Tailpipe Emissions Provides inputs required for EIS tailpipe emissions calculations.  This input file is 
required for EIS modeling only. 
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Appendix A.1 Market Data File 

The market data file contains four worksheets:  Manufacturers, Vehicles, Engines and 
Transmissions.  Taken together, the manufacturers, vehicle models, engines, and 
transmissions worksheets provide "initial state" historical and/or forecast data for the light 
vehicle fleet.  The sections below describe each worksheet in greater detail. 

Appendix A.1.1 Manufacturers Worksheet 

The manufacturers input worksheet contains a list of all manufacturers that produce 
vehicle models offered for sale during the study period.  Each manufacturer has a unique 
code and is represented by a unique manufacturer name.  For each manufacturer, the 
manufacturer code, name, cost allocation strategy, and willingness to pay CAFE fines must 
all be specified.  Available credits, if applicable, should be expressed in Vehicle/MPG and is 
applied directly as a credit (or discredit if negative) to the CAFE level for the given 
manufacturer in the given model year.  If no available credits are to be specified, a value of 
zero (0.0) can be used or the cell can be left blank. 

 
Table 6. Manufacturers Worksheet 

 
 

Category Column Units Definition/Notes
Manufacturer Code integer Unique number assigned to each manufacturer.
Manufacturer Name text Name of the manufacturer.

Cost Allocation Strategy integer

The cost allocation strategy the manufacturer will use for allocating costs.
  0 = allocate technology costs on an as-incurred basis
  1 = distribute technology costs and fines based on the share of aggregate sales 
revenue
  2 = not used
  3 = distribute technology costs and fines evenly

Discount Rate number Represents the manufacturer specific discount rate, which factors into the 
effective cost calculation.

Optimize text Y = consider the manufacturer during optimization
N = do not consider the manufacturer during optimization

2011 text
2012 text
2013 text
2014 text
2015 text
2016 text
2011 vehicle-mpg
2012 vehicle-mpg
2013 vehicle-mpg
2014 vehicle-mpg
2015 vehicle-mpg
2016 vehicle-mpg
2011 vehicle-mpg
2012 vehicle-mpg
2013 vehicle-mpg
2014 vehicle-mpg
2015 vehicle-mpg
2016 vehicle-mpg
2011 vehicle-mpg
2012 vehicle-mpg
2013 vehicle-mpg
2014 vehicle-mpg
2015 vehicle-mpg
2016 vehicle-mpg

text Y = apply manufacturer's credits to the baseline scenario
N = do not apply manufacturer's credits to the baseline scenario
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Credits Apply to Baseline

Represents the manufacturer's available credits towards CAFE compliance for 
vehicles regulated as Domestic Automobiles.

Represents the manufacturer's willingness to pay fines.
  Y = pay fines instead of applying ineffective technologies
  N = apply ineffective technologies instead of paying fines

Represents the manufacturer's available credits towards CAFE compliance for 
vehicles regulated as Imported Automobiles.

Represents the manufacturer's available credits towards CAFE compliance for 
vehicles regulated as Light Trucks.
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Appendix A.1.2 Vehicles Worksheet 

The vehicles worksheet contains information regarding each vehicle model offered for sale 
during the study period.  Each vehicle model is represented as a single row of input data. 
Data in Table 7, Table 8, and Table 9 list the different columns of information specified in 
the vehicle models file.  To make the information readable, the Vehicle Models tables are 
presented vertically and divided into sections. 

In the "General" category, the vehicle code, manufacturer, model, nameplate, fuel economy, 
engine code, transmission code, and origin must be specified for each vehicle model.  The 
engine and transmission codes must refer to a valid engine and transmission, respectively, 
for the relevant manufacturer in the engines and transmissions worksheets.  Known or 
projected sales are specified in the "Sales" section for each model year in which the model is 
offered.  Changes to a model – in particular any that would affect fuel economy (e.g., a 
different engine or transmission) – are specified by creating a new row (effectively a new 
vehicle model) with the older model's number in the "predecessor" field.  The known or 
projected MSRP should be specified in its corresponding section for each model year in 
which the vehicle model is offered for sale.  In the "Regulatory Classification" section, the 
regulatory and technology class assignments for each vehicle must be specified. 

 
Table 7. Vehicles Worksheet (1) 

 

Within the "Vehicle" category, it is important that each vehicle model's class, style, 
structure, drive, footprint, curb weight, GVWR, and fuel capacity be specified.  For any 
hybrid vehicle models, it is necessary to specify the type of hybridization as well.  In the 
"Planning & Assembly" section, it is important that the number of any (single) predecessor 
to the current vehicle model be specified.  The redesign and refresh years must be comma 
separated and contain all known previous and projected future redesign and refresh years. 

Category Column Units Definition/Notes
Vehicle Code integer Unique number assigned to each vehicle.
Manufacturer text The manufacturer of the vehicle.
Model text Name of the vehicle model.
Nameplate text The nameplate of the vehicle.
Primary Fuel text Most common type of fuel with which the vehicle's engine is compatible.
Fuel Economy on Primary 
Fuel

mpg Weighted (FTP+highway) fuel economy of the vehicle.

Engine Code integer The engine code of the engine that the vehicle uses.
Transmission Code integer The transmission code of the transmission that the vehicle uses.
Origin text D = domestic; I = imported
MY2011 units
MY2012 units
MY2013 units
MY2014 units
MY2015 units
MY2016 units
MY2011 dollars
MY2012 dollars
MY2013 dollars
MY2014 dollars
MY2015 dollars
MY2016 dollars

Regulatory Class text
The regulatory assignment of the vehicle.
  PC = the vehicle should be regulated as a passenger automobile
  LT = the vehicle should be regulated as a light truck

Technology Class text The technology class of the vehicle.
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Vehicle's projected production for sale in the US.

Vehicle's projected average MSRP (sales-weighted, including options).
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Table 8. Vehicles Worksheet (2) 

 

The applicability of technologies considered on a vehicle model basis (as opposed, for 
example, to an engine basis) can be controlled for each vehicle model by using the 
"Technology Applicability" category.  This section must be completed to prevent double 
counting of technologies. 

 
Table 9. Vehicles Worksheet (3) 

 
 

Appendix A.1.3 Engines Worksheet 

Similar to the vehicles input sheet, the engines worksheet contains a list of all engines used 
in vehicle models offered for sale during the study period.  For each manufacturer, the 
engine code is a unique number assigned to each such engine.  This code is referenced in 
the engine code field on the vehicles worksheet.  For each engine, the engine code, 
manufacturer, configuration, primary fuel, cycle, aspiration, valve actuation/timing, valve 
lift, number of cylinders, number of valves per cylinder, and horsepower must all be 
specified.  As in the vehicles worksheet, the technology applicability for any engine 
technology must be specified for any specific engine. 

Category Column Units Definition/Notes
Class text Vehicle class.
Style text Vehicle style.
Structure text Vehicle structure (e.g., ladder or unibody).

Drive text Vehicle drive (e.g., A=all-wheel drive, F=front-wheel drive, R=rear-wheel drive, 
4=four-wheel drive).

Footprint sq. feet The vehicle footprint; wheelbase times average track width.

Curb Weight pounds
Total weight of the vehicle, including batteries, lubricants, and other expendable 
supplies, but excluding the driver, passengers, and other payloads (SAE J1100).

GVWR pounds Gross Vehicle Weight Rating; weight of loaded vehicle, including passengers and 
cargo.

Seating (Max) integer The number of usable seat belts before folding and removal of seats (where 
accomplished without specific tools).

Fuel Capacity gallons The capacity of the vehicle's fuel tank in gallons of diesel fuel or gasoline; MJ 
(LHV) of other fuels (or chemical battery energy).

Hybridization Type of Hybrid/Electric 
Vehicle

text Hybridization type of the vehicle, if any.

Predecessor integer The vehicle code of a vehicle model upon which this vehicle model is based.
Refresh Years model year Comma separated list of previous and future refresh years of the vehicle.
Redesign Year model year Comma separated list of previous and future redesign years of the vehicle.

Planning and 
Assembly
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Category Column Units Definition/Notes
EPS text
IACC text
MHEV text
BISG text
CISG text
PSHEV text
2MHEV text
PHEV text
MS1 text
MS2 text
MS5 text
ROLL text
LDB text
SAXU text
SAXL text
AERO text
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<blank> = the technology is not used on the vehicle
USED = the technology is used on the vehicle
SKIP = the technology is not applicable to the vehicle
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Table 10. Engines Worksheet 

 
 

Appendix A.1.4 Transmissions Worksheet 

Similar to the vehicles and engines input sheets, the transmissions worksheet contains a 
list of all transmissions used in vehicle models offered for sale during the study period.  For 
each manufacturer, the transmission code is a unique number assigned to each such 
transmission.  This code is referenced in the transmission code field on the vehicles 
worksheet.  For each transmission, the transmission code, manufacturer, type, and number 
of forward gears must all be specified.  As in the vehicles worksheet, the technology 
applicability for any engine technology must be specified for any specific transmission. 

 

Category Column Units Definition/Notes
Engine Code integer Unique number assigned to each engine.
Manufacturer text The manufacturer of the engine.
Configuration text Configuration of the engine.
Primary Fuel text Most common type of fuel with which the engine is compatible.

Engine Oil Viscosity text Ratio between the applied shear stress and the rate of shear, which measures the 
resistance of flow of the engine oil (as per SAE Glossary of Automotive Terms).

Cycle text Combustion cycle of the engine.
Fuel Delivery System text The mechanism that delivers fuel to the engine.

Aspiration text Breathing or induction process of the engine (as per SAE Automotive 
Dictionary).

Valvetrain Design text Design of the total mechanism from camshaft to valve of an engine that actuates 
the lifting and closing of a valve (as per SAE Automotive Dictionary).

Valve Actuation/Timing text Valve opening and closing points in the operating cycle (SAE J604).

Valve Lift text The manner in which the valve is raised during combustion (as per SAE 
Automotive Dictionary).

Cylinders integer Number of engine cylinders.
Valves/Cylinder integer Number of valves per cylinder.
Deactivation text Weighted (FTP+highway) aggregate degree of deactivation.
Displacement liters Total volume displaced by a piston in a single stroke.
Max. Horsepower number Maximum horsepower of the engine (horsepower).
Max. Torque number Maximum torque of the engine (pound-foot).
LUB text
EFR text
CCPS text
DVVLS text
DEACS text
ICP text
DCP text
DVVLD text
CVVL text
DEACD text
DEACO text
CCPO text
DVVLO text
CDOHC text
SGDI text
CBRST text
TRBDS text
EGRB text
DSLT text
DSLC text

<blank> = the technology is not used on the engine
USED = the technology is used on the engine
SKIP = the technology is not applicable to the engine
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Table 11. Transmissions Worksheet 

 

Appendix A.2 Technologies File 

The technologies input file contains assumptions regarding the fuel consumption benefit, 
cost, applicability, and availability of different vehicle, engine, and transmission 
technologies during the study period.  Input assumptions are specific to each of the 
following vehicle technology classes:  subcompact cars, subcompact performance cars, 
compact cars, compact performance cars, midsize cars, midsize performance cars, large 
cars, large performance cars, minivans, small pickups and SUVs, midsize pickups and 
SUVs, and large pickups and SUVs.  Table 12 shows sample technology assumptions for 
subcompact cars.

Category Column Units Definition/Notes
Transmission Code integer Unique number assigned to each transmission.
Manufacturer text The manufacturer of the transmission.
Type text Type of the transmission.
Number of Forward Gears integer Number of forward gears the transmission has.
6MAN text
IATC text
CVT text
NAUTO text
DCTAM text
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<blank> = the technology is not used on the transmission
USED = the technology is used on the transmission
SKIP = the technology is not applicable to the transmission
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Table 12. Technologies Assumptions (Sample) 

 
 

Index Technology Abbr.  TechType 
 Year
Avail. 

FC-
Lower

FC-
Upper

 Cost-
Lower 

 Cost-
Upper 

 Learning
Type 

 Learning
Start 

 Learning
End 

 Learning
Threshold 

 Learning
Rate  Aux.  Applicability 

Phase-
in 2011

Phase-
in 2012

Phase-
in 2013

Phase-
in 2014

Phase-
in 2015

Phase-
in 2016

1 Low Friction Lubricants LUB EngMod 2007 0.50% 0.50% 3$          3$          TRUE 85% 100% 100% 100% 100% 100%
2 Engine Friction Reduction EFR EngMod 2007 1.00% 2.00% 13$        13$        1 TRUE 85% 85% 85% 85% 100% 100%
3 VVT - Coupled Cam Phasing (CCP) on SOHC CCPS EngMod 2007 1.00% 3.00% 45$        45$        TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
4 Discrete Variable Valve Lift (DVVL) on SOHC DVVLS EngMod 2007 1.00% 3.00% 142$      142$      TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
5 Cylinder Deactivation on SOHC DEACS EngMod 2007 0.00% 0.00% -$       -$       TIME 2012 0.03 FALSE 85% 85% 85% 85% 85% 85%
6 VVT - Intake Cam Phasing (ICP) ICP EngMod 2007 1.00% 2.00% 45$        45$        TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
7 VVT - Dual Cam Phasing (DCP) DCP EngMod 2007 2.00% 3.00% 38$        38$        TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
8 Discrete Variable Valve Lift (DVVL) on DOHC DVVLD EngMod 2007 1.00% 3.00% 142$      142$      TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
9 Continuously Variable Valve Lift (CVVL) CVVL EngMod 2007 1.50% 3.50% 277$      277$      TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
10 Cylinder Deactivation on DOHC DEACD EngMod 2007 0.00% 0.00% -$       -$       TIME 2012 0.03 FALSE 85% 85% 85% 85% 85% 85%
11 Cylinder Deactivation on OHV DEACO EngMod 2007 0.00% 0.00% -$       -$       TIME 2012 0.03 FALSE 85% 85% 85% 85% 85% 85%
12 VVT - Coupled Cam Phasing (CCP) on OHV CCPO EngMod 2007 1.00% 1.50% 45$        45$        TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
13 Discrete Variable Valve Lift (DVVL) on OHV DVVLO EngMod 2007 0.50% 2.50% 142$      142$      TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 100% 100%
14 Conversion to DOHC with DCP CDOHC EngMod 2007 1.00% 2.50% 276$      276$      TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 85% 85%
15 Stoichiometric Gasoline Direct Injection (GDI) SGDI EngMod 2007 2.00% 3.00% 59$        59$        TIME 2012 0.03 1 TRUE 85% 85% 85% 85% 85% 85%
16 Combustion Restart CBRST EngMod 2007 2.00% 2.50% 118$      118$      TIME 2014 0.03 TRUE 0% 0% 0% 85% 85% 85%
17 Turbocharging and Downsizing TRBDS EngMod 2007 4.23% 4.81% 445$      445$      TIME 2012 0.03 TRUE 85% 85% 85% 85% 85% 85%
18 Exhaust Gas Recirculation (EGR) Boost EGRB EngMod 2007 3.50% 4.00% 144$      144$      TIME 2013 0.03 TRUE 0% 0% 85% 85% 85% 85%
19 Conversion to Diesel following CBRST DSLC EngMod 2007 13.94% 13.45% 1,527$   1,527$   TIME 2012 0.03 TRUE 0% 3% 6% 9% 12% 15%
20 Conversion to Diesel following TRBDS DSLT EngMod 2007 6.88% 5.29% 938$      938$      TIME 2012 0.03 TRUE 0% 3% 6% 9% 12% 15%
21 6-Speed Manual/Improved Internals 6MAN TrMod 2007 0.50% 0.50% 250$      250$      TIME 2012 0.03 TRUE 85% 85% 85% 85% 100% 100%
22 Improved Auto. Trans. Controls/Externals IATC TrMod 2007 1.50% 2.50% 60$        60$        TIME 2012 0.03 TRUE 85% 85% 85% 85% 100% 100%
23 Continuously Variable Transmission CVT TrMod 2007 0.70% 2.00% 250$      250$      TIME 2012 0.03 TRUE 85% 85% 85% 85% 85% 85%
24 6/7/8-Speed Auto. Trans with Improved Internals NAUTO TrMod 2007 1.40% 3.40% 112$      112$      TIME 2012 0.03 TRUE 85% 85% 100% 100% 100% 100%
25 Dual Clutch or Automated Manual Transmission DCTAM TrMod 2007 5.50% 7.50% (59)$       (59)$       TIME 2012 0.03 TRUE 85% 85% 100% 100% 100% 100%
26 Electric Power Steering EPS ELEC 2007 1.00% 2.00% 106$      106$      TIME 2012 0.03 TRUE 85% 85% 85% 85% 100% 100%
27 Improved Accessories IACC ELEC 2007 1.00% 2.00% 128$      128$      TIME 2012 0.03 TRUE 85% 85% 85% 85% 100% 100%
28 12V Micro-Hybrid MHEV ELEC 2007 2.00% 3.00% 288$      288$      TIME 2012 0.03 TRUE 85% 85% 85% 85% 85% 85%
29 Belt mounted Integrated Starter Generator BISG ELEC 2007 4.00% 6.00% 286$      286$      VOLUME 150,000    0.2 TRUE 85% 85% 85% 85% 85% 85%
30 Crank mounted Integrated Starter Generator CISG ELEC 2007 8.90% 8.64% 2,791$   2,791$   VOLUME 150,000    0.2 TRUE 0% 3% 6% 9% 12% 15%
31 Power Split Hybrid PSHEV ELEC 2007 6.28% 12.35% 1,600$   1,600$   VOLUME 150,000    0.2 TRUE 0% 3% 6% 9% 12% 15%
32 2-Mode Hybrid 2MHEV ELEC 2007 0.12% 3.87% 3,248$   3,248$   VOLUME 150,000    0.2 FALSE 0% 3% 6% 9% 12% 15%
33 Plug-in Hybrid PHEV ELEC 2011 45.23% 47.67% 11,520$ 11,520$ VOLUME 150,000    0.2 TRUE 0% 3% 6% 9% 12% 15%
34 Material Substitution (1.50%) MS1 MSM 2007 0.53% 0.53% 1$          1$          1.50% TRUE 85% 85% 85% 85% 85% 100%
35 Material Substitution (5% to 10% Cum) MS2 MSM 2014 2.74% 2.74% 1$          1$          3.50% TRUE 85% 85% 85% 85% 85% 100%
36 Material Substitution (NA) MS5 MSM 2007 0.00% 0.00% -$       -$       0.00% FALSE 85% 85% 85% 85% 85% 100%
37 Low Rolling Resistance Tires ROLL DLR 2007 1.00% 2.00% 6$          6$          TRUE 85% 85% 85% 85% 100% 100%
38 Low Drag Brakes LDB DLR 2007 0.50% 1.00% 63$        63$        FALSE 85% 85% 85% 85% 100% 100%
39 Secondary Axle Disconnect - Unibody SAXU DLR 2007 FALSE 85% 85% 85% 85% 100% 100%
40 Secondary Axle Disconnect - Ladder Frame SAXL DLR 2007 1.00% 1.50% 87$        87$        TIME 2012 0.03 TRUE 85% 85% 85% 85% 100% 100%
41 Aero Drag Reduction AERO AERO 2007 2.00% 3.00% 48$        48$        TIME 2012 0.03 TRUE 85% 85% 85% 85% 100% 100%

Subcompact PC  Benefit/Cost Variables Phase-in Values
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For each technology, Table 12 contains the following: 

• Index:  Specifies the index of the technology, which loosely reflects the sequence to follow when 
populating technology groups. 

• Technology:  Represents the full technology name. 

• Abbr.:  Represents the technology abbreviation used in output files. 

• TechType:  Specifies the technology group to which the technology belongs. 

• Year Avail.:  Specifies the first year the technology is available for applicability. 

• FC-Lower:  Provides a low-end estimate of the incremental fuel consumption reduction. 

• FC-Upper:  Provides a high-end estimate of the incremental fuel consumption reduction. 

• Cost-Lower:  Provides a low-end estimate of the incremental cost (RPE in 2003 dollars, or 
dollars/pound for material substitution). 

• Cost-Upper:  Provides a high-end estimate of the incremental cost (RPE in 2003 dollars, or 
dollars/pound for material substitution). 

• Learning Type:  Indicates whether to apply time-based or volume-based learning curve when 
estimating the technology costs.  If this value is blank, the technology does not use a learning 
curve. 

• Learning Start:  Specifies the model year when learning begins for a Technology. 

• Learning End:  Not applicable; reserved for future use. 

• Learning Threshold:  Indicates the minimum sales volume the industry must reach before 
learning for the technology begins.  The learning threshold applies to volume-based learning 
only. 

• Learning Rate:  Specifies the rate of decline to apply to the learning curve. 

• Aux.:  For material substitution technologies, specifies the relative change in curb weight; not 
applicable to other technologies. 

• Applicability:  Indicates whether the technology is available for applicability on a given 
technology class. 

• Phase-in Values:  Specifies the maximum incremental share of a manufacturer's fleet to which 
technology can be added in model years 2011 to 2016; the phase-in value for each year is 
cumulative over the entire analysis period. 

The technologies are organized into technology types specified by TechType field in the 
fourth column.  Each technology type is populated with specific technologies following the 
sequence specified by the Index column.  The sequence of engine and transmission 
technologies may be split to follow slightly different paths, based on the original vehicle, 
engine, or transmission characteristics, or depending on which technologies have already 
been applied to a vehicle.  If the original vehicle uses a manual transmission with fewer 
than six gears, the only available technology would be the 6-speed manual transmission.  If 
the original vehicle, however, uses an automatic transmission, the technologies applied 
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would follow one of the two specified orders: IATC and CVT; or: IATC, 6/7/8-speed auto 
(NAUTO), and dual clutch / automatic manual transmission (DCTAM). 

Appendix A.2.1 Technology Synergies 

Technology synergies occur when the combined effect of two technologies is greater than (or 
less than) the fuel consumption reduction for the two technologies combined.  To support 
synergies, the technology input file has synergy sections for cost and fuel improvements. 
Samples from the synergy tables are shown in Table 13 and Table 14 below. 

The synergy table is most commonly used for synergistic interactions in vehicle 
technologies from differing technology groups (e.g. between engine technologies and 
transmission technologies).  Synergies within a technology group are already built into the 
cost and fuel reduction values for the technologies.  Therefore, in-group synergies are not 
likely to occur, unless special circumstances arise, such as branching of technology paths. 

 
Table 13. Technology Cost Synergies (Sample) 

 
 

Type Technology A Technology B
Subcompact 

PC
Subcompact 

Perf. PC
Compact 

PC
Compact 
Perf. PC

Midsize 
PC

Midsize 
Perf. PC

Large 
PC

Large 
Perf. PC

Minivan 
LT

Small 
LT

Midsize 
LT

Large 
LT

Accounting MHEV CBRST (118)$           (118)$           (118)$     (118)$     (118)$    (118)$     (118)$ (118)$     (118)$    (118)$ (118)$    (118)$ 
Accounting DEACD CVVL -$             -$             -$       (28)$       -$      (28)$       (28)$   (28)$       (28)$      -$   (28)$      (28)$   
Accounting PSHEV DCTAM 197$            95$              197$      95$        146$     95$        146$   95$        146$     146$   95$       95$     
Accounting PHEV DCTAM 197$            95$              197$      95$        146$     95$        146$   95$        146$     8$       95$       95$     
Accounting TRBDS DVVLD (4)$               (4)$               (4)$         (197)$     (4)$        (197)$     (197)$ (274)$     (197)$    (4)$     (197)$    (274)$ 
Accounting TRBDS CVVL (4)$               (4)$               (4)$         (197)$     (4)$        (197)$     (197)$ (274)$     (197)$    (4)$     (197)$    (274)$ 
Accounting TRBDS DVVLO 141$            141$            141$      479$      141$     479$      479$   282$      479$     141$   479$     282$   
Accounting TRBDS CDOHC (4)$               (4)$               (4)$         (197)$     (4)$        (197)$     (197)$ (274)$     (197)$    (4)$     (197)$    (274)$ 
Accounting DSLC DVVLD (38)$             (38)$             (38)$       (83)$       (38)$      (83)$       (83)$   (83)$       (83)$      (38)$   (83)$      (83)$   
Accounting DSLC CVVL (173)$           (173)$           (173)$     (358)$     (173)$    (358)$     (358)$ (317)$     (358)$    (173)$ (358)$    (317)$ 
Accounting DSLC DVVLO -$             -$             -$       80$        -$      80$        80$     148$      80$       -$   80$       148$   
Accounting DSLC CDOHC (134)$           (134)$           (134)$     (328)$     (134)$    (328)$     (328)$ (376)$     (328)$    (134)$ (328)$    (376)$ 
Accounting DSLT DVVLD (34)$             (34)$             (34)$       114$      (34)$      114$      114$   191$      114$     (34)$   114$     191$   
Accounting DSLT CVVL (169)$           (169)$           (169)$     (162)$     (169)$    (162)$     (162)$ (42)$       (162)$    (169)$ (162)$    (42)$   
Accounting DSLT DVVLO (141)$           (141)$           (141)$     (399)$     (141)$    (399)$     (399)$ (134)$     (399)$    (141)$ (399)$    (134)$ 
Accounting DSLT CDOHC (131)$           (131)$           (131)$     (131)$     (131)$    (131)$     (131)$ (102)$     (131)$    (131)$ (131)$    (102)$ 

Synergies
Synergy values by Vehicle Class

Vehicle classes must be in the same order and the same names as the preceeding worksheets.
Positive values are increase costs, negative values are decrease costs. Blank cells are assumed to be zero.
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Table 14. Technology Fuel Consumption Synergies (Sample) 

 
 
For each technology relation, the above two tables contain the following: 
 

• Type:  Specifies the synergy type relation between two technologies.  The "accounting" type 
indicates that the synergy relation between two technologies is to provide accounting adjustments 
for the decision trees and is the only synergy type applied to technology costs.  The "physical" 
type indicates that the synergy relation between two technologies is to address physical energy 
losses. 

• Technology A:  Specifies the abbreviation of the first technology in a synergy pair. 

• Technology B:  Specifies the abbreviation of the second technology in a synergy pair. 

• Subcompact PC – Large LT:  Contains values to offset the technology cost or fuel consumption 
when either of technology A or B is being applied when the other is already installed. 

When a technology is being applied (or is being tested for application), a lookup is 
performed in the "Technology A" and "Technology B" columns of the table.  If found, the 
vehicle is examined to determine if the paired technology (or technologies) have been 
applied (or are installed as part of the base vehicle definition).  If so, the offset value for the 
applicable vehicle class is obtained, summed, and applied to the cost or fuel consumption 
reduction of the technology being examined. 

 

Type Technology A Technology B
Subcompact 

PC
Subcompact 

Perf. PC
Compact 

PC
Compact 
Perf. PC

Midsize 
PC

Midsize 
Perf. PC

Large 
PC

Large 
Perf. PC

Minivan 
LT

Small 
LT

Midsize 
LT

Large 
LT

Accounting MHEV CBRST -2.25% -2.25% -2.25% -2.25% -2.25% -2.25% -2.25% -2.25% -2.25% -2.25% -2.25% -2.25%
Accounting DEACD CVVL 0.00% 0.00% 0.00% -0.25% 0.00% -0.25% -0.25% -0.25% -0.25% 0.00% -0.25% -0.25%
Accounting PSHEV DCTAM -7.32% -4.18% -7.32% -4.18% -4.18% -4.18% -4.18% -4.18% -4.18% -4.18% -4.18% -4.10%
Accounting PHEV DCTAM -4.33% -2.47% -4.33% -2.47% -2.47% -2.47% -2.47% -2.47% -2.47% -2.47% -2.47% -2.43%
Accounting TRBDS DVVLD -1.95% -1.95% -1.95% 0.51% -1.95% 0.51% 0.51% 0.51% 0.51% -1.95% 0.51% 0.51%
Accounting TRBDS CVVL -2.45% -2.45% -2.45% 0.25% -2.45% 0.25% 0.25% 0.25% 0.25% -2.45% 0.25% 0.25%
Accounting TRBDS DVVLO 1.21% 1.21% 1.21% -0.74% 1.21% -0.74% -0.74% -0.74% -0.74% 1.21% -0.74% -0.74%
Accounting TRBDS CDOHC 0.97% 0.97% 0.97% -0.99% 0.97% -0.99% -0.99% -0.99% -0.99% 0.97% -0.99% -0.99%
Accounting DSLC DVVLD -1.76% -1.76% -1.76% 0.46% -1.76% 0.46% 0.46% 0.46% 0.46% -1.76% 0.46% 0.46%
Accounting DSLC CVVL -2.21% -2.21% -2.21% 0.23% -2.21% 0.23% 0.23% 0.23% 0.23% -2.21% 0.23% 0.23%
Accounting DSLC DVVLO 1.09% 1.09% 1.09% -0.67% 1.09% -0.67% -0.67% -0.67% -0.67% 1.09% -0.67% -0.67%
Accounting DSLC CDOHC 0.88% 0.88% 0.88% -0.89% 0.88% -0.89% -0.89% -0.89% -0.89% 0.88% -0.89% -0.89%
Accounting DSLT DVVLD 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Accounting DSLT CVVL 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Accounting DSLT DVVLO 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Accounting DSLT CDOHC 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
Physical CCPS 6MAN -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1%
Physical CCPS IATC -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2%
Physical CCPS CVT -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8%
Physical CCPS NAUTO -0.4% -0.4% -0.4% -0.4% -0.4% -0.4% -0.4% -0.4% -0.4% -0.4% -0.4% -0.4%
Physical CCPS MHEV -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7%
Physical CCPS BISG -0.9% -0.9% -0.9% -0.9% -0.9% -0.9% -0.9% -0.9% -0.9% -0.9% -0.9% -0.9%
Physical DVVLS 6MAN -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1% -0.1%
Physical DVVLS IATC -0.5% -0.5% -0.5% -0.5% -0.5% -0.5% -0.5% -0.5% -0.5% -0.5% -0.5% -0.5%
Physical DVVLS CVT -1.4% -1.4% -1.4% -1.4% -1.4% -1.4% -1.4% -1.4% -1.4% -1.4% -1.4% -1.4%
Physical DVVLS NAUTO -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7% -0.7%
Physical DVVLS MHEV -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8% -0.8%
Physical DVVLS BISG -1.0% -1.0% -1.0% -1.0% -1.0% -1.0% -1.0% -1.0% -1.0% -1.0% -1.0% -1.0%
Physical DEACS 6MAN -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2% -0.2%

Synergies
Fuel Consumption Improvement Synergy values by Vehicle Class

Vehicle classes must be in the same order and the same names as the preceeding worksheets.
Positive values are [positive] synergies, negative values are dissynergies. Blank cells are assumed to be zero.
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Appendix A.2.2 Technology Variations for Monte-Carlo 

During Monte-Carlo modeling, it is necessary to specify technology FC and cost variations, 
so that the model may properly assign randomized values to technology costs and fuel 
consumption improvements.  Table 15 below provides an example of technology variations 
used during Monte-Carlo modeling. 

 
Table 15. Technology FC and Cost Variations for Monte-Carlo Modeling (Sample) 

 

The first four columns in the above table are used to identify and match the associated 
technologies on the vehicle technology class tabs.  The rest are used as follows: 

• Complexity:  Indicates the complexity level of the Technology. 

• FC:  Specifies the variation of the fuel consumption estimate of a technology. 

• Cost:  Specifies the variation of the cost estimate of a technology. 

Index Technology Abbr. TechType Complexity FC Cost
1 Low Friction Lubricants LUB EngMod L 29.00% 15.50%
2 Engine Friction Reduction EFR EngMod L 33.33% 15.50%
3 VVT - Coupled Cam Phasing (CCP) on SOHC CCPS EngMod L 50.00% 15.50%
4 Discrete Variable Valve Lift (DVVL) on SOHC DVVLS EngMod L 50.00% 15.50%
5 Cylinder Deactivation on SOHC DEACS EngMod L 9.09% 15.50%
6 VVT - Intake Cam Phasing (ICP) ICP EngMod L 33.33% 15.50%
7 VVT - Dual Cam Phasing (DCP) DCP EngMod L 20.00% 15.50%
8 Discrete Variable Valve Lift (DVVL) on DOHC DVVLD EngMod L 50.00% 15.50%
9 Continuously Variable Valve Lift (CVVL) CVVL EngMod H 40.00% 46.50%
10 Cylinder Deactivation on DOHC DEACD EngMod L 100.00% 15.50%
11 Cylinder Deactivation on OHV DEACO EngMod L 17.02% 15.50%
12 VVT - Coupled Cam Phasing (CCP) on OHV CCPO EngMod L 20.00% 15.50%
13 Discrete Variable Valve Lift (DVVL) on OHV DVVLO EngMod L 66.67% 15.50%
14 Conversion to DOHC with DCP CDOHC EngMod L 42.86% 15.50%
15 Stoichiometric Gasoline Direct Injection (GDI) SGDI EngMod L 20.00% 15.50%
16 Combustion Restart CBRST EngMod M 29.00% 31.00%
17 Turbocharging and Downsizing TRBDS EngMod M 29.00% 31.00%
18 Exhaust Gas Recirculation (EGR) Boost EGRB EngMod M 29.00% 31.00%
19 Conversion to Diesel following CBRST DSLC EngMod M 29.00% 31.00%
20 Conversion to Diesel following TRBDS DSLT EngMod M 29.00% 31.00%
21 6-Speed Manual/Improved Internals 6MAN TrMod L 29.00% 15.50%
22 Improved Auto. Trans. Controls/Externals IATC TrMod L 25.00% 15.50%
23 Continuously Variable Transmission CVT TrMod M 48.15% 31.00%
24 6/7/8-Speed Auto. Trans with Improved Internals NAUTO TrMod L 41.67% 15.50%
25 Dual Clutch or Automated Manual Transmission DCTAM TrMod M 29.00% 31.00%
26 Electric Power Steering EPS ELEC L 33.33% 15.50%
27 Improved Accessories IACC ELEC M 33.33% 31.00%
28 12V Micro-Hybrid MHEV ELEC M 29.00% 31.00%
29 Belt mounted Integrated Starter Generator BISG ELEC M 29.00% 31.00%
30 Crank mounted Integrated Starter Generator CISG ELEC H 29.00% 46.50%
31 Power Split Hybrid PSHEV ELEC H 32.57% 46.50%
32 2-Mode Hybrid 2MHEV ELEC H 41.66% 46.50%
33 Plug-in Hybrid PHEV ELEC H 29.00% 46.50%
34 Material Substitution (1.50%) MS1 MSM L 29.00% 15.50%
35 Material Substitution (5% to 10% Cum) MS2 MSM L 29.00% 15.50%
36 Material Substitution (NA) MS5 MSM L 29.00% 15.50%
37 Low Rolling Resistance Tires ROLL DLR L 33.33% 15.50%
38 Low Drag Brakes LDB DLR L 33.33% 15.50%
39 Secondary Axle Disconnect - Unibody SAXU DLR L 29.00% 15.50%
40 Secondary Axle Disconnect - Ladder Frame SAXL DLR L 20.00% 15.50%
41 Aero Drag Reduction AERO AERO L 20.00% 15.50%

Technology FC and Cost Variations for Monte-Carlo Modeling
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Appendix A.3 Parameters File 

The benefits model parameters file contains a variety of input data and assumptions used 
to estimate various impacts of the simulated response of the industry to CAFE standards.  
The file contains a series of worksheets, the contents of which are summarized below. 

Appendix A.3.1 Vehicle Age Data 

The Vehicle Age Data worksheet contains age-specific (i.e., vintage-specific) estimates of the 
survival rate and annual accumulated mileage applicable to different vehicle categories. 

 
Table 16. Vehicle Age Data Worksheet (sources data shown as samples) 

 

Separate survival fractions are used for automobiles and light trucks.  These measure the 
proportion of vehicles originally produced during a model year that remain in service at 
each age (up to 25 years for automobiles and 35 years for light trucks), by which time only a 
small fraction typically remain in service. 

Appendix A.3.2 Forecast Data 

The Forecast Data worksheet contains estimates of future fuel prices, which are used when 
calculating pre-tax fuel outlays and fuel tax revenues.  It also contains the share of 
Ethanol-85 to Gasoline fuel, projected for each calendar year. 

 
Table 17. Forecast Data Worksheet (sources data shown as samples) 

 
 

Appendix A.3.3 Economic Values 

The Economic Values worksheet contains an estimate of the magnitude of the "rebound 
effect", as well as the rates used to compute the economic value of various direct and 

Model Characteristic Units Definition/Notes Source

Proportion of Original Sales 
Surviving to Age proportion

Proportion of original vehicle sales that remain in 
service by vehicle age (year 1 to 26 for cars, 1 - 36 for 
trucks)

Segment-Based Average Annual 
Miles Driven

miles Average annual miles driven by surviving vehicles by 
vehicle age (year 1 to 26 for cars, 1 - 36 for trucks)

Miles Driven at Low Fuel Prices miles
Annual miles driven at low fuel prices by surviving 
vehicles by vehicle age (year 1 to 26 for cars, 1 - 36 for 
trucks)

Miles Driven at High Fuel Prices miles
Annual miles driven at high fuel prices by surviving 
vehicles by vehicle age (year 1 to 26 for cars, 1 - 36 for 
trucks)

U.S. Environmental Protection Agency, Fleet 
Characterization Data for MOBILE6:  Development and 
Use of Age Distributions, Average Annual Mileage 
Accumulation Rates and Projected Vehicle Counts for 
Use in MOBILE6, EPA420-P-99-011, April 1999, 
http://www.epa.gov/otaq/models/mobile6/r01047.pdf, 
Appendix B, Table 4-5, p. 45.

Model Characteristic Units Definition/Notes Source

Retail Fuel Prices $/gallon 2007 $ per gallon, varies by fuel type, forecast by 
calendar year staring with MY-2000

Average Values from AEO 2008 Early Release; Low and 
High Values from AEO 2007

Fuel Taxes $/gallon
2007 $ per gallon, varies by fuel type, forecast by 
calendar year staring with MY-2000

calculated from "Federal Fuel Tax" and "Average State 
Fuel Tax" components, obtained from FHWA Highway 
Statistics, Tables FE-21B and MF-121T

Pre-Tax Fuel Price $/gallon 2007 $ per gallon, varies by fuel type, forecast by 
calendar year staring with MY-2000

calculated

E85 Share percent
percent share of Ethanol-85 vs. Gasoline fuel used 
during each calendar year; varies by fuel type, forecast 
by calendar year staring with MY-2000
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indirect impacts of CAFE standards, and the discount rate to apply when calculating 
present value.  As mentioned above, the user can define and edit all inputs.  For example, 
although Table 18 identifies available sources of information for economic values, the 
system does not require that the user rely on these sources. 
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Table 18. Economic Values Worksheet (sources data shown as samples) 

 
 

Model Characteristic Units Definition/Notes Source

Rebound Effect percent
increase in the annual use of vehicle models in 
response to lower per-mile cost of driving a more fuel-
efficient vehicle

various

Discount Rate percent
percent rate by which the dollar value of a benefit or 
cost is reduced when its receipt or payment is 
postponed by one additional year into the future

Office of Management and Budget, office of 
Information and Regulatory Analysis

Payback Period integer
number of years required for an initial investment to be 
repaid in the form of future benefits or cost savings

Kf $/mpg the CAFE fine rate
"Gap" between Test and On-Road 
MPG

percent difference between a vehicle's EPA fuel economy rating 
and its actual on-road fuel economy

EPA/OTAQ estimate

Value of Travel Time per Vehicle $/hour amount that the driver of a vehicle would be willing to 
pay to reduce the time required to make a trip

Volpe estimates

Economic Costs of Oil Imports various economic costs of various oil imports

"Monopsony" Component $/gallon

demand cost for imported oil; increasing domestic 
petroleum demand that is met through higher oil 
imports can cause the world price of oil to rise, and 
conversely that declining imports can reduce the world 
price of oil; determined by a complex set of factors, 
including the relative importance of U.S. imports in the 
world oil market and demand to its world price among 
other participants in the international oil market

Price Shock Component $/gallon

expected value of costs to U.S. economy from 
reduction in potential output resulting from risk of 
significant increases in world petroleum price; includes 
costs resulting from inefficiencies in resource use 
caused by incomplete adjustments to industry output 
levels and mixes of production input when world oil 
price changes rapidly

Military Security Component $/gallon

costs of taxpayers for maintaining a military presence 
to secure the supply of oil imports from potentially 
unstable regions of the world and protect the nation 
against their interruption

Total Economic Costs ($/gallon) $/gallon
total economic costs of oil imports (sum of 
monopsony, price shock, and military security 
components)

Total Economic Costs ($/BBL) $/BBL total economic costs of oil imports, specified in $/BBL

External Costs from Additional 
Vehicle Use Due
to "Rebound" Effect

$/vehicle-mile

estimates intended to represent costs per vehicle-mile 
of increased travel compared to approximately current 
levels, assuming current distribution of travel by hours 
of the day and facility types

Congestion $/vehicle-mile congestion component of external costs from 
additional vehicle use

Accidents $/vehicle-mile accidents component of external costs from additional 
vehicle use

Noise $/vehicle-mile noise component of external costs from additional 
vehicle use

Emission Damage Costs various additional costs arising from emission damage

Carbon Monoxide $/ton economic costs arising from Carbon Monoxide damage McCubbin & DeLucchi

Volatile Organic Compounds $/ton economic costs arising from Volatile Organic 
Compounds damage

Nitrogen Oxides $/ton economic costs arising from Nitrous Oxides damage

Particulate Matter $/ton economic costs arising from Particulate Matter damage

Sulfur Dioxide $/ton economic costs arising from Sulfur Oxides damage
Annual Growth Rate for Average 
VMT per Vehicle

various annual growth rate for average VMT per vehicle

Base Year for Average Annual 
Usage Data

model year base year for annual growth rate for average VMT per 
vehicle

Cars percent annual growth rate for average VMT per vehicle for 
passenger cars

Trucks percent annual growth rate for average VMT per vehicle for 
light trucks

Cost of CO-2 $/metric ton
economic costs arising from Carbon Dioxide damage, 
by calendar year; estimates for low, average, high, or 
very high growth rates are provided

CO-2 Discount Rates percent discount rates to apply to low, average, high, or very 
high Carbon Dioxide estimates

Leiby et al.

calculated

Federal Highway Administration, 1997 Highway Cost 
Allocation Study, T. V-23

OMB (1998), p. 72
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Appendix A.3.4 Fuel Properties 

The Fuel Properties worksheet contains estimates of the physical properties of gasoline, 
diesel, and other types of fuels, as well as certain assumptions about the effects of reduced 
fuel use on different sources of petroleum feedstocks and on imports of refined fuels.  These 
fuel properties and assumptions about the response of petroleum markets to reduced fuel 
use are used to calculate the changes in vehicular carbon dioxide emissions as well as in 
“upstream” emissions (from petroleum extraction and refining and from fuel storage and 
distribution) that are likely to result from reduced motor fuel use. 

 
Table 19. Fuel Properties Worksheet (sources data shown as samples) 

 
 

Appendix A.3.5 Upstream Emissions 

The Upstream Emissions worksheet contains emission factors for greenhouse gas and 
criteria pollutant emissions from petroleum extraction and transportation, and from fuel 
refining, storage, and distribution. 

 
Table 20. Upstream Emissions Worksheet (sources data shown as samples) 

 
 

Model Characteristic Units Definition/Notes Source

Energy Density BTU/gallon amount of energy stored in a given system or region of 
space per unit volume, specified by fuel type

Mass Density grams/gallon mass per unit volume, specified by fuel type

Carbon Content percent by 
weight

average share of carbon in fuel, specified by fuel type

SO-2 Emissions grams/gallon Sulfur Oxides emissions rate of gasoline and diesel 
fuels

Share of Fuel Savings Leading to
Lower Fuel Imports

percent assumed value for share of fuel savings leading to 
lower fuel imports

Share of Fuel Savings Leading to
Reduced Domestic Fuel Refining

percent assumed value for share of fuel savings leading to 
reduced domestic fuel refining

Share of Reduced Domestic
Refining from Domestic Crude

percent assumed value for share of reduced domestic refining 
from domestic crude

Share of Reduced Domestic
Refining from Imported Crude

percent assumed value for share of reduced domestic refining 
from imported crude

Assumed Gasoline Mix percent estimated share of total fuel consumption by fuel type

USEPA, Regulatory Impact Analysis for Tier 2 
Emissions Standard, Table 19, p. 42; and estimate 
supplied by Ford Motor Company in comments on 
proposed 2005-07 Light Truck CAFE Rule

Wang, Michael, The Greenhouse Gases, Regulated 
Emissions, and Energy Use in Transportation (GREET) 
Model: Version 1.5 Technical Report, Argonne 
National Laboratory, August 1999, Table 3.3, p. 25 
(http://greet.anl.gov/pdfs/esd_3v1.pdf)

Energy Information Administration, Annual Energy 
Outlook 2003, Tables 1, 2, and 117; and Volpe 
assumptions

Model Characteristic Units Definition/Notes Source

Petroleum Extraction grams/mil BTU
total emissions by stage of fuel production and 
distribution from petroleum extraction, specified by 
pollutant and fuel type

Petroleum Transportation grams/mil BTU
total emissions by stage of fuel production and 
distribution from petroleum transportation, specified by 
pollutant and fuel type

Petroleum Refining grams/mil BTU
total emissions by stage of fuel production and 
distribution from petroleum refining, specified by 
pollutant and fuel type

Fuel TS&D grams/mil BTU
total emissions by stage of fuel production and 
distribution from refined fuel transportation, storage, 
and delivery, specified by pollutant and fuel type

Argonne National Laboratory, The Greenhouse Gases, 
Regulated Emissions, and Energy Use in 
Transportation (GREET) Model, version 1.6, June 2001, 
Near-Term Output: Petroleum Fuels
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Appendix A.3.6 Monte-Carlo 

The Monte-Carlo worksheet contains parameters for setting up pseudo-random trial for 
uncertainty analysis. 

 
Table 21.  Monte-Carlo Worksheet 

 
 

Discount Rates (%) percent comma-separated list of discount rates to use during 
Monte-Carlo modeling

Fuel Path Randomization Parameters percent randomization parameters for the low, reference, or high 
fuel path

Rebound Effect Randomization 
Parameters

parameters for generating randomized rebound effect 
values

Carbon Dioxide Randomization 
Parameters

percent randomization parameters for the low, average, high or 
very high Carbon Dioxide path

Monopsony Randomization 
Parameters

dollars parameters for generating randomized monopsony cost 
values

Price Shock Randomization 
Parameters

dollars parameters for generating randomized price shock cost 
values

Military Security Randomization 
Parameters

dollars, percent parameters for generating randomized military security 
cost values

M
on

te
-C

ar
lo
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Appendix A.4 Emissions Rates File 

The emissions rates file contains vehicular criteria pollutant emission factors.  Emission 
factors (all in grams per mile and specific to both vehicle model year and age) for all fuel 
types (gasoline, reformulated gasoline, and Diesel, E85, CFG, Hydrogen, and two spares) 
and five pollutants (CO, VOC, NOX, PM2.5, and SO2) are contained in a series of forty 
worksheets of identical structure.  Some of the fuel types specified are provided for future 
use, and may not have been part of the current analysis. 

 
Table 22. Emissions Rates Worksheet (shown for CO - Gasoline only) (sources data shown as samples)  

 

Covered pollutants include carbon monoxide (CO), volatile organic compounds (VOC), 
nitrogen oxides (NOX), sulfur dioxide (SO2), and fine particulate matter (PM2.5, or 
particulate matter less than 2.5 microns in diameter).  Particulate matter includes sulfate 
particulates, elemental carbon, non-volatile organic carbon compounds, and airborne lead, 
as well as particulate emissions from brake and tire wear.  Because we are concerned with 
increased emissions from more intensive use of existing vehicles (rather than from a larger 
vehicle fleet), the emission factors we estimated included only the components associated 
with vehicle use, and omitted those associated with vehicle storage.  Emission components 
associated with increased vehicle use include exhaust emissions during vehicle start-up and 
operation, evaporative emissions during vehicle operation, cool-down ("hot soak"), and 
refueling, and particulate emissions from brake and tire wear. 

 

Model Characteristic Units Definition/Notes Source

CO LDGV grams/mile
Carbon Monoxide vehicle operation emission rate 
for MOBILE6 LDGV class for conventional 
gasoline.

CO LDGT12 grams/mile
Carbon Monoxide vehicle operation emission rate 
for MOBILE6 LDGT1 and LDGT2 classes for 
conventional gasoline.

CO LDGT34 grams/mile
Carbon Monoxide vehicle operation emission rate 
for MOBILE6 LDGT3 and LDGT4 classes for 
conventional gasoline.

CO HDGV2b grams/mile
Carbon Monoxide vehicle operation emission rate 
for MOBILE6 HDGV2b class for conventional 
gasoline.

U.S. Environmental Protection Agency, MOBILE 
Motor Vehicle Emission Factor Model, version 
6.1/6.2, October 2004.
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Appendix A.5 Scenarios File 

The scenarios file provides one or more worksheets that begin with "SCEN_" and are 
identified as CAFE program scenarios, which are defined in terms of the design and 
stringency of the CAFE program.  The system numbers these scenarios as 0, 1, 2 …, based 
on their order of appearance.  The first worksheet is assigned to Scenario 0, and is 
identified as the baseline scenario to which all others are compared.  Each scenario defines 
the CAFE program as it relates to the following "regulatory classes": 

Table 23. Regulatory Classes 
Reg. Class Includes 

0 Unregulated vehicles 

1 Passenger automobiles (domestic) 

2 Passenger automobiles (imported) 

3 Nonpassenger automobiles 

The "Regulatory Class" column on the vehicles worksheet discussed above is used to 
indicate whether the vehicle is regulated as a passenger or nonpassenger automobile.  The 
vehicle origin is further used to differentiate between regulatory classes 1 and 2 (domestic 
or imported).  Vehicles from one regulatory class may also be reassigned into another via 
the Regulatory Declassification section of the scenario as shown in Table 24. 

Table 24. Regulatory Declassification Codes 
Code Description 

<blank> Specifies that regulatory merging does not apply. 

RC1 Specifies that all passenger automobiles (domestic and imported) 
should be merged into regulatory class 1. 

RC3 Specifies that all vehicles should be merged into regulatory class 3. 

 
Table 25 shows an example of a CAFE scenario definition worksheet. 
 



 

54 

Table 25. Scenario Definition Worksheet (Sample) 

 
 
The purpose of each of the defined sections is as follows: 

• Scenario Description:  A short name describing the key features of the scenario. 

• Regulatory Declassification:  Specifies whether vehicles from one regulatory class should be 
merged with vehicles from another regulatory class. 

• Passenger Automobile Standards:  The CAFE functional or flat standards to use during 
modeling of the scenario.  The "Fnc Type" subsection determines the functional form the system 
will use for the specific scenario.  Presently, the supported functional forms are:  1, for flat 
standards; 2 for a logistic area-based functional form; and 6, for a linear area-based functional 
form.  The "Coefficients" subsection contains corresponding coefficient values.  And the "Alt. 
Minimum" sub-section applies to non-flat standard scenarios and represents the alternative 
minimum CAFE standards to apply to manufacturers whose required functional CAFE standard is 
below a specific minimum (mpg), or less than the specific percentage of the industry average (% 
average).  In the example scenario in Table 25, function type "2" is used, indicating that 
passenger automobiles should use a logistic area-based functional form, with the coefficients 
specified in fields A through D. 

2010 2011 2012 2013 2014 2015 2016 2017
RC1 RC1 RC1 RC1 RC1 RC1

2010 2011 2012 2013 2014 2015 2016 2017
Fnc Type 2 2 2 2 2 2

Coefficients
A 31.2 31.2 31.2 31.2 31.2 31.2
B 24.0 24.0 24.0 24.0 24.0 24.0
C 51.4 51.4 51.4 51.4 51.4 51.4
D 1.9 1.9 1.9 1.9 1.9 1.9

Alt. Minimum
mpg 27.5 27.5 27.5 27.5 27.5 27.5

% average 92% 92% 92% 92% 92% 92%

2010 2011 2012 2013 2014 2015 2016 2017
Fnc Type 2 2 2 2 2 2

Coefficients
A 27.1 27.1 27.1 27.1 27.1 27.1
B 21.1 21.1 21.1 21.1 21.1 21.1
C 56.4 56.4 56.4 56.4 56.4 56.4
D 4.3 4.3 4.3 4.3 4.3 4.3

Alt. Minimum
mpg

% average

2010 2011 2012 2013 2014 2015 2016 2017

Up to 2020 0.00%
After 2020 0.00%
Up to 2020 0.00%
After 2020 0.00%

Scenario Description

Passenger
Automobile Standards

Nonpassenger
Automobile Standards

Model YearCAFE Scenario Definition

Regulatory Declassification

MY2011 standards

Annual CAFE Growth Rate for EIS Modeling

Passenger

Nonpassenger

Comply By Industry
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• Nonpassenger Automobile Standards:  Same as the Passenger Automobile Standards section 
above, but applies to nonpassenger automobiles. 

• Comply By Industry:  "Y" forces the model to treat the entire industry as one manufacturer and 
perform compliance simulation on all manufacturers at the same time; "N" or blank is the default 
and performs compliance simulation on each manufacturer individually. 

• Annual CAFE Growth Rate for EIS Modeling:  This section applies only when the modeling 
system is used to perform supplemental analysis necessary for the Environmental Impact 
Statement.  It specifies the rate at which to growth the achieved CAFE levels past the last analysis 
year. 
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Appendix A.6 EIS Parameters File 

The EIS parameters file contains additional modeling parameters required to perform 
supplemental analysis necessary for the Environmental Impact Statement (EIS).  The file 
contains a series of worksheets, the contents of which are summarized below. 

Appendix A.6.1 Parameters 

The Parameters worksheet contains base parameters for use in EIS analysis. 
 

Table 26.  Parameters Worksheet (Sample) 

 
 

Appendix A.6.2 Emissions Rates 

The Emissions Rates worksheet contains upstream emission factors, specified in grams per 
gallon, for greenhouse gases (CO2, CH4, and N2O), criteria pollutants (VOC, CO, NOx, 
PM2.5, and SOx), and air toxics (formaldehyde, acetaldehyde, butadiene, benzene, acrolein, 
MTBE, and diesel PM).  This worksheet also contains tailpipe emissions, in grams per 
gallon, for selected pollutants (CO2 and SOx).  The rest of the tailpipe emissions are 
provided in the EIS Tailpipe Emissions file. 

 
Table 27. Emissions Rates Worksheet (Sample) 

 
 

Appendix A.6.3 Upstream Process Emission Rates 

The Upstream worksheet contains emission factors by stage of processing for criteria 
pollutants and air toxics.  The emission factors are separated, for each pollutant, by fuel 
type and stage of fuel production (petroleum extraction, petroleum transportation, 
petroleum refining, and fuel TS&D).  This worksheet performs internal calculations to 

Annual Growth Rate for Average VMT per Vehicle
Base Year for Average Annual Usage Data 2001
Cars 1.15%
Light Trucks 1.15%

Rebound Effect 10%
On-Road Fuel Economy Gap 20%
Elasticity of Vehicle Use wrt Fuel Price per Gallon (SR) -0.10

CO2 CH4 N2O VOC CO NOx PM2.5 SOx Formaldehyde Acetaldehyde Butadiene Benzene Acrolein MTBE Diesel PM
Gasoline 2,072 12.5191 0.1011 5.1451 0.4921 1.5405 0.2097 0.9419 0.00412 0.00055 0.00012 0.01113 0.00008 0.00000 0.58700
Diesel 2,105 13.5817 0.0334 0.5992 0.9289 2.7099 0.4068 1.8534 0.00482 0.00061 0.00026 0.00476 0.00009 0.00000 0.47327

CO2 SOx
Gasoline 8,852 0.170
Diesel 10,239 0.096

Upstream Emission Rates (grams per gallon)

Tailpipe Emission Rates (grams per gallon)

Air ToxicsCriteria PollutantsGreenhouse Gases
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obtain the domestic emissions by stage of fuel production and distribution, specified in 
grams per gallon, as shown in the table below. 

 
Table 28. Upstream Worksheet (Excerpt, shown for selected pollutants) 

 
 

Appendix A.6.4 Fuel Prices 

The Fuel Prices worksheet provides historical and forecast retail fuel prices, specified 2007$ 
per gallon.  Historical data is provided between 1975 and 2005; forecast data is between 
2006 and 2060.  

 

Petroleum
Extraction

Petroleum
Transportation

Petroleum
Refining

Fuel
TS&D Total

Conventional Gasoline 0.0176 0.0109 0.3787 0.0869 0.4941
Federal Reformulated Gasoline 0.0173 0.0106 0.3732 0.0872 0.4883
California Reformulated Gasoline 0.0214 0.0066 0.3743 0.0875 0.4897
Weighted Average for Gasoline 0.0175 0.0108 0.3768 0.0870 0.4921
Low Sulfur Diesel 0.0393 0.0242 0.7644 0.1010 0.9289
Conventional Gasoline 0.0074 0.0102 0.1835 4.9817 5.1828
Federal Reformulated Gasoline 0.0072 0.0100 0.1824 4.8755 5.0751
California Reformulated Gasoline 0.0074 0.0099 0.1829 4.8894 5.0896
Weighted Average for Gasoline 0.0073 0.0102 0.1831 4.9445 5.1451
Low Sulfur Diesel 0.0165 0.0228 0.3966 0.1633 0.5992
Conventional Gasoline 0.0419 0.0446 1.0315 0.4284 1.5465
Federal Reformulated Gasoline 0.0410 0.0437 1.0146 0.4301 1.5294
California Reformulated Gasoline 0.0532 0.0318 1.0175 0.4313 1.5338
Weighted Average for Gasoline 0.0416 0.0443 1.0256 0.4290 1.5405
Low Sulfur Diesel 0.0935 0.0996 2.0545 0.4623 2.7099

Fuel TypePollutant

CO

VOC

NOx

Domestic Emissions by Stage of Fuel Production
 and Distribution (grams/gallon)
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Table 29. Fuel Prices Worksheet (Sample) 

 
 

Appendix A.6.5 Forecast Data 

The Forecast Data worksheet contains age-specific estimates of the survival rate and 
annual accumulated mileage applicable to passenger cars and light trucks.  Original and 
"conditional" survival rates are provided, both of which are used internally in the 
worksheet.  The former are used for adjusting the conditional rates, while the latter are 
used to estimate data in the Car Fleet and Truck Fleet worksheets.  The accumulated 
millage section provides three separate paths (for each vehicle type) for miles driven at low, 
reference, and high fuel prices. 

 

Low Reference High Low Reference High
1975 $1.788 $1.788 $1.788 $1.788 $1.788 $1.788
1976 $1.759 $1.759 $1.759 $1.759 $1.759 $1.759
…

2000 $1.873 $1.873 $1.873 $1.787 $1.787 $1.787
2001 $1.791 $1.791 $1.791 $1.639 $1.639 $1.639
2002 $1.657 $1.657 $1.657 $1.517 $1.517 $1.517
2003 $1.844 $1.844 $1.844 $1.699 $1.699 $1.699
2004 $2.105 $2.105 $2.105 $1.981 $1.981 $1.981
2005 $2.478 $2.478 $2.478 $2.546 $2.546 $2.546
2006 $2.707 $2.707 $2.707 $2.786 $2.786 $2.786
2007 $2.822 $2.831 $2.822 $2.870 $2.894 $2.870
2008 $3.205 $3.172 $3.205 $3.723 $3.714 $3.723
2009 $2.282 $2.279 $2.282 $2.630 $2.387 $2.630
2010 $2.213 $2.441 $3.078 $2.278 $2.566 $3.020
2011 $2.194 $2.473 $3.361 $2.251 $2.591 $3.387
2012 $2.103 $2.609 $3.627 $2.164 $2.752 $3.701
2013 $2.082 $2.844 $3.914 $2.163 $2.889 $4.042
2014 $2.044 $2.954 $4.241 $2.191 $2.984 $4.410
2015 $2.028 $3.004 $4.496 $2.161 $3.077 $4.671
2016 $2.033 $3.072 $4.656 $2.162 $3.176 $4.818
2017 $2.035 $3.135 $4.838 $2.160 $3.254 $4.995
2018 $2.041 $3.185 $4.935 $2.169 $3.342 $5.097
2019 $2.025 $3.222 $5.003 $2.146 $3.393 $5.154
2020 $2.024 $3.268 $5.043 $2.147 $3.434 $5.201

…
2059 $2.070 $4.934 $6.933 $2.278 $5.170 $6.819
2060 $2.071 $4.987 $6.990 $2.282 $5.225 $6.866

Calendar Year
DieselGasoline
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Table 30. Forecast Data Worksheet (Sample) 

 
 

Appendix A.6.6 Sales, Car Fleet, and Truck Fleet 

The Sales worksheet contains projected vehicle production for sale in the U.S. between 
model years 2005 and 2060.  The Sales worksheet is used internally to estimate data that 
goes into the Car Fleet and Truck Fleet worksheets. 

 

Low Reference High Low Reference High
0 100.00% 100.00% 100.00% 100.00% 14,231 14,231 14,231 16,085 16,085 16,085
1 99.50% 99.50% 99.50% 99.50% 13,961 13,961 13,961 15,782 15,782 15,782
2 99.00% 97.41% 99.50% 97.90% 13,669 13,669 13,669 15,442 15,442 15,442
3 98.31% 96.03% 99.30% 98.58% 13,357 13,357 13,357 15,069 15,069 15,069
4 97.31% 94.20% 98.98% 98.09% 13,028 13,028 13,028 14,667 14,667 14,667
5 95.93% 91.90% 98.58% 97.56% 12,683 12,683 12,683 14,239 14,239 14,239
6 94.13% 89.13% 98.12% 96.99% 12,325 12,325 12,325 13,790 13,790 13,790
7 91.88% 85.90% 97.61% 96.38% 11,956 11,956 11,956 13,323 13,323 13,323
8 89.18% 82.26% 97.06% 95.76% 11,578 11,578 11,578 12,844 12,844 12,844
9 86.04% 78.27% 96.48% 95.15% 11,193 11,193 11,193 12,356 12,356 12,356
10 82.52% 74.01% 95.91% 94.56% 10,804 10,804 10,804 11,863 11,863 11,863
11 78.66% 69.56% 95.32% 93.99% 10,413 10,413 10,413 11,369 11,369 11,369
12 71.70% 65.01% 91.15% 93.46% 10,022 10,022 10,022 10,879 10,879 10,879
13 61.25% 60.42% 85.43% 92.94% 9,633 9,633 9,633 10,396 10,396 10,396
14 50.94% 55.17% 83.17% 91.31% 9,249 9,249 9,249 9,924 9,924 9,924
15 41.42% 50.09% 81.31% 90.79% 8,871 8,871 8,871 9,468 9,468 9,468
16 33.08% 45.22% 79.86% 90.28% 8,502 8,502 8,502 9,032 9,032 9,032
17 26.04% 40.62% 78.72% 89.83% 8,144 8,144 8,144 8,619 8,619 8,619
18 20.28% 36.33% 77.88% 89.44% 7,799 7,799 7,799 8,234 8,234 8,234
19 15.65% 32.36% 77.17% 89.07% 7,469 7,469 7,469 7,881 7,881 7,881
20 12.00% 28.73% 76.68% 88.78% 7,157 7,157 7,157 7,565 7,565 7,565
21 9.16% 25.42% 76.33% 88.48% 6,866 6,866 6,866 7,288 7,288 7,288
22 6.96% 22.44% 75.98% 88.28% 6,596 6,596 6,596 7,055 7,055 7,055
23 5.27% 19.75% 75.72% 88.01% 6,350 6,350 6,350 6,871 6,871 6,871
24 3.99% 17.35% 75.71% 87.85% 6,131 6,131 6,131 6,739 6,739 6,739
25 3.01% 15.22% 75.44% 87.72% 5,940 5,940 5,940 6,663 6,663 6,663
26 2.27% 13.32% 75.42% 87.52% 5,780 5,780 5,780 6,648 6,648 6,648
27 0.00% 11.65% 0.00% 87.46% 5,654 5,654 5,654 6,648 6,648 6,648
28 0.00% 10.17% 0.00% 87.30% 5,562 5,562 5,562 6,648 6,648 6,648
29 0.00% 8.87% 0.00% 87.22% 5,508 5,508 5,508 6,648 6,648 6,648
30 0.00% 7.73% 0.00% 87.15% 5,508 5,508 5,508 6,648 6,648 6,648
31 0.00% 6.73% 0.00% 87.06% 5,508 5,508 5,508 6,648 6,648 6,648
32 0.00% 5.86% 0.00% 87.07% 5,508 5,508 5,508 6,648 6,648 6,648
33 0.00% 5.09% 0.00% 86.86% 5,508 5,508 5,508 6,648 6,648 6,648
34 0.00% 4.43% 0.00% 87.03% 5,508 5,508 5,508 6,648 6,648 6,648
35 0.00% 3.85% 0.00% 86.91% 5,508 5,508 5,508 6,648 6,648 6,648
36 0.00% 3.34% 0.00% 86.75% 5,508 5,508 5,508 6,648 6,648 6,648
37 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
38 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
39 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
40 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
41 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
42 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
43 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
44 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
45 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
46 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
47 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
48 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
49 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
50 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
51 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
52 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
53 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
54 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
55 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
56 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
57 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
58 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
59 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648
60 0.00% 0.00% 0.00% 0.00% 5,508 5,508 5,508 6,648 6,648 6,648

Vehicle Age Passenger Cars Light Trucks

Original Survival Rates Conditional Survival Rates

Passenger Cars Light Trucks

Average Annual Miles Driven
Light TrucksPassenger Cars
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Table 31. Sales Worksheet (Sample) 

 

The Car Fleet and Truck Fleet worksheets provide historic and projected data of vehicles 
remaining on the road, specified by model year and calendar year.  The period of years 
covered is between 1975 and 2060.  The conditional survival rates on the Forecast Data 
worksheet, along with forecast of sales on the Sales worksheet are used when estimating 
the projected data. 

 
Table 32. Car Fleet (Sample) 

 
 
The structure of both worksheets (Car Fleet and Truck Fleet) is identical. 
 

2005 7,698,885 8,125,438 15,824,323
2006 7,809,903 7,875,145 15,685,047
2007 7,704,630 7,474,079 15,178,708
2008 6,614,097 5,830,264 12,444,360
2009 4,829,454 4,383,431 9,212,885
2010 5,136,304 5,270,257 10,406,561
2011 7,922,670 5,457,537 13,380,207
2012 9,122,736 5,798,295 14,921,031
2013 9,797,100 6,038,091 15,835,190
2014 10,231,299 5,947,426 16,178,725
2015 10,626,436 5,826,239 16,452,676
2016 10,831,738 5,669,364 16,501,102
2017 10,694,688 5,490,255 16,184,943
2018 10,688,660 5,281,916 15,970,576
2019 10,930,975 5,191,409 16,122,384
2020 11,387,039 5,154,528 16,541,566

…
2059 17,083,605 6,370,273 23,453,879
2060 17,235,456 6,426,897 23,662,353

TotalLight TrucksPassenger CarsCalendar Year

1975 1976 1977 1978 1979 1980 1981 1982 … 2059 2060
1975 5,155,795 7,459,274 7,395,419 7,206,478 6,911,003 6,608,778 6,391,110 6,120,707 0 0
1976 6,533,377 9,452,325 9,371,408 9,096,899 8,797,199 8,632,878 8,371,761 0 0
1977 7,096,747 10,267,394 10,110,566 9,823,405 9,649,940 9,552,440 0 0
1978 7,358,777 10,573,362 10,358,469 10,165,079 10,029,281 0 0
1979 7,207,394 10,277,491 10,119,116 9,950,999 0 0
1980 5,806,894 8,707,110 8,712,739 0 0
1981 5,064,756 8,127,671 0 0
1982 4,326,717 0 0

…
2059 13,169,445 16,925,159
2060 826,571 13,286,504

Model Year
Calendar Year



 

61 

Appendix A.6.7 Fuel Economy 

The Fuel Economy worksheet contains actual fuel economy levels and diesel shares 
covering the years between 1975 and 2060.  Data is provided for gasoline and diesel fuel 
types and is separated by passenger cars and light trucks.  The data is further separated 
into two subsections, one working under the assumption that the CAFE program does not 
exists ("Without CAFE"), and the other taking the impact of the CAFE program into 
account ("With CAFE"). 

For the "Without CAFE" subsection, the fuel economy levels and diesel shares are flatlined 
after 1977, all the way to 2060.  In the "With CAFE" subsection, historic data is provided up 
to 2010.  For model years 2011 to 2016, resultant fuel economy levels and diesel shares 
form the modeling analysis are inserted in place of historic data.  Data in model years 2017 
to 2060 are either flatlined, based on the 2016 values, or incremented by the growth rates 
specified in the scenarios file, depending on the assumptions used during EIS modeling. 

 
Table 33. Fuel Economy Worksheet (Sample) 

 
 
 

Gasoline Diesel Diesel Share Gasoline Diesel Diesel Share Gasoline Diesel Diesel Share Gasoline Diesel Diesel Share
1975 15.8 15.8 0.3% 15.8 15.8 0.3% 13.7 13.7 0.3% 13.7 13.7 0.3%
1976 17.5 17.5 1.1% 17.5 17.5 1.1% 14.4 14.4 0.3% 14.4 14.4 0.3%

…
2000 18.3 18.3 1.9% 28.5 28.5 0.3% 15.2 15.2 0.3% 21.3 21.3 0.3%
2001 18.3 18.3 1.9% 28.8 28.8 0.2% 15.2 15.2 0.3% 20.9 20.9 0.3%
2002 18.3 18.3 1.9% 29.0 29.0 0.4% 15.2 15.2 0.3% 21.4 21.4 0.3%
2003 18.3 18.3 1.9% 29.5 29.5 0.5% 15.2 15.2 0.3% 21.8 21.8 0.3%
2004 18.3 18.3 1.9% 29.5 29.5 0.4% 15.2 15.2 0.3% 21.5 21.5 0.3%
2005 18.3 18.3 1.9% 30.3 30.3 0.6% 15.2 15.2 0.3% 22.1 22.1 0.3%
2006 18.3 18.3 1.9% 29.9 29.9 0.6% 15.2 15.2 0.3% 22.5 22.5 0.3%
2007 18.3 18.3 1.9% 30.0 30.0 0.6% 15.2 15.2 0.3% 22.5 22.5 0.4%
2008 18.3 18.3 1.9% 30.1 30.1 0.6% 15.2 15.2 0.3% 22.5 22.5 0.6%
2009 18.3 18.3 1.9% 30.3 30.3 0.6% 15.2 15.2 0.3% 22.6 22.6 0.8%
2010 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2011 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2012 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2013 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2014 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2015 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2016 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2017 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2018 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2019 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2020 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%

…
2059 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%
2060 18.3 18.3 1.9% 30.4 30.4 0.6% 15.2 15.2 0.3% 22.6 22.6 1.0%

Model Year

Passenger Cars Light Trucks
Without CAFE With CAFE Without CAFE With CAFE
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Appendix A.7 EIS Tailpipe Emissions 

The EIS tailpipe emissions file contains pollutant emission factors necessary for EIS 
analysis.  Emission factors are specified in grams per mile by calendar and model years, 
covering the period between 1975 and 2060.  The included pollutants are:  acetaldehyde, 
acrolein, benzene, butadiene, CH4, CO, diesel PM10, formaldehyde, MTBE, N2O, NOx, PM, 
SO2, and VOC.  Each pollutant contains emissions factors separated by gasoline and diesel 
fuel types, as well as by cars and trucks (LDGV for gasoline cars, LDGT for gasoline trucks, 
LDDV for diesel cars, and LDDT for diesel trucks). 

 
Table 34. EIS Tailpipe Emissions (Sample for sellected pollutant & fuel type only) 

 
 
 
 
 

Model Year 1975 1976 1977 1978 1979 1980 1981 1982 … 2059 2060
1975 0.01700 0.02202 0.02761 0.03302 0.03831 0.04351 0.04102 0.04209 0.09408 0.09408
1976 0.01700 0.02202 0.02761 0.03302 0.03831 0.04351 0.04102 0.09408 0.09408
1977 0.01700 0.02202 0.02761 0.03302 0.03831 0.04351 0.09408 0.09408
1978 0.01686 0.02182 0.02735 0.03270 0.03793 0.09271 0.09271
1979 0.01683 0.02179 0.02732 0.03266 0.09256 0.09256
1980 0.00733 0.01148 0.01621 0.06457 0.06457
1981 0.00553 0.00765 0.03059 0.03059
1982 0.00538 0.02798 0.02798

…
2059 0.00046 0.00047
2060 0.00046

Calendar Year
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Appendix B Model Outputs 

The system produces seven formatted output files, all as Microsoft Excel workbooks, four of 
which are for each scenario defined in the compliance model scenarios file, two cumulative 
output files covering all scenarios, and one output file applicable only when performing 
optimization modeling.  The system places all files in the "reports" folder, located in the 
user selected output path (ex: C:\cafe\demo-run\demo\reports).  Table 35 lists the 
available output files and their contents.  As discussed earlier, the first scenario appearing 
in the scenarios file is assigned to Scenario 0 and treated as the baseline scenario.  Output 
files for all other scenarios report absolute and relative changes compared to this baseline.20

 

 

Table 35. Output Files 
Output File21 Contents  

Industry_Report_Sn*.xls 

Contains industry-wide and manufacturer-specific results, showing all model 
years per worksheet, for each regulatory class:22

Manufacturers_Report_Sn*.xls 

 sales; preliminary and final 
value of CAFE standard; average fuel economy, curb weight, area, incurred 
technology cost, incurred fine, price increase; total technology costs, fines, and 
increases in sales revenue; technology application and penetration rates. 

Contains industry-wide and manufacturer-specific results, showing one model 
year per worksheet, for each regulatory class: sales; preliminary and final value 
of CAFE standard; average fuel economy, curb weight, area, incurred 
technology cost, incurred fine, price increase; total technology costs, fines, and 
increases in sales revenue; technology application and penetration rates. 

Vehicles_Report_Sn*.xls 

Provides vehicle model-specific results: index, ID number, manufacturer, model 
name, nameplate, regulatory class, technology class, predecessor ID number, 
initial and final sales, initial MSRP and price, initial and final fuel economy and 
curb weight, area, engine ID number and basic characteristics, transmission ID 
number and type, unit and total technology cost and price increase, redesign and 
refresh states, application and usage status of each technology. 

ScenSummary_Report.xls 

Displays a summary of industry-wide and manufacturer-specific results, 
compared versus the baseline for all scenarios: total costs and benefits 
(manufacturer and total cost, fuel savings, preliminary and final value of CAFE 
standard, total and net benefits, and benefit-to-cost ratio); price increase. 

Effects_Report_Sn*.xls 
Provides national-scale effects: travel demand, fuel consumption, carbon dioxide 
and criteria pollutant emissions, and economic externalities related to highway 
travel and petroleum consumption. 

EA_Report.xls Presents national-scale effects, for all scenarios, disaggregated by calendar year 
for each model year: fuel consumption and carbon dioxide and criteria pollutant 

                                                 
20 For example, if the baseline scenario involves a flat 27.5 mpg standard for passenger automobiles and Scenario 3 
examines a reformed standard with a higher average required value of CAFE standard, Industry_Summary_Sn3.xls 
might report total technology costs of $2.2b, of which about $2.0b might be attributable to the increase in the overall 
standard. 
21 Here, the asterisk (*) indicates a number corresponding to a scenario, with 0 indicating the baseline scenario. 
22 As discussed earlier, RC0=unregulated vehicles, RC1=domestic passenger autos, RC2=imported passenger autos, 
and RC3 =nonpassenger autos (i.e., light trucks). 
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emissions. 

OptIndExt_Report.xls 

Provides industry-wide and manufacturer-specific technology costs, fines, and 
benefits, as well as carbon dioxide and fuel savings, and benefit-cost ratios, for 
all iterations from industry optimization.  This report also graphs the socially 
optimized functional form (aka, optimized shape) for the entire industry by 
model year, and displays benefit-cost, marginal benefit:cost, net benefits, and 
optimized shape charts. 

The remainder of this section shows sample output files for a scenario based on reformed 
passenger automobile standards.  This scenario addresses model years spawning six years 
(2011-2016), however, only years 2012 and 2016 are displayed in most screenshots.  The 
scenario assumes regulatory merging of all vehicles into RC1 (domestic passenger autos).  
Also, because the output files produced by the system are extensive, the text shows only 
portions of some files.  Furthermore, although the system produces output specific to each 
represented vehicle model, only the more summarized output files are shown here. 
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Appendix B.1 Industry Report 

 
Table 36. Industry Report (Sample) 

 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

0 0 - %      0 0 - %        
9,122,736 0 - %      10,831,738 0 - %        

0 0 - %      0 0 - %        
0 0 - %      0 0 - %        

9,122,736 0 - %      10,831,738 0 - %        
0.00 0.00 - %      0.00 0.00 - %        

33.35 2.86 9%      37.76 7.28 24%      
0.00 0.00 - %      0.00 0.00 - %        
0.00 0.00 - %      0.00 0.00 - %        

33.35 2.86 9%      37.76 7.28 24%      
0.00 0.00 - %      0.00 0.00 - %        

33.35 2.86 9%      37.76 7.28 24%      
0.00 0.00 - %      0.00 0.00 - %        
0.00 0.00 - %      0.00 0.00 - %        

33.35 2.86 9%      37.76 7.28 24%      
0.00 0.00 - %      0.00 0.00 - %        

32.77 1.20 4%      37.21 5.35 17%      
0.00 0.00 - %      0.00 0.00 - %        
0.00 0.00 - %      0.00 0.00 - %        

32.77 1.20 4%      37.21 5.35 17%      
0 0 - %      0 0 - %        

3,281 -9 (0%)     3,177 -99 (3%)       
0 0 - %      0 0 - %        
0 0 - %      0 0 - %        

3,281 -9 (0%)     3,177 -99 (3%)       
0 0 - %      0 0 - %        

45 0 - %      45 0 - %        
0 0 - %      0 0 - %        
0 0 - %      0 0 - %        

45 0 - %      45 0 - %        
 - $        - $       - %       - $          - $       - %        

542.23$    454.74$    520%   972.32$      880.22$    956%     
 - $        - $       - %       - $          - $       - %        
 - $        - $       - %       - $          - $       - %        

542.23$    454.74$    520%   972.32$      880.22$    956%     
 - $        - $       - %       - $          - $       - %        

53.65$      49.80$      1293% 27.18$       26.84$      7935%   
 - $        - $       - %       - $          - $       - %        
 - $        - $       - %       - $          - $       - %        

53.65$      49.80$      1293% 27.18$       26.84$      7935%   
 - $        - $       - %       - $          - $       - %        

595.88$    504.54$    552%   999.49$      907.06$    981%     
 - $        - $       - %       - $          - $       - %        
 - $        - $       - %       - $          - $       - %        

595.88$    504.54$    552%   999.49$      907.06$    981%     
 - $        - $       - %       - $          - $       - %        

4,946.65$ 4,148.47$ 520%   10,531.86$ 9,534.29$ 956%     
 - $        - $       - %       - $          - $       - %        
 - $        - $       - %       - $          - $       - %        

4,946.65$ 4,148.47$ 520%   10,531.86$ 9,534.29$ 956%     
 - $        - $       - %       - $          - $       - %        

489.40$    454.28$    1293% 294.39$      290.72$    7935%   
 - $        - $       - %       - $          - $       - %        
 - $        - $       - %       - $          - $       - %        

489.40$    454.28$    1293% 294.39$      290.72$    7935%   
 - $        - $       - %       - $          - $       - %        

5,436.05$ 4,602.75$ 552%   10,826.25$ 9,825.01$ 981%     
 - $        - $       - %       - $          - $       - %        
 - $        - $       - %       - $          - $       - %        

5,436.05$ 4,602.75$ 552%   10,826.25$ 9,825.01$ 981%     

Overall

Value of Preliminary CAFE Standard

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Value of Final CAFE Standard

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Fuel Economy

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Curb Weight (lb.)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Area (sq. ft.)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Technology Costs (RPE)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Fines Incurred (RPE)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Price Increase Per Vehicle
(Including Tech Costs and Fines)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Total Incurred Technology Costs ($m)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Total Fines Owed ($m)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Total Increase in Sales Revenue ($m)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

2012 Total
Industry Overall

Total Sales

Unregulated
Dom Auto
Imp Auto

Light Truck

2016 Total
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Appendix B.2 Manufacturers Report 

 
Table 37. Manufacturers Report (Sample) 

 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

0 0 - %   0 0 - %   0 0 - %   
326,314 0 - %   1,355,584 0 - %   388,130 0 - %   

0 0 - %   0 0 - %   0 0 - %   
0 0 - %   0 0 - %   0 0 - %   

326,314 0 - %   1,355,584 0 - %   388,130 0 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   

29.40 0.00 - %   30.80 0.00 - %   30.80 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   

29.40 0.00 - %   30.80 0.00 - %   30.80 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   

29.40 0.00 - %   30.80 0.00 - %   30.80 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   

29.40 0.00 - %   30.80 0.00 - %   30.80 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   

28.16 0.00 - %   35.11 0.00 - %   30.48 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   
0.00 0.00 - %   0.00 0.00 - %   0.00 0.00 - %   

28.16 0.00 - %   35.11 0.00 - %   30.48 0.00 - %   
0 0 - %   0 0 - %   0 0 - %   

3,572 0 - %   3,109 0 - %   3,445 0 - %   
0 0 - %   0 0 - %   0 0 - %   
0 0 - %   0 0 - %   0 0 - %   

3,572 0 - %   3,109 0 - %   3,445 0 - %   
0 0 - %   0 0 - %   0 0 - %   

47 0 - %   44 0 - %   44 0 - %   
0 0 - %   0 0 - %   0 0 - %   
0 0 - %   0 0 - %   0 0 - %   

47 0 - %   44 0 - %   44 0 - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   

22.07$     - $ - %    - $      - $ - %   171.67$   - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   

22.07$     - $ - %    - $      - $ - %   171.67$   - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %   16.50$     - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %   16.50$     - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   

22.07$     - $ - %    - $      - $ - %   188.17$   - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   

22.07$     - $ - %    - $      - $ - %   188.17$   - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
7.20$      - $ - %    - $      - $ - %   66.63$     - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
7.20$      - $ - %    - $      - $ - %   66.63$     - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %   6.40$      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %   6.40$      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
7.20$      - $ - %    - $      - $ - %   73.04$     - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
 - $      - $ - %    - $      - $ - %    - $      - $ - %   
7.20$      - $ - %    - $      - $ - %   73.04$     - $ - %   

Overall

Value of Preliminary CAFE Standard

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Value of Final CAFE Standard

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Fuel Economy

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Curb Weight (lb.)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Area (sq. ft.)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Technology Costs (RPE)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Fines Incurred (RPE)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Average Price Increase Per Vehicle
(Including Tech Costs and Fines)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Total Incurred Technology Costs ($m)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Total Fines Owed ($m)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

Total Increase in Sales Revenue ($m)

Unregulated
Dom Auto
Imp Auto

Light Truck
Overall

MFR-1
Manufacturer

Total Sales

Unregulated
Dom Auto
Imp Auto

Light Truck

MFR-2 MFR-3
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Appendix B.3 Vehicles Report 

 
Table 38. Vehicles Report (Contents) 

 

Group Column Contents
Unique vehicle index across the entire industry.
Unique vehicle ID per manufacturer.
The manufacturer of the vehicle.
Name of the vehicle model.
The nameplate of the vehicle.
The regulatory class assignment of the vehicle.
The technology class of the vehicle.
ID number of the vehicle's predecessor.

Initial Initial sales volume (units).
Final Final sales volume (units).

Initial MSRP ($).
Intial Price ($).

Initial Initial fuel economy.
Final Final fuel economy.
Initial Initial curb weight.
Final Final curb weight.

Vehicle footprint.
ID# ID number of the vehicle's engine.
Fuel Engine fuel type.
Disp (lit.) Engine displacement.
Cyl. Number of cylinders in an engine.
ID# ID number of the vehicle's transmission.
Type Type of the transmission.
Incurred Tech Cost Unit technology cost ($).
Price Increase Unit price increase ($).
Incurred Tech Cost Total technology cost ($k).
Increase in Sales Rev. Total increase in revenue ($k).

Redesign state of the vehicle.
Refresh state of the vehicle.
Usage of each technology by the vehicle.Technology Utilization/Applicability

Total ($k)

Unit ($)

Transmission

Refresh State
Redesign State

Engine

Curb Weight (lb)

Fuel Econ. (mpg)

Total Sales

Initial Price ($)
Initial MSRP ($)

Area (sf)

Pred ID#
Technology Class

Reg Class
Name Plate

Model
Manufacturer

ID#
Index
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Appendix B.4 Scenario Summary Report 

 
Table 39. Scenario Summary Report (Sample) 

 

2011 2012 2013 2014 2015 2016 Total 2011 2012 2013 2014 2015 2016 Total
MFR-1 0 -21 -32 -25 -23 -24 -125 0 3 -2 -2 -2 -2 -4
MFR-2 0 0 0 0 0 0 0 0 157 216 302 353 388 1,416
MFR-3 -7 -34 -32 -30 -28 -28 -160 0 300 445 465 498 543 2,251
MFR-4 -67 -74 -83 -84 -89 -89 -485 0 63 213 247 279 456 1,259
MFR-5 -42 -127 -126 -181 -196 -196 -868 0 1 1 9 76 247 334
MFR-6 0 0 0 0 0 0 0 0 210 234 304 380 434 1,562
MFR-7 -1 -39 -36 -37 -41 -40 -193 0 54 57 182 284 282 858
MFR-8 -16 -22 -20 -16 -14 -14 -100 0 59 48 140 154 151 553
MFR-9 0 0 0 0 0 0 0 0 33 47 76 127 152 434

MFR-10 -64 -279 -267 -248 -258 -255 -1,371 0 710 1,384 1,637 1,937 2,004 7,672
MFR-11 -4 -9 -37 -37 -47 -47 -180 0 4 5 9 20 46 84
MFR-12 -41 -135 -135 -138 -157 -152 -758 0 2,377 2,283 2,403 2,642 2,937 12,642
MFR-13 0 0 0 0 0 0 0 0 98 269 604 669 787 2,427
MFR-14 -1 -1 -4 -4 -4 -4 -18 0 0 51 71 80 104 305
MFR-15 0 0 0 0 0 0 0 0 50 57 85 263 279 735
MFR-16 0 0 0 0 0 0 0 0 30 104 223 250 424 1,031
MFR-17 -42 -57 -70 -139 -150 -150 -609 0 0 0 100 211 301 612

Big-17 Summary
Total -283 -798 -842 -939 -1,007 -998 -4,867 0 4,148 5,411 6,855 8,221 9,534 34,170

Fuel Savings (BG) -0.808 -2.126 -2.262 -2.496 -2.756 -2.830 -13.277 0.000 2.396 5.153 7.233 9.446 11.433 35.660
Preliminary Standard (MPG) 1.0 1.0 1.0 1.0 1.0 1.0 30.4 33.3 34.2 34.9 36.2 37.8

Final Standard (MPG) 1.0 1.0 1.0 1.0 1.0 1.0 30.4 33.3 34.2 34.9 36.2 37.8
Total Benefits -2,294 -6,178 -6,721 -7,541 -8,453 -8,803 -39,991 0 6,826 15,155 21,626 28,677 35,200 107,483
Net Benefits -2,011 -5,380 -5,879 -6,602 -7,446 -7,806 -35,123 0 2,677 9,745 14,770 20,455 25,665 73,313

Benefit:Cost Ratio 8.09 7.74 7.98 8.03 8.39 8.82 8.22 N/A 1.65 2.80 3.15 3.49 3.69 3.15
Entire Industry Summary

Total -283 -798 -842 -939 -1,007 -998 -4,867 0 4,148 5,411 6,855 8,221 9,534 34,170
Fuel Savings (BG) -0.808 -2.126 -2.262 -2.496 -2.756 -2.830 -13.277 0.000 2.396 5.153 7.233 9.446 11.433 35.660

Preliminary Standard (MPG) 1.0 1.0 1.0 1.0 1.0 1.0 30.4 33.3 34.2 34.9 36.2 37.8
Final Standard (MPG) 1.0 1.0 1.0 1.0 1.0 1.0 30.4 33.3 34.2 34.9 36.2 37.8

Total Benefits -2,294 -6,178 -6,721 -7,541 -8,453 -8,803 -39,991 0 6,826 15,155 21,626 28,677 35,200 107,483
Net Benefits -2,011 -5,380 -5,879 -6,602 -7,446 -7,806 -35,123 0 2,677 9,745 14,770 20,455 25,665 73,313

Benefit:Cost Ratio 8.09 7.74 7.98 8.03 8.39 8.82 8.22 N/A 1.65 2.80 3.15 3.49 3.69 3.15

2011 2012 2013 2014 2015 2016 2011 2012 2013 2014 2015 2016
MFR-1 -275 -661 -861 -849 -834 -818 0 316 251 307 390 496
MFR-2 0 0 0 0 0 0 0 632 656 799 854 923
MFR-3 -22 -83 -76 -74 -72 -69 0 794 1,043 1,129 1,270 1,358
MFR-4 -188 -171 -166 -161 -157 -152 0 293 505 587 668 964
MFR-5 -286 -456 -445 -489 -476 -464 0 157 196 255 443 855
MFR-6 0 0 0 0 0 0 0 559 591 768 744 838
MFR-7 -97 -215 -205 -203 -198 -191 0 413 472 988 1,385 1,361
MFR-8 -189 -197 -191 -177 -168 -166 0 644 620 1,588 1,875 1,831
MFR-9 0 0 0 0 0 0 0 110 144 177 235 277

MFR-10 -52 -176 -173 -170 -173 -168 0 552 896 1,127 1,302 1,323
MFR-11 -298 -361 -748 -751 -731 -710 0 243 258 370 532 924
MFR-12 -30 -92 -91 -88 -102 -97 0 1,641 1,537 1,533 1,713 1,884
MFR-13 0 0 0 0 0 0 0 119 323 707 723 832
MFR-14 -14 -12 -46 -45 -43 -42 0 242 625 779 794 1,005
MFR-15 0 0 0 0 0 0 0 31 29 41 121 126
MFR-16 0 0 0 0 0 0 0 33 98 205 273 456
MFR-17 -289 -362 -413 -570 -570 -555 0 160 198 564 944 1,252
Average -46 -91 -88 -92 -95 -92 0 505 573 690 799 907

Total Costs ($M) and Benefits

Manufacturer

Average Vehicle Price Increases

Manufacturer

Product Plans (Do-Nothing Standard)

Product Plans (Do-Nothing Standard)

Preferred Alternative

Preferred Alternative
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Appendix B.5 Effects Report 

The summary of effects for each scenario is organized into sections.  The first section, 
shown by example in Table 40, presents calculated levels of fuel consumed (in thousands of 
gallons) during the full useful life of all vehicles sold in each model year.  Calculated sales 
volumes, full useful life travel, and average fuel economy levels are also presented to 
provide a basis for comparison.  However, because the system calculates lifetime travel 
(taking into account the rebound effect) and fuel consumption on a model-by-model basis, 
these additional aggregate calculations are only generally explanatory, and cannot be used 
to calculate lifetime fuel consumption. 

 
Table 40. Effects Report - Energy Consumption (Sample) 

 

The second section presents estimates of full fuel cycle carbon dioxide and criteria pollutant 
emissions, reporting results for the following emissions classes represented in EPA’s 
MOBILE6 emissions model: 

 
Table 41. MOBILE6 Emissions Classes 

Emissions Class Definition 

LDDV Diesel cars 

LDGV gasoline cars 

LDDT1 Diesel trucks with GVW ratings below 6,000 pounds 

LDGT1 gasoline trucks with GVW ratings below 6,000 pounds 

LDDT2 Diesel trucks with GVW ratings between 6,000 and 8,500 pounds 

LDGT2 gasoline trucks with GVW ratings between 6,000 and 8,500 pounds 

HDDV2b Diesel trucks with GVW ratings between 8,500 and 10,000 pounds 

HDGV2b gasoline trucks with GVW ratings between 8,500 and 10,000 pounds 

 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

Gas 66,688,033 -3,545,420 (5%)     73,605,159 -12,798,740 (15%)    
Diesel 1,173,474 1,149,833 4864% 1,396,293 1,365,817 4482% 
Total 67,861,507 -2,395,587 (3%)     75,001,452 -11,432,923 (13%)    
Gas 8,932,706 -186,617 (2%)     10,611,783 -215,409 (2%)     

Diesel 190,030 186,617 5467% 219,955 215,409 4739% 
Total 9,122,736 0 - %      10,831,738 0 - %      
Gas 1,739,313,905 -32,006,200 (2%)     2,183,097,373 -16,188,072 (1%)     

Diesel 39,488,498 38,832,569 5920% 47,881,842 46,967,519 5137% 
Total 1,778,802,403 6,826,369 0%      2,230,979,215 30,779,447 1%      
Gas 32.61 1.05 3%      37.11 5.25 16%     

Diesel 42.03 7.34 21%     42.83 5.33 14%     
Total 32.77 1.20 4%      37.21 5.35 17%     

2016 Total

Energy Consumption

Model Year
2012 Total

Lifetime Fuel Consumption (k gal.)

Sales

Lifetime VMT (k mi.)

Average Fuel Economy (mpg)
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Table 42 shows sample emissions calculations. As indicated, carbon dioxide emissions are 
reported in thousand metric tons of carbon-equivalent emissions (one metric ton of carbon 
dioxide is equivalent to 12/44 of a metric ton of carbon), and all criteria pollutants are 
reported in short tons (one ton equals 2,000 pounds). 

 
Table 42. Effects Summary - Emissions (Sample) 

 
 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

LDGV 620 -21 (3%)     694 -107 (13%)    
LDDV 5 4 1443% 5 5 1362% 

LDGT1 108 -18 (14%)    109 -33 (23%)    
LDDT1 10 10 - %      12 12 - %      
LDGT2 0 0 - %      0 0 - %      
LDDT2 0 0 - %      0 0 - %      

HDGV2b 0 0 - %      0 0 - %      
HDDV2b 0 0 - %      0 0 - %      

Total 742 -25 (3%)     821 -123 (13%)    
LDGV 5,723,676 -25,474 (0%)     7,171,099 38,731 1%      
LDDV 8,140 7,688 1702% 10,028 9,407 1514% 

LDGT1 1,566,259 -169,580 (10%)    1,692,146 -178,229 (10%)    
LDDT1 3,686 3,686 - %      4,313 4,313 - %      
LDGT2 0 0 - %      0 0 - %      
LDDT2 0 0 - %      0 0 - %      

HDGV2b 0 0 - %      0 0 - %      
HDDV2b 0 0 - %      0 0 - %      

Total 7,301,761 -183,679 (2%)     8,877,586 -125,778 (1%)     
LDGV 472,280 -11,483 (2%)     546,792 -54,234 (9%)     
LDDV 785 740 1651% 962 902 1486% 

LDGT1 95,668 -13,529 (12%)    98,553 -21,496 (18%)    
LDDT1 2,484 2,484 - %      2,935 2,935 - %      
LDGT2 0 0 - %      0 0 - %      
LDDT2 0 0 - %      0 0 - %      

HDGV2b 0 0 - %      0 0 - %      
HDDV2b 0 0 - %      0 0 - %      

Total 571,217 -21,787 (4%)     649,242 -71,893 (10%)    
LDGV 298,371 -4,112 (1%)     360,238 -15,027 (4%)     
LDDV 1,005 943 1531% 1,234 1,153 1416% 

LDGT1 109,483 -12,787 (10%)    119,236 -15,830 (12%)    
LDDT1 5,193 5,193 - %      6,180 6,180 - %      
LDGT2 0 0 - %      0 0 - %      
LDDT2 0 0 - %      0 0 - %      

HDGV2b 0 0 - %      0 0 - %      
HDDV2b 0 0 - %      0 0 - %      

Total 414,051 -10,764 (3%)     486,888 -23,524 (5%)     
LDGV 26,082 -497 (2%)     30,270 -2,162 (7%)     
LDDV 292 275 1623% 362 339 1470% 

LDGT1 5,901 -768 (12%)    6,048 -1,089 (15%)    
LDDT1 461 461 - %      548 548 - %      
LDGT2 0 0 - %      0 0 - %      
LDDT2 0 0 - %      0 0 - %      

HDGV2b 0 0 - %      0 0 - %      
HDDV2b 0 0 - %      0 0 - %      

Total 32,735 -530 (2%)     37,227 -2,365 (6%)     
LDGV 69,519 -2,342 (3%)     77,873 -11,970 (13%)    
LDDV 433 405 1443% 529 492 1362% 

LDGT1 12,104 -1,997 (14%)    12,216 -3,695 (23%)    
LDDT1 959 959 - %      1,128 1,128 - %      
LDGT2 0 0 - %      0 0 - %      
LDDT2 0 0 - %      0 0 - %      

HDGV2b 0 0 - %      0 0 - %      
HDDV2b 0 0 - %      0 0 - %      

Total 83,015 -2,975 (3%)     91,746 -14,045 (13%)    

2016 Total
Model Year

2012 Total

Emissions

CO2 (mmT)

CO (tons)

VOC (tons)

NOX (tons)

PM (tons)

SOX (tons)
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The third and fourth sections of the effects summary presents monetized private and social 
costs and benefits of each scenario.  These effects, discussed in detail in Section III.C.6 of 
the primary text, include the following: 

• Pretax Fuel Expenditures:  Savings in pretax cost to vehicle users of vehicle fuel. 

• Fuel Tax Revenues:  Reduction in total (federal and state) fuel tax revenues. 

• Travel Value:  The value derived from additional driving due to the "rebound effect". 

• Refueling Time Value:  Savings in the value of vehicle occupants’ time during refueling. 

• Petroleum Market Externalities:  Reduction in costs of economic externalities resulting from 
crude petroleum imports. 

• Congestion Costs:  The additional cost of highway congestion from added driving due to the 
"rebound effect". 

• Accident Costs:  Additional injury and damage costs of highway crashes. 

• Emissions Damage Costs:  The change in damage costs from air pollutant emissions (by species). 

In all cases, these costs and benefits are calculated for the fleet of vehicles sold in each 
model year over their full useful lives, discounted using the rate specified in the benefits 
model parameters file, and reported in thousands of constant year-2003 dollars.  Section 
III.C.6 of the primary text discusses these types of costs and benefits in greater detail, and 
Appendix A (Model Inputs) discusses corresponding input assumptions. 

Appendix B.5.1 Optimized Industry Report 

The Optimized Industry Report can be generated for optimization runs by the Model. The report 
shows the parameters used for the target CAFE stringencies for the modeling years, as shown in 
Table 44 as well as graphing the net benefits curve for the stringencies examined for the 
optimization modeling, as shown in Error! Reference source not found.. 
Optimization modeling is discussed in Appendix C below. 
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Table 43. Effects Report - Private and Social Costs and Benefits (Sample) 

 
 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

Current
Scenario

Delta
(abs.)

 Delta
(%) 

188,730,869 -6,572,810 (3%)     224,043,957 -33,971,499 (13%)    
25,949,107 -883,559 (3%)     27,977,660 -4,230,855 (13%)    

-491,142 -491,142 - %      -2,448,833 -2,448,833 - %      
-546,227 -546,227 - %      -2,373,575 -2,373,575 - %      

10,901,612 -384,839 (3%)     12,048,608 -1,836,642 (13%)    
94,470,900 356,250 0%      118,669,386 1,631,631 1%      
1,778,802 6,826 0%      2,230,979 30,779 1%      

41,704,670 163,193 0%      52,214,268 723,157 1%      
19,365,738 -643,342 (3%)     23,275,884 -3,487,441 (13%)    

0 0 - %      0 0 - %      
907,093 -34,598 (4%)     1,030,996 -114,166 (10%)    

2,638,335 -68,586 (3%)     3,102,451 -149,892 (5%)     
9,535,460 -154,346 (2%)     10,843,888 -688,866 (6%)     
3,122,609 -111,920 (3%)     3,451,009 -528,296 (13%)    

153,135,109 -5,290,393 (3%)     182,660,550 -27,654,900 (13%)    
21,475,935 -725,373 (3%)     23,167,441 -3,498,016 (13%)    

-395,984 -395,984 - %      -1,996,859 -1,996,859 - %      
-451,717 -451,717 - %      -1,971,929 -1,971,929 - %      

8,978,167 -314,565 (3%)     9,927,540 -1,511,175 (13%)    
77,876,272 291,974 0%      97,873,633 1,344,201 1%      
1,465,498 5,589 0%      1,839,047 25,341 1%      

34,336,766 133,475 0%      43,015,543 594,969 1%      
15,666,654 -515,904 (3%)     18,846,077 -2,819,827 (13%)    

0 0 - %      0 0 - %      
724,635 -27,540 (4%)     825,146 -93,344 (10%)    

2,070,163 -52,294 (2%)     2,442,849 -120,173 (5%)     
7,584,574 -116,827 (2%)     8,695,017 -561,383 (6%)     
2,571,696 -91,464 (3%)     2,843,520 -434,645 (13%)    

2016 Total
Model Year

2012 Total

Fuel Tax Revenues

Fuel Tax Revenues

Travel Value

Undiscounted Owner and Societal Costs (k $)

Discounted Owner and Societal Costs (k $)

Total Lifetime Pretax Fuel Expenditures

Refueling Time Value

Refueling Time Value

Petroleum Market Externalities

Total Lifetime Pretax Fuel Expenditures

Congestion Costs

Congestion Costs

Noise Costs

Travel Value

Accident Costs

Accident Costs

CO2

Petroleum Market Externalities

CO

CO

VOC

Noise Costs

NOX

NOX

PM

CO2

PM

SOX

SOX

VOC
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Appendix B.6 Optimized Industry Report 

Appendix C (below) discusses use of the model to estimate the “optimal” stringency of CAFE 
standards.  This operating mode involves incrementally increasing the stringency of the 
standards over a range, estimating corresponding costs, fuel savings, CO2 emission reductions, 
and benefits at each iteration.  Table 44 shows a sample of industry-level reporting.  Average 
required CAFE levels for each iteration are shown in the “Standards” section, with resultant 
average achieved fuel economy levels shown under “CAFE”, and resultant incremental costs 
(relative to the baseline standards) shown under “Tech Costs”.  Estimated optimal stringencies 
(e.g., for MY2012, index number 75, producing an average required CAFE of 26.3 mpg) are 
shown in the “Optimized” section. 
 

Table 44. Optimized Industry Report - Data (Sample) 

 
 
 
The optimized industry report also produces graphs of numerous measures (e.g., incremental 
costs, incremental benefits) versus stringency.  Figure 10 (below) shows a sample graph in which 
net benefits (relative to baseline standards) are plotted versus average required CAFE levels for 
each model year during MY2012-2016. 

Optimized A B C D Stnd Index
2011 27.1 21.1 56.4 4.3
2012 31.1 23.0 0.0 0.0 26.3 75
2013 33.0 24.0 0.0 0.0 27.7 73
2014 34.9 25.0 0.0 0.0 29.1 73
2015 36.7 25.9 0.0 0.0 30.3 75
2016 37.9 26.5 0.0 0.0 31.1 76

Standards 0 1 2 3 4 5 6
2011
2012 22.0 22.0 22.1 22.1 22.2 22.2 22.3
2013 23.0 23.1 23.1 23.2 23.2 23.3 23.3
2014 24.0 24.0 24.1 24.1 24.2 24.3 24.3
2015 24.7 24.7 24.8 24.9 24.9 25.0 25.1
2016 25.2 25.2 25.3 25.4 25.4 25.5 25.6

CAFE
2011
2012 24.1 24.1 24.1 24.1 24.1 24.1 24.1
2013 26.4 26.4 26.4 26.4 26.4 26.4 26.4
2014 27.8 27.8 27.8 27.8 27.8 27.8 27.8
2015 29.1 29.1 29.1 29.1 29.1 29.1 29.1
2016 30.3 30.3 30.3 30.3 30.3 30.3 30.3

Tech Costs
2011
2012 -90.9 -90.9 -90.9 -90.9 -90.9 -90.9 -90.9
2013 3,346.0 3,346.0 3,346.0 3,346.0 3,346.0 3,346.0 3,346.0
2014 5,518.1 5,518.1 5,518.1 5,518.1 5,518.1 5,518.1 5,518.1
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Figure 10. Optimized Industry Report - Net Benefits Graph (Sample) 
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Appendix C “Optimization” of CAFE Standards 

The modeling system contains algorithms that may be used to “optimize” the average 
stringency (that is, the average required fuel economy) of an attribute-based system by 
estimating the stringency at which a given condition is met.  “Optimizing” the stringency, 
in the current modeling system, is done either by estimating the stringency level at which 
net societal benefits are maximized (maximum net benefits), or by finding the level where 
the absolute value of net benefits is minimized, after the maximum has occurred (total cost 
equals total benefits).23

Appendix E below
  Optimization of CAFE Standards may be set up and run using 

directions provided in the shown in . 

Using the functional form defined in the scenarios file, the optimized stringency for either 
the passenger car or light truck fleet is determined for the entire industry, and for each 
year, by adjusting the function’s upper and lower limits at a user-specified increment, for a 
given number of iterations above and below the initial shape.24

With the varying asymptotes, the system examines new iterations (or trials), performing 
typical compliance modeling, holding the function’s shape constant while altering the 
stringency.  At the end of each iteration, the model calculates and saves the final technology 
costs, fines owed, benefits, fuel savings, and benefit-cost ratios for each manufacturer and 
industry overall.  Once all iterations have been processed, the modeling system calculates 
the stringency by finding the first iteration that satisfies the net-benefit-maximizing or 
absolute-value-of-net-benefit-minimizing criterion. 

  To ensure the correct 
“carry-over” of technology costs and improvements, the model years are optimized 
sequentially.  At the end of each model year, the system re-runs the entire passenger car or 
light truck fleet using the optimized stringency, then carries the costs and improvements 
into the next year. 

Below, Figure 11 illustrates how the model maximizes net benefits.  The plot on the left 
shows curves specifying fuel economy targets for three iterations (i.e., stringency levels) 
examined under a sample optimization.  For each of these iterations, colored points in the 
plot on the right show the corresponding stringency (in terms of average required fuel 
economy) and the calculated net benefits (in $m).  The black line in the plot on the right 
shows stringency and net benefits for all other iterations included in the optimization.  In 
this example, the least stringent of the three highlighted iterations, shown in red, produces 
net benefits of about $2,700m at a stringency of 31.2 mpg.  As stringency increases, net 
benefits reach a peak or maximum, shown in green, of about $3,100m at a stringency of 
31.7 mpg.  The corresponding curve is shown in green in the plot on the left.  As stringency 
increases beyond this point, more expensive technologies are required, such that net 

                                                 
23 Use of the term “optimize” was first applied in this model in reference to the concept of estimating the “socially 
optimal” stringency—that is, the stringency producing the greatest increase in benefits relative to the increase in 
costs, where both benefits and costs are measured on a societal basis, excluding economic transfers such as fuel 
taxes and civil penalties.  This approach involves maximizing net benefits.  Considering public comments, NHTSA 
also required the availability to examine stringencies at which total costs equal total benefits (or, within the scope of 
available technologies, most nearly equal).  As currently used, the term “optimize” refers to either approach. 
24 The model currently optimizes stringency for only one fleet (i.e., passenger car or light truck) in a single model 
run.   
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benefits decrease.  By the point stringency reaches 31.2 mpg, shown in blue, net benefits 
fall to about $2,800m.  

Figure 11. Maximizing Net Benefits 

            
 

This example also illustrates a scenario in which net benefits stop decreasing before total 
costs equal total benefits (when total costs equal total benefits, net benefits equal zero).  In 
this example, all available technologies are exhausted when stringency reaches 32.5 mpg, 
at which point net benefits are about $500m. Once technologies are exhausted, no 
additional cost or benefits will be realized – the manufacturer’s fleet will remain static. 
Above this stringency, civil penalties are incurred.  However, as economic transfers, civil 
penalties are not counted as costs to society.  Therefore, net benefits do not change as 
stringency increases beyond 32.5 mpg. 

The last step of the modeling process is to use the optimized standard (i.e., the standard 
defined by the user-specified shape and then shifted vertically by the model to produce the 
optimized stringency) to obtain the corresponding fleet (i.e., the fleet that reflects estimated 
manufacturer responses at the optimized stringency) for the model year.  As under 
standard (i.e., non-optimizing) modeling exercises, this step is necessary to properly carry 
over added technologies from one model year to the next. 

As originally designed, the model only performed optimization by accounting for each 
manufacturer separately, and then using the industry-wide sum of manufacturer-specific 
results to estimate optimal stringency.  In the current version, the model also provides an 
optional setting to merge the fleet (i.e., combine the vehicles of all individual manufacturers 
into a single group) throughout the optimization process.  As explained below, under some 
circumstances, this option can provide more stable optima than when accounting for each 
manufacturer separately.  The effect of this setting is illustrated below for a hypothetical 
fleet involving two manufacturers:  “OEM1,” a “laggard” which produces a fleet of vehicles 
with generally low baseline fuel economy relative to fuel economy targets; and “OEM2,” a 
“front runner” which produces a fleet of vehicles with generally high baseline fuel economy 
relative to fuel economy targets. Typically, a manufacturer with a “laggard” fleet will 
experience application of technologies to its fleet at a lower stringency than that of a 
manufacturer with a more fuel efficient fleet. This will result in a different shape net 
benefits curve, as well as a different placement of the peak of maximum net benefits. 
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Below, Figure 12 shows net benefits (attributable separately to OEM1 and OEM2) on the y 
axis, with stringency (in terms of the average required fuel economy) on the x axis.  As 
stringency increases (moving from left to right on the chart), OEM1, shown in orange, 
begins to be impacted by new standards when the average stringency (i.e., the average fuel 
economy required of the industry) reaches 29.0 mpg.25

Figure 12. Net Benefits versus Stringency for Hypothetical 2-Manufacturer Fleet 

  For OEM1, net benefits increase as 
stringency increases past 29.0 mpg, peak when stringency reaches 31.9 mpg, decline as 
stringency continues to increase, and stabilize when stringency increases beyond past 32.8 
mpg, at which point OEM1 exhausts all available technology applications.  For OEM2, 
shown in blue, net benefits do not begin to increase until stringency increases past 34.3 
mpg.  Subsequently, net benefits attributable to OEM2 peak when stringency reaches 40.1 
mpg, decline as stringency continues to increase, and stabilize when stringency increases 
beyond past 41.2 mpg, at which point OEM2 exhausts all available technology applications. 

 

Figure 13 shows the corresponding total net benefits for the industry (i.e., the sum of net 
benefits attributable to both OEM1 and OEM2) as a dashed line superimposed on the net 
benefits attributable separately to OEM1 and OEM2.  In this example, the significant 
difference between OEM1 and OEM2 in terms of baseline performance as compared to 
targets causes the total net benefits for the industry to exhibit two distinct peaks, one at 
32.8 mpg and one at 40.1 mpg.  Below 34.3 mpg, OEM2 is unaffected, such that results for 

                                                 
25 At stringencies of about 29.0-30.2 mpg, net benefits attributable to OEM1 are negative.  This indicates the market 
forecast for OEM1 fell short of the baseline standards, and that for OEM1, standards of 29.0-30.2 mpg (again, in 
terms of average fuel economy required of the industry) would require technology beyond that required under the 
market forecast for OEM1, but not as much as would be required under the baseline standards. 
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OEM1 account for all of the net benefits for the industry.  Above 34.3 mpg, the net benefits 
attributable to OEM2 are augmented by approximately $500m in net benefits attributable 
to OEM1 once OEM1 has exhausted available technologies (at 32.8 mpg).26

 

  In this 
example, relative sales volumes are such that the “OEM2 peak” at 40.1 mpg is dominant.  
However, if OEM1’s market share had been somewhat greater than in this example, the 
“OEM1” peak at 32.8 mpg would have been dominant. 

Figure 13. Sum of Net Benefits Attributable to OEM1 and OEM2 

 

For the same hypothetical fleet, Figure 14 demonstrates the effect of selecting the “Merge 
the fleet before optimizing” setting when running the model.  With distinctions between 
OEM1 and OEM2 removed, the baseline average fuel economy of the merged fleet exceed 
are 30.2 mpg and technologies are not required until average stringency reaches 30.3 mpg. 
This higher average fuel economy is because the relatively high performance of OEM2’s 
fleet balances the relatively low performance of OEM1’s fleet.  Net benefits subsequently 
increase, peak at 33.8 mpg, and then decline (except for a slight secondary peak at 34.2 
mpg) until all technology options are exhausted when stringency reaches 34.4 mpg. 

 

                                                 
26 If a manufacturer exhausts available technologies without achieving compliance with a given standard, the model 
calculates the resultant civil penalties.  However, because civil penalties are economic transfers, the model does not 
add these to estimated costs; therefore, the plot of net benefits attributed to an individual manufacturer becomes flat 
at stringencies beyond the point where the manufacturer exhausts available technology options. 
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Figure 14. Net Benefits for Hypothetical Merged Fleet 

 

Figure 15 compares the net benefits obtained with the merged fleet to those obtained for 
the underlying individual manufacturers, and for the industry as represented maintaining 
the distinction between the two manufacturers.  Without merging the fleet, the model 
obtains a net benefits plot that has two widely separated peaks.  Because the relative 
heights of these peaks could be impacted differently by relatively modest changes in model 
inputs (including manufacturers’ market shares and sometimes other inputs), these widely 
separated peaks lead to unstable (albeit correctly calculated) results.  For example, 
relatively modest changes in model inputs such as manufacturer sales volumes or economic 
factors (e.g., discount rate, rebound effect, fuel price) can change which peak is dominant, 
thereby causing a significant change in estimated optimized stringency.  The merged fleet 
produces a much more stable peak that falls between the two peaks obtained without 
applying this option. 
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Figure 15. Comparison of Net Benefits with and without Merging of Fleet 
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Appendix D Monte Carlo Analysis 

Uncertainty analysis (e.g., Monte-Carlo simulation) may be performed, such that all 
included scenarios are examined under varying discount rates, technology costs and fuel 
consumption effects, pretax fuel prices, rebound effect, and fuel-related externalities 
(monopsony, price shock, military security, and carbon dioxide costs).  Monte-Carlo analysis 
may be set up and run using directions provided in the CAFE Model Software Manual 
document. 

The results of the analysis are located in the output folder selected during modeling.  
Unlike other model runs, Monte-Carlo simulation does not produce formatted Excel reports.  
Instead, plain text Monte-Carlo log files can be found under the "MC-logs" subdirectory.  As 
with regular modeling runs, however, the per-scenario logs are numbered in order of 
appearance, starting at 0, with the first scenario (0) being the baseline to which all others 
are compared.  The following files are generated at the end of the Monte-Carlo simulation: 

• MC_trials.csv:  Contains pseudo-randomly generated Monte-Carlo trials used as input to the 
analysis.  The contents of the file are summarized in Table 45. 

• MC_tech_costs.csv:  Specifies the sales-weighted average technology costs for each technology, 
adjusted by the randomized cost scales from the MC_trials.csv file. The average costs for a 
technology are computed across all vehicle technology classes that were used during modeling as 
follows:  
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where SALESi represent the sales of vehicle i, COSTi,t is the base (unadjusted) cost of technology t 
as it applies to vehicle i, and SCALEt is the randomized value specifying the amount by which to 
scale the technology cost of technology t. 

• MC_tech_fcs.csv:  Specifies the sales-weighted average technology fuel consumption 
improvements for each technology, adjusted by the randomized fuel consumption scales from the 
MC_trials.csv file. The average fuel consumption improvements for a technology are computed 
across all vehicle technology classes that were used during modeling as follows:  
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where SALESi represent the sales of vehicle i, FCi,t is the base (unadjusted) fuel consumption 
improvement of technology t as it applies to vehicle i, and SCALEt is the randomized value 
specifying the amount by which to scale the technology fuel consumption improvement of 
technology t. 

• MC_Sn*_data.csv:  Includes the results of pseudo-randomly generated Monte-Carlo trials for all 
scenarios.  The log file for the results of the baseline scenario (0) provides the totals accrued 
during that scenario.  The log files for the results of non-baseline scenarios (Sn1, Sn2, …) contain 
changes compared to the baseline.  The contents of the file are summarized in Table 46. 
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Table 45. MC_Trials.csv Contents 

 
 

Table 46. MC_Sn*_data.csv Contents 

 
 
 

 
 

  

Column Contents
Index Unique index of the trial.

FuelPriceEstimates Randomized pretax fuel prices; the probabilities are: 50% for 
average fuel prices and 25% for and high prices.

DiscountRate Value of the discount rate examined with each trial.
ReboundEffect Randomized value of the rebound effect.

CO2Estimates
Randomized carbon diaxide cost estimates; the probabilites are: 
50% for average cost estimates, 25% for low, 20% for high, and 5% 
for very high.

MonopsonyCost Randomized value of the monopsony cost.
PriceShockCost Randomized value of the price shock cost.
MilitarySecurityCost Randomized value of the military security cost.

Cost(Technology) Randomized value specifying the amount by which to scale the 
technology costs for each technology.

FC(Technology) Randomized value specifying the amount by which to scale the 
technology fuel consumption improvement for each technology.

Column Contents
Index Unique index of the trial.
DiscountRate Value of the discount rate examined with each trial.

AvePrice_MFR*(MY) Average regulatory costs accumulated by the manufacturers for 
each model year.

TechCost_MFR*(MY) Total technology costs accumulated by the manufacturers for 
each model year.

TechCost(MY) Total technology costs accumulated by the entire industry for 
each model year.

SocialBenefits(MY) Discounted social benefits accumulated by the entire industry for 
each model year.

FuelSavings(MY) Fuel savings accumulated by the entire industry for each model 
year.

BCRatio(MY) Ratio of social benefits to total technology costs for each model 
year.
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Appendix E CAFE Model Software Manual 

 

Appendix E.1 Warnings 

This software was developed for analysis by U.S. Department of Transportation staff of 
potential fuel economy requirements. 

This software uses input files containing detailed information regarding vehicles 
manufactured for sale in the United States and creates output files containing similarly 
detailed information regarding such vehicles.  If input files containing information in any 
way (e.g., based on entitlement under 5 U.S.C 552 to confidential treatment) protected from 
disclosure to the public are used, some output files created by this software must also be 
protected from disclosure to the public. 

Appendix E.2 Notice 

Some of the icons and/or images used by the CAFE Compliance and Effects Modeling 
System may have been obtained from www.kde-look.org and are the sole property of their 
respective owners. 

To the best of our knowledge, all images are distributed under the GNU GPL or the GNU 
LGPL licenses.  If any of the icons violate the original author's copyright or terms of use, 
please contact the current administrators of the CAFE Model project. 

Appendix E.3 Installation and System Requirements 

The CAFE Compliance and Effects Modeling System (abbreviated: CAFE Model) runs on 
IBM-compatible computers using the Microsoft® Windows operating system.  Although the 
software does not have strict hardware requirements, beyond what is needed to run the 
operating system, a 1 GHz or faster Intel compatible processor, with at least 1 GB of 
physical RAM is strongly recommended.  The software has been developed and tested on 
computers using Windows XP and Windows Server 2003, but may operate properly on 
machines using older versions of Windows (e.g., Windows 2000), or newer versions (e.g., 
Windows Vista/7), as long as a compatible Microsoft® .NET Framework is installed. 

Because the software makes extensive use of Microsoft® Excel files for input and output, 
Excel must be installed on the system.  To provide a means of protecting confidential 
business information (CBI) contained in input and output files (if the user is relying on 
CBI), the software makes use of encryption algorithms available in Excel 2003.  These 
algorithms are not available in older versions of Excel.  Unencrypted files, however, may be 
used with such versions. 

The software uses the Microsoft® .NET Framework, version 1.1.  If the Framework is not 
already present, it must be installed.  Instructions for downloading and installing the .NET 
framework are available on the Internet at 
http://msdn.microsoft.com/netframework/downloads/framework1_1/. 
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The software also uses the Microsoft® Visual J# .NET Redistributable Package 1.1, which 
can be obtained on the Internet at http://msdn.microsoft.com/en-us/vjsharp/bb188598.aspx. 

Based on the characteristics of machines used in the development of this software, the 
following table provides a summary of system requirements: 

 
Table 47.  CAFE Model System Requirements 

Intel compatible processor (1 GHz or faster recommended) 
512 MB RAM (1 GB recommended) 
10 MB hard drive space for installation 
(additional disk space will be required during runtime) 
Microsoft® Windows XP 
Microsoft® Windows Server 2003 
Microsoft® Windows Server 2008 
Microsoft® .NET Framework 1.1 
Microsoft® Visual J# 1.1 Redistributable 
Microsoft® Office 2003 or later. 

Once the system requirements have been met, the latest version of the CAFE Model may be 
obtained by contacting NHTSA or Volpe Center staff.  Prior to installation, make sure that 
all previous version of the model are removed from the computer as described in the 
Appendix E.4, Removing/Repairing a CAFE Model Installation section below. 

To install the software, place the setup files on the desktop and execute Setup.Exe27

The installer places a shortcut for the modeling system on the desktop as well as creates a 
Start Menu entry under Start > Programs > CAFE Model. 

.  
Follow the on-screen instructions provided by the wizard.  After installation completes, the 
setup files may be deleted from the computer. 

Appendix E.4 Removing/Repairing a CAFE Model Installation 

The CAFE Model installation may be removed or repaired at any time by going to Start > 
Programs > CAFE Model > Uninstall CAFE Model.  To remove the modeling system 
completely, select the "Remove CAFE Model" option in the dialog box that appears.  If the 
application is misbehaving, the "Repair CAFE Model" option may be selected instead.  Click 
Finish and wait for the remove/repair process to complete. 

Appendix E.5 CAFE Model Graphical User Interface 

The CAFE Model Graphical User Interface (GUI) provides users with a set of tools 
necessary to set up and run multiple modeling test scenarios, which are commonly referred 
to as CAFE Model sessions.  Each CAFE Model session can be configured independently, 
each with its own set of model inputs and settings.  Once configured, the session may be 

                                                 
27 The setup files provided may be in a zip archive, which will need to be extracted using a zip utility such as 
WinZip (www.winzip.com) or 7Zip (www.7-zip.org). 
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saved for future runs, or executed immediately.28

The model GUI consists of two primary screens:  the main CAFE Model window and the 
Modeling Settings window.  The CAFE Model window is used for managing the modeling 
sessions, while the Modeling Settings window is used to configure them.   

  When the model runs, the system 
displays the progress of the compliance modeling process in each session's window. 

To run the modeling system, click on the CAFE Model shortcut located on the desktop, or go 
to Start > Programs > CAFE Model > CAFE Model.  When the application launches, a 
Warnings dialog box is displayed (Figure 16).  The user must read and understand the 
warnings listed prior to using the modeling system. 

 

 
Figure 16. Warnings Dialog Box 

After clicking the OK button in the Warnings dialog box, the main CAFE Model window, 
described below, opens. 

 

Appendix E.6 CAFE Model Window 

The main CAFE Model window (Figure 17) is used to create, configure, and manage CAFE 
modeling sessions.  The main window also controls the model operation, allowing users to 
start and stop modeling simulation, as well as to generate modeling reports. 
                                                 
28 It is recommended that users save the sessions prior to running them in order to assign a meaningful title to each 
session. 
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Figure 17. CAFE Model Window 

When the model first starts up, most of the menu items and toolbar icons are disabled, until 
a new session is created, or an existing one is opened. 

The model GUI is operated using a simple, easy to use file-menu (Figure 18), with most 
commonly used shortcuts also available on the model toolbar (Figure 19).  For user 
convenience, most of the menu entries may also be controlled using keyboard shortcuts. 

 

 
Figure 18. CAFE Model File Menu 
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Figure 19. CAFE Model Toolbar 

 
Some of the most commonly used file menus are: 

• File > New Session:  Creates a new CAFE Model Session and displays the Modeling Settings 
window to the user. 

• File > Open Session:  Opens an existing CAFE Model Session. 

• File > Close Session:  Closes the active CAFE Model Session. 

• File > Save Session:  Saves the active CAFE Model Session. 

• File > Start Modeling:  Begins the modeling process for the active CAFE Model Session. 

• File > Stop Modeling:  Suspends the modeling process of the active CAFE Model Session. 

• File > Exit:  Exits the CAFE Model.  If any of the modeling sessions are still opened, they will be 
closed prior to exiting the model. 

• View > Modeling Settings:  Displays the Modeling Settings window, where all modeling options 
and settings can be configured. 

• View > Output Location:  Opens the Windows Explorer and browses to the location where the 
output files and reports of the active session are saved. 

Appendix E.6.1 Modeling Settings Window 

The Modeling Settings window contains multiple panels for configuring all of the runtime 
options available to the model.  The user can use this window to set up a new session, or 
modifying an existing one, before starting the modeling process.  Each of the available 
configuration panels is outlined in the sections below. 

1. General Compliance Settings Panel 

The General Compliance Settings panel (Figure 20) is used to specify what type of modeling 
the user would like to run.  Each model is tailored to different type of analysis, using its 
own set of assumptions and configuration settings.  Presently, four model types are 
available: 

• Standard Compliance Model:  The Standard Compliance Model is the default mode of operation 
for the CAFE modeling system.  This model type is used to evaluate technology costs and 
benefits in response to the required CAFE standards defined in the modeling scenarios. 

• Maximum Technology Compliance Model:  This model type is similar to the Standard 
Compliance Model, except additional modeling constraints are enabled.  When this model type is 
used, the modeling system is configured to ignore year availability of technologies, technology 
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phase-in caps, and vehicle refresh and redesign years.  Furthermore, each manufacturer is 
assumed to be unwilling to pay CAFE fines. 

• Optimization Model:  This model type should be used to perform sensitivity analysis and 
optimize the shape of the required CAFE standard. 

• Monte-Carlo Model:  The Monte-Carlo Model is a specialized CAFE modeling type, which is 
used for running customized Monte-Carlo simulations necessary for uncertainty analysis. 

 

 
Figure 20. General Compliance Settings Panel 

 
2. Input Settings Panel 

On the Input Settings panel (Figure 21), the user can select the input data files for use with 
the modeling system.  To protect Confidential Business Information (CBI), some of the 
input files may be password protected.  The CAFE Model, therefore, provides an option for 
users to enter an input password prior to loading such files. 
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Figure 21. Input Settings Panel (1) 

When selecting input files, the model will attempt to verify that an appropriate file was 
selected.  If incorrect file path is entered, an error message will be displayed (Figure 22). 
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Figure 22. Input Settings Panel (2) 

 
3. Output Settings Panel 

The Output Settings panel (Figure 23) is used to configure the location where modeling 
results will be saved and which modeling reports the CAFE Model should generate.  If 
input data contained CBI, it may be necessary to protect outputs produced by the model.  
The system provides the ability to password protect the Excel reports that the model 
generates, however, the modeling logs are not encrypted. 
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Figure 23. Output Settings Panel (1) 

When password protecting the Excel reports, "strong encryption" option may be used for 
improved security (Figure 24). 
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Figure 24. Output Settings Panel (2) 

The modeling system is configured to generate seven different reports (Figure 25)29

• Industry Report:  Provides industry-wide and manufacturer-level summary of compliance model 
results.  The results are grouped by manufacturer (or entire industry), with each worksheet tab 
showing a summary view for all model years. 

: 

• Manufacturers Report:  Provides industry-wide and manufacturer-level summary of compliance 
model results.  The results are grouped by model year, with each worksheet tab showing results 
from all manufacturers, and the combined industry values. 

• Vehicles Report:  Presents disaggregate vehicle-level summary of compliance model results. 

• Scenario Summary Report:  Displays an overview of industry-wide and manufacturer-level 
compliance and effects results, compared versus the baseline across all scenarios. 

• Effects Report:  Provides summary of energy and emissions effects. 

• Environmental Assessment Report:  Presents summary of fuel consumption and emissions 
effects, disaggregated by calendar and model year. 

• Optimized Industry Report:  Provides industry-wide and manufacturer-level technology costs, 
fines, and benefits, as well as carbon dioxide and fuel savings, and benefit-cost ratios, for all 
iterations from industry optimization.  This report also graphs the socially optimized functional 
form (aka, optimized shape) for the entire industry by model year, and displays benefit-cost, 

                                                 
29 Note:  The Monte-Carlo Model does not support any of the modeling reports provided on the Output Settings 
panel.  Selecting any of the reports during Monte-Carlo modeling will have no effect. 
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marginal benefit:cost, net benefits, and optimized shape charts. 
Note:  The Optimized Industry report can only be generated when running the Optimization 
Model. 

 

 
Figure 25. Output Settings Panel (3) 

 
4. Parameters Overrides Panel 

Some of the options loaded from a parameters input file may be overridden using the 
Parameters Overrides panel (Figure 26).30

Figure 26

  If an "override" option is checked off (not 
selected), a default value from the input file is used.  If an override option is checked on 
(selected), that value will be used in place of what was loaded from the parameters file.  In 

 below, the options for overriding the rebound effect and the discount rate are 
selected, and set to 20% and 7% respectively. 

The following are available parameters overrides options: 
• Override Fuel Price Estimates:  Specifies whether to use the low, average, or high fuel price 

estimates from the parameters input file.  By default, average fuel price estimates are used. 

• Override CO2 Estimates:  Specifies whether to use low, average, high, or very-high carbon 
dioxide cost estimates from the parameters input file.  By default, average CO2 cost estimates are 
used. 

                                                 
30 The Parameters Overrides cannot be used if the Monte-Carlo Model is selected. 
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• Override Rebound Effect:  Overrides the Rebound Effect value read in from the parameters file 
with a user defined value.  Valid values are between -1.00 and 1.00. 

• Override Discount Rate:  Overrides the Discount Rate value read in from the parameters file with 
a user defined value.  Valid values are between 0.00 and 1.00. 

• Override Value of Travel Time per Vehicle:  Overrides the Value of Travel Time per Vehicle 
value read in from the parameters file with a user defined value. 

• Override Military Security Cost:  Overrides the Military Security component of economic costs 
read in from the parameters file with a user defined value. 

• Scale Consumer Benefits During Effects Calculations:  Specifies whether the model should 
scale the private consumer benefits by a specific percentage during the effects calculations.  Valid 
values are between 0.00 and 1.00. 

 

 
Figure 26. Parameters Overrides Panel 

 
5. EIS Model Settings Panel 

The CAFE Model includes the ability to perform supplemental analysis necessary for the 
Environmental Impact Statement (EIS).  The system can be configured for EIS modeling 
using the EIS Model Settings panel (Figure 27).31

                                                 
31 EIS modeling cannot be run when the Optimization Model or the Monte-Carlo Model is selected. 

  There, the EIS Model is enabled by 
selecting the "Run the EIS Model" option, and choosing the appropriate input files required 
for EIS analysis. 
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Figure 27. EIS Model Settings Panel 

  
6. Optimization Model Settings Panel 

When an Optimization Model type is selected, the Optimization Model Settings panel 
(Figure 28) becomes available.  This panel provides additional options necessary for 
configuring the system for optimization modeling. 

The first set of options determines the type of optimization – that is, which fleet the model 
should optimize: 

• Cars:  Forces the modeling system to optimize vehicles regulated as passenger automobiles only.  
If the market data input file contains any vehicles regulated as light trucks, the value of CAFE 
standard for those vehicles will be kept at a constant value throughout optimization. 

• Trucks:  Forces the modeling system to optimize vehicles regulated as light trucks only.  If the 
market data input file contains any vehicles regulated as passenger automobiles, the value of 
CAFE standard for those vehicles will be kept at a constant value throughout optimization. 

• Auto-detect:  Allows the model to automatically determine whether to optimize passenger 
automobiles or light trucks.  This option is useful if the market data input file contains only one 
class of vehicles (e.g., cars-only or trucks-only).  If the market data file includes a mixed fleet of 
vehicles (passenger autos and light trucks), this option should not be used. 

The next set of options determines the optimization mode the model should use when 
identifying the optimum value of the CAFE standard: 
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• Optimize based on maximum Net Benefits:  Specifies that the optimization model should 

optimize the value of CAFE standard based on the difference between the discounted social 
benefits and technology costs, by maximizing that difference. 

• Optimized by minimizing Net Benefits, after the maximum has occurred:  Specifies that the 
optimization model should optimize the value of CAFE standard based on the difference between 
the discounted social benefits and technology costs, by finding the lowest positive difference after 
the maximum difference has occurred. 

Additional optimization options are: 

• Iterations above optimum:  Indicates the number of iterations to examine above the initially 
calibrated shape of the target function, by moving the asymptotes upward in GPM space.  
Increasing the asymptotes produces a less stringent value of CAFE standard.  Valid values are 
between 0 and 1000. 

• Iterations below optimum:  Indicates the number of iterations to examine below the initially 
calibrated shape of the target function, by pushing the asymptotes down in GPM space.  
Decreasing the asymptotes produces a less stringent value of CAFE standard.  Valid values are 
between 0 and 1000. 

• Increment by:  Specifies the value at which to increment the asymptotes of the target function in 
GPM space.  Valid values are between 0.00001 and 0.00500. 

• Merge the fleet before optimizing:  Specifies whether to merge the entire industry into a single 
large manufacturer before beginning the optimization modeling process.  Using this option 
smoothes the Net Benefits calculations and may help reduce multiple relative maximums 
("peaks") caused by manufacturers with conflicting redesign schedules. 
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Figure 28. Optimization Model Settings Panel 

 
7. Monte-Carlo Model Settings Panel 

Selecting the Monte-Carlo Model type enables the Monte-Carlo Model Settings panel 
(Figure 29), which provides additional options required for Monte-Carlo modeling.  During 
modeling, the system may automatically generate a new set of trial pairs to use for 
analysis, or use an input file that was previously generated during an earlier run.  When 
generating trial pairs, each new trial pair may consist of multiple Monte-Carlo trials – one 
for each discount rate analyzed. 

 



 

 98 

 
Figure 29. Monte-Carlo Model Settings Panel 
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Appendix E.7 CAFE Model Usage Examples 

This section provides examples for configuring and running the CAFE Model sessions using 
various model types. 

Appendix E.7.1 Example 1 – Configuring for Standard Compliance Modeling 

This example demonstrates the steps necessary for configuring the modeling system to perform a 
regular Compliance Model run. 

• Run the CAFE Model by clicking on the CAFE Model shortcut located on the desktop, or going 
to Start > Programs > CAFE Model > CAFE Model.  Read through the Warnings dialog box, 
and then click the OK button. 

• Select File > New Session to create a new modeling session.  The Modeling Settings window 
appears.  Note the errors at the bottom of the window; these indicate that the input files have not 
been selected. 

• On the General Compliance Settings panel, select the Standard Compliance Model as in Figure 
30 below. 

 

 
Figure 30. Select Standard Compliance Model 

• Click on the Input Settings panel to select the input files to use for modeling (Figure 31).  Note 
that once all the input files have been selected appropriately, the error messages disappear. 
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Figure 31. Select Input Files 

• On the Output Settings panel, select the location for output files and the industry, vehicles, and 
scenario summary reports (Figure 32). 
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Figure 32. Select Output Location and Modeling Reports 

• The Parameters Overrides and the EIS Model Settings panels are not used for this exercise. 

• Click the Save button to save the modeling settings and load the input files (Figure 33). 
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Figure 33. Save Modeling Settings 

• Once loading completes, click the Close button to return the main CAFE Model window.  A new 
Compliance Model session, titled "Session 1" has now been created (Figure 34). 
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Figure 34. New Compliance Model Session Created 

• Save the new session by selecting File > Save Session As....  Enter "demo.cmsd" in the dialog 
box that appears, and click the Save button (Figure 35). 
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Figure 35. Save New Session 

• After the session has been saved, notice the title of the session has changed to "demo" (Figure 
36). 
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Figure 36. "demo" Session Saved 

• Select File > Start Modeling to start the compliance modeling process.  As the model runs, the 
progress of the Compliance Model is displayed in the session window (Figure 37). 
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Figure 37. Modeling Progress from the Compliance Model 

• Once the modeling process completes, the system will automatically switch to generating the 
modeling reports (Figure 38). 
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Figure 38. Generating Reports for the Compliance Model 

 
• After modeling and reporting has completed, the "Reporting Completed!" message appears at the 

bottom of the main CAFE Model window (Figure 39). 
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Figure 39. Compliance Model Completed 

 
• Select View > Output Location to open Windows Explorer and browse to the location where 

model outputs for the "demo" session are saved. 

• Exit the session by selecting File > Close Session. 

• Exit the CAFE Model by selecting File > Exit, or proceed to the next example. 

Appendix E.7.2 Example 2 – Configuring for Optimization Modeling 

This example demonstrates how the take an existing session created in Example 1 – 
Configuring for Standard Compliance Modeling, and modify it to run the Optimization 
Model. 

• Run the CAFE Model by clicking on the CAFE Model shortcut located on the desktop, or going 
to Start > Programs > CAFE Model > CAFE Model.  Read through the Warnings dialog box, 
and then click the OK button. 

• Select File > Open Session to open an existing modeling session.  Select "demo.cmsd" in the 
dialog box that appears, and click the Open button (Figure 40). 
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Figure 40. Open "demo" Session 

 
• Once the session has been loaded, select View > Modeling Settings to bring up the Modeling 

Settings window.  There select the Optimization Model as in Figure 41. 
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Figure 41. Select Optimization Model 

 
• Under the Input Settings panel, select a market data file containing data for the light truck fleet 

only, as well as a scenarios file required for optimization modeling (Figure 42). 
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Figure 42. Select Scenarios File for Optimization 

 
• On the Output Settings panel, deselect the industry, vehicles, and scenario summary reports, and 

select the optimized industry report (Figure 43). 
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Figure 43. Select Reports for Optimization Modeling 

 
• Use the Optimization Model Settings to configure the system for optimization modeling as 

specified in Figure 44. 
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Figure 44. Configure Optimization Model Settings 

 
• Click the Save button to save the updated modeling settings; then click Close, once saving 

completes. 

• To prevent overwriting results from the "demo" session, select File > Save Session As... to save 
the modified session with a new name.  For this example, the optimization session was saved as 
"demo-opt.cmsd" (Figure 45). 
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Figure 45. Save Modified Session 

 
• Select File > Start Modeling to start the optimization modeling process.  As the model runs, the 

progress of the Optimization Model is displayed in the session window (Figure 46). 

 



 

 115 

 
Figure 46. Modeling Progress from the Optimization Model 

 
• Once optimization modeling competes, the system will automatically begin generating modeling 

reports. 

• After the "Reporting Completed!" message appears at the bottom of the main CAFE Model 
window, select File > Exit to exit the model. 

 
  



 

 116 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

                                                              
 

Research and  
Innovative Technology 

Administration 
Volpe National  

Transportation System Center 
Cambridge, MA 02142-1093 

 


	Contents
	Tables
	Figures
	Abbreviations
	1 Introduction
	2 System Design
	2.1 Overall Structure
	2.2 CAFE Compliance Simulation
	2.2.1 Compliance Simulation Algorithm
	2.2.2 Vehicle Technology Application within the CAFE Model
	2.2.3 Compliance Simulation Loop 

	2.3 Calculation of Effects
	2.3.1 Light-Duty Vehicle Sales and Fleet
	2.3.2 Vehicle Use and Total Mileage
	2.3.3 Fuel Use and Savings
	2.3.4 Greenhouse Gas Emissions
	2.3.5 Air Pollutant Emissions
	2.3.6 Private versus Social Costs and Benefits


	Appendix A Model Inputs
	Appendix A.1 Market Data File
	Appendix A.1.1 Manufacturers Worksheet
	Appendix A.1.2 Vehicles Worksheet
	Appendix A.1.3 Engines Worksheet
	Appendix A.1.4 Transmissions Worksheet

	Appendix A.2 Technologies File
	Appendix A.2.1 Technology Synergies
	Appendix A.2.2 Technology Variations for Monte-Carlo

	Appendix A.3 Parameters File
	Appendix A.3.1 Vehicle Age Data
	Appendix A.3.2 Forecast Data
	Appendix A.3.3 Economic Values
	Appendix A.3.4 Fuel Properties
	Appendix A.3.5 Upstream Emissions
	Appendix A.3.6 Monte-Carlo

	Appendix A.4 Emissions Rates File
	Appendix A.5 Scenarios File
	Appendix A.6 EIS Parameters File
	Appendix A.6.1 Parameters
	Appendix A.6.2 Emissions Rates
	Appendix A.6.3 Upstream Process Emission Rates
	Appendix A.6.4 Fuel Prices
	Appendix A.6.5 Forecast Data
	Appendix A.6.6 Sales, Car Fleet, and Truck Fleet
	Appendix A.6.7 Fuel Economy

	Appendix A.7 EIS Tailpipe Emissions

	Appendix B Model Outputs
	Appendix B.1 Industry Report
	Appendix B.2 Manufacturers Report
	Appendix B.3 Vehicles Report
	Appendix B.4 Scenario Summary Report
	Appendix B.5 Effects Report
	Appendix B.5.1 Optimized Industry Report

	Appendix B.6 Optimized Industry Report

	Appendix C “Optimization” of CAFE Standards
	Appendix D Monte Carlo Analysis
	Appendix E CAFE Model Software Manual
	Appendix E.1 Warnings
	Appendix E.2 Notice
	Appendix E.3 Installation and System Requirements
	Appendix E.4 Removing/Repairing a CAFE Model Installation
	Appendix E.5 CAFE Model Graphical User Interface
	Appendix E.6 CAFE Model Window
	Appendix E.6.1 Modeling Settings Window

	Appendix E.7 CAFE Model Usage Examples
	Appendix E.7.1 Example 1 – Configuring for Standard Compliance Modeling
	Appendix E.7.2 Example 2 – Configuring for Optimization Modeling



